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Preface

The Workshop L&er's Guide for the Lisa describes the Workshop environment
for developing, testing, and running programs written in assembly language,
Pascal, and other high-level languages.

This manual is written far programmers who are familiar with the Lisa@®
system.

Related Documents
For all programmers:

« Lisg 2 Qwner's Guide
For Pascal and assembly-language programmers:
« Pascal Reference Manugl for the Lisa
= MR 16/32-Bit Microprocsessor: Programmmer's Ralsrence Manwal
« Operating System Reference Manual for the Lisa
For BASIC programmers:
« BASIC-Flus Lker's Guide ror the Lisa
For Macintosh programmers:
« [nside Macintosh

What This Manual Comtains
The contents of the orkshop Leer's Guide are summarized below.

= Chapter 1, Imtroduction, describes the Workshop environment for program
development and discusses the conventions used by the Warkshop tools.
1t tells you how to install the Workshop and how to use the main
Waorkshop command line.

= Chapter 2, The File Manager, describes file-neming cornventions; tells
vyou how to list directories; how to copy, rename, and delete files; and
how to mount, unmount, initialize, and repair volumes.

= Chapter 3, The System Manager, tells you how to set system defaults
and specify device connectione.

= Chapter 4, The Editor, tells you how to create, modify, search, save, and
print text files.

= Chapter 5, The Pascal Compiler, tells you how to use the Compiler and
the Code Generator to turn a Pascal source program into an object file.
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» Chapter 6, The Assembler, tells you how to assemble a 68000
assembly-language source progrem intc an chject file; it also describes
how your sssembly-language program can communicate with a Pascsl
program.

» Chapter 7, The Linker, tells you how to combine compiled or assembled
object files into a single executable object file. It discusses regular
and intrinsic units, external names, and segmentation.

« Chapter 8, The Debugger. describes how to set breakpoints in your
program; how to display memory and registers; how to trace the
program flow; and other run-time debugging functions.

« Chapter 9, Exec Files, tells you how to create a file of commands to
run programs under the Workshop automatically; the commands consist
of Workshop and program commands plus a special high-level exec
language.

» Chapter 10, The Transfer Program, describes a data communications
package for transferring keyboard input or text files between the Lisa
and a remote computer.

Chapter 11, The WRilities, documents a set of utility programs that
perform file compearing, file searching, cross-referencing, Lisa-Macintosh
communication, and various other functions.

Appendix A, Error Messages, provides the text of error messages from
the Assembler, the Linker, ObjlOLib, SULib, PasLib, the Exec Processor,
and the Lisa Operating System.

Appendix B, Lisa Extended Character Set, is a table of ASCII cheracter
codes and special characters.

» Appendix C, Screen Control Characters, contains information on screen
control in Pascal and BASIC.

= Appendix D, Common Problems, contains troubleshooting suggestions.

Type and Syntax Conventions
Boldfece type is used in this manual to distinguish program text from English
text.

ltalics are used when technical terms are introduced.

Syntax diagrams show how to enter filenames and other syntactic
constructions. For example, the following syntax diagram from Chapter 2
describes a wild-card-gpec:

/4
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wild-card-spec

-
L—b{ string-1 I—/

v

7 L
string-2

29806

Start at the left and follow the arrows through the diagram. Alternate paths
are possible. Every path that begine at the leftmost arrow and ends at the
rightmost arrow is valid.

Circles and ovals contain reserved words, operators, or punctuation symbols
that must be written as shown, except that capitalization is not required.

Boxes contain the name of a syntactic construction that is described by
another syntax diagram. Replace the name with an instance of the
construction.

The wild-card-spec diagram embodies the following rules:

* A wild-card-spec can begin with an optional string (String-1).

» A wild-card-spec must contain =, ?, $, #, or ¢é.

«The =, 2 §, », or & can be followed by an optional string (String-2).
Here are some examples that conform to the wild-cerd-spec syntex:

—ol-$._text
?.o0bj

¥/ /4
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The File Manager
The Flle Manager enables you to manage and manlpulate flles and volumes.
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The System Manager
The System Manager enables you to set default and conflguration parameters
for the Lisa, and manage processes.

Chapter 4
The Editor

The Editor enables you to create and modify text flles. These text files are
used as input to the Compiler and the Assembler.

Chapter 5
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The Compiler transiates Pascal source code Into object cade. Translation

requires two steps: first the compiler translates Pascal into I-code; then the
code Generator translates the I-code into object code.
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The Assembler

The Assembler translates assembly language programs Into object code.
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The Llnker comblnes O'DJECI code flles Inlo executable programs.
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The Debugger enables you to examine memory, set breakpoints, and perform
other run-time debuggling functlions.




Chapter 9
Exec Flles

Exec flles enable you to execute a serles of commands and programs
automatically.

Chapter 10
The Transfer Program

The Transfer Program enables you to transfer files between the Lisa and a
remote computer. It can also let you use the Lisa as a terminal for a
remote cormputer.

Chapter 11
The Utilities

Utility programs are provided for debugging, configuring the system, and
manipulating files.

Appendixes
A Error

This section contains a list of error messages for the system, the Linker,
and the Assembler.

B The Lisa Character Set
This section defines the complete Lisa character set.

C Screen Control Characters
This section lists character sequences that can be used for controlling the
screen display.

D Common Problems
This section contalns some common problems and suggestions for handling
them.
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Introduction

1.1 Introduction to the Workshop
The Workshop contains a collection of tools for preparing and running
programs. These tools allow you to

= Configure the Lisa and set system defaults.
= Write, compile or assemble, link, and run programs.
= Debug prograrmns that run under the Lisa Operating System.

« Create and run files of Workshop and program commands using a
high-level exec language.

= Initialize, list, copy, rename, delete, compsare, sesrch, cross-reference,
and otherwise view and modify files, catalogs, and volumes.

= Transfer data between the Lisa and a remote computer.

The Workshop lets you develop Macintosh programs on the Lisa. You can
also transfer files between Lisa and Macintosh by running the MacCom
utility program. With MacWorks, you can even run Macintosh programs on
the Lisa. Seversal programming languages are svailable, including 68000
assembly language, Pascal, BASIC, C, and others.

The Workshop tools run under the Lisa Operating System (0S). The OS
enables programs to do file handling, process management, and memory
management; it provides some facilities for which there are no parallels in
the Workshop. If you ere writing programs to run under the Lisa OS, you
should be familiar with the CGperating Systemn Reference Marwal for the Lisa
If you are writing programs to run under the Macintosh OS, you should be
familiar with Inside Macintosh.

You use the main Workshup Teatures by typing a single character response to
a cormvnand line that lists available programs. The main command line is
described in this chepter. The File Manager and the System Manager have
their own eommand lines, described in chapters 2 and 3.

12 Sterting the Workshop
If you have already installed the Workshop from micro diskettes, boot from
the Workshop startup disk. Either the Workshop command line or the
Environments window sppeears on the screen. For a description of the
Workshop command line, see Section 1.5.1. The Environments window allows
you to stert the Workshop or another environment such as the Office System.
For a description of the Environments window, see Section 1.2.1.

If you have not yet installed the Workshop software onto & startup disk,
follow the instructions in Section 1.2.2

1-1
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1.2.1 The Environments Window

It your startup disk contains only the Workshop environment, booting
automatically starts the Workshop and its command line appesars. If the
startup disk contains more than one environment, the Environments window,
below, lets you select which environment you want. The window displays &
checkbox for each environment plus the following five buttons:

Power Off Turn off the Lisa.

Restart Reboot or reset the Lisa.

Start Start the selected environment.

Set Default Set the default to the selected ervironment.

No Default Always display the Environments window on startup.

Environments

lk Workshop Set Default

[ oftice system
No Default

start

To start the Workshop or ancther environment from the Ernvironments window,
move the pointer to the check box of the environment you want to start and
click the mouse button. Then move the pointer to the Start button and click.

To return to the Environments window from the Workshop, use the Quit
command In the Workshop command line. Reply Y when asked if you really
want to leave the Workshop. Then type A for Another_shell.

To go to the Workshop or another environment automatically at startup time,
select the environment's check box and click Set Default. To go to the
Ernvironments window automatically at startup time, click No Default.

To go to the Environments window when booting the systern, press any key
while the Lisa is sterting up.

1-2
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You can create your own environmerts. Any object file named
SHELL filename will appear in the Environments window es an slternate
environrnent.

1.22 Installation Overview
The Workshop Pascal software comes on nine micro diskettes, "Workshop
Pascal 1-9." Installing the Workshop involves transferring copies of files
from these micro diskettes to a herd disk that you designate. This hard disk
will then be called a startup disk or boot disk.

Here is an overview of the steps you rnust follow to properly install the
Workshop Pascal software. The actusl instructions are in the next section.

* Physically hook up the Lisa and any peripheral devices, such as printers
and external hard disks. If you have not yet physically set up the Lisa
hardweare, turn to Appendix A, Setting Up Your System, in the Lisa 2
Qwrer's Guide.

= Insert the "Workshop Pascal 1" micro diskette and use it to install the
startup software from the first six micro diskettes ( Workshop Pascal
1-6") onto a herd disk that you designate. These diskettes produce a
startup disk containing the minimum Pascal Workshop, which is capable
of editing, assembling, compiling, linking, running programs, managing
files, and configuring various hardware and softwere options.

It will take about 15 minutes to install the minimum Pascal Workshop, a
little over 2 minutes per micro diskette.

= Start the Workshop and use the Systern Manager's Preferences tool to
describe your Lisa's perticulsr configuration of disks, printers, and other
devices.

* Use the Workshop's File Manager to copy to the hard disk any additional
files that you need from the remaining micro diskettes ("Workshop
Pascal 7-9").

123 Installing the Warkshop Pascal Software
Follow these step-by-step instructions to install the Workshop Pascal
software.

It's a good idea to read through this entire procedure before starting.
1. If the Lisa is on, turn it off by pressing the on-off button.

2. Have the nine micro diskettes handy ("Workshop Pascal 1-9"). If vour
systemn has an external hard disk, be sure it is on and the ready light
is steady.

Do not write-protect the micro disketies. If you try to install the
software from a write-protected diskette, the Lisa will fail, try to
boot, and continue to fail.

1-3
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3. Insert the "Workshop Pascal 1" micro diskette into the drive. Make
sure the arrow embossed on the diskette points toward the drive.

4. Turn the Lisa on by pressing the on-off buttan once. About four
seconds later, after you hear a click from the cabinet, hold down the
% key and type a Z on the main keyboard. Do not use the 2 on the
numneric keywsd.

If you type #-2 correctly, the Lisa will go through a self-test that
checks to make sure the Central Processing Unit (CPU), Memory
(Mem), Input-Output (1/0), and expansion slots are working properly.
Proceed to step 5.

TESTING. ..

If you type 8 2 without pressing the ® key, the startup menu will
sppesr. Hold down the # key and tvype .2 again.

If you type #-2 late—-after you hear a second click from the
cabinet--this screen will appeer. Hold down the ® key and type X

lhe startup menu described in the preceding peregraph sppears. Type
~2.
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L 3} RESTART

*

*« STARTUP FROM. ..

3. When the Main Menu appears, use the mouse to move the pointer to
the Install box. Click the mouse button once. The box will darken,
indicating that you have selected it.

435 Warkshop Pascal System 3.0 L Finished ]
©1983, 1984 ¢fapple computer inc.

Thiy micro diskette is used to repair the Lisa
Workshop Pascal System startup disk and to . -
install the startup software. The startup disk is [ Repair
attached to the internal connector,

Click Finished if you are Finished,
Click Repair to fix a damaged disk.

Click Install to put hew startup software on the
disk.

Click Restore to restore the disk from backup

diskettes or archive tapes. | Restore ]

Clicking the Repsir box performs the same function as the Scavenge
command in the File Manager (see Chapter 2); select it only if your
hard disk is dameged end you want to try to preserve its files. The
Restore box is of interest only to Office System users.

6. A message will tell you thaet the Lisa is looking for any attached hard
disks. It will only find disks that are attached and powered on.

Then you will be asked to select the stariyp disk: that is, the disk on
which you went to install the Workshop Psscal software.

1-5
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Do you want to use the disk attached to the (_cancet )
parallel connector?
Click Cancel iF you do not want to specify any [ 0K ]
disk to use at this time,
Click OK if you want to select this disk.
Click More if you want to select a different disk, [ Mare ]

To select the hard disk identified by the first paragraph of the screen
message, click OK.

To select a different hard disk, click More. The Lisa will continue
looking for other attached disks.

You can keep clicking More each time & disk is presented for
spproval. If the screen notifies you that no more disks are available,
click Retry to start over or click Main Menu to return to the screen
shown in Step 5.

7. After you select your stertup disk, one of two screens will sppesr.

a If the disk you have chosen is a new disk that hes never before
been used, or if it is a disk containing software unusable by the
Lisa, you will see the message shown below.

Click Continue.

The disk is either damaged or has not yet been

initiatized, Before installing the Lisa workshop
Pascal System software, the Lisa will erase and
initialize the disk.

f you choose to Continue, all files on the disk
will be erased before the Lisa Workshop Pascal
System software is installed. Click Cancel iF
you do not want the disk to be erased.

[ Continue Rr]

ar

b. If the herd disk you select as your startup disk alresdy has Lisa
files on it, you will be asked if you want to erasse it. You can't
share the disk with MacWorks unless you initialize or erase it.
Click Erase to erase everything on the disk.

1-6
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Do you want the disk erased?
Click Erase oniy if you are starting new
work and want to destroy all information [ Erase ]
now on the disk. -

If the hard disk contains files that you want to keep, click Don't
Erase; go to step 9.

B. You will be asked if you want to use part of the disk with MacWorks
(the Macintosh ernvironment for the Lisa system).

If you don't want to store Macintosh files on this disk, click Don't
Share.

Do you wish to use part of the specified disk Oon't Share

with MacWorks?

Click Don't Share if you do not wish to split
the disk between the Lisa Workshop Pascal
System and MacWaorks,

Click Share if you want to be able to use [

part of the disk with MacWorks, _.__E'_‘E';S.__]

If you plan to use part of the hard disk for Macintosh files, click
Share. You will be asked how much space you want to reserve. The
only choice possible for a 5-MegaByte ProFile is 2000 blocks (1
MegsByte). Click one of the buttons.

The specified disk has a total size of 13448 Oon? Share
hlocks. How tmany blocks do you wish to use

with Mackorks? [ 2000 }
Click Don't Share if you do not wish to share

the disk with Macworks, [ 5000 "]
Note that disk blocks used by MacWorks

tannot be used by the Lisa Workshop Pascal [ 10000 ]
System,

1-7
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9. A wait message will sppear while the startup disk is erssed and
initialized. It takes a few minutes for the disk to be formatted and

initialized.

When the startup disk has been initialized, the Lisa will automatically
begin installing the Workshaop software from the "Workshop Pascal 1"
micro diskette. You will see a message telling you that the startup
software is being installed. The first micro diskette will soon be

ejected from the drive.

10. When the message on the screen tells you to insert the next micro
diskette, remove the “Workshop Pascal 1" micro diskette from the

drive and insert the "Workshop Pascal 2" micro diskette.

The

installation process will automatically continue. You do not need to

click either of the boxes shown.

Please insert the Lisa Workshop Pascal System 2
micro diskette into the micro disk drive,

Click Cancel to cancel installation.

[
k

If you insert a micro diskette out of sequence, the diskette will be

ejected, and this message will appear.

You inserted a Workshop Pascal System diskette out
of sequence.
The correct diskette to insert at this time is the

Lisa Workshop Pascal System 2.

The Install will continue,

o)

Replace the diskette with the correct one. Click OK: the installation

procedure will continue automstically.

11. Insert the remaining diskettes when you are prompted for them.

If you cancel the automatic installation process before installing
software from the first six diskettes, you will have to repeat this
procedure beginning with the "Workshop Pascal 1" diskette.
not be able to use the Workshop until softweare from the first six

diskettes have been installed.

1-8
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12. After the Lisa has

Pascal 1" diskette.
Insert the diskette.

installed the softwere from the sixth ("Workshop
Pascal 6") micro diskette, you will be asked to reinsert the "Workshop

Please reinsert the Lisa Workshop Pascal System [“EEI__]

1 micro diskette at this time. The Lisa will not
be able to Finish installing the Lisa Workshop
Pascal System software untit the Lisa Workshop
Pascal System 1 micro diskette has been
reinserted,

13. wWhen the message

informs you that the Workshop Pascal software has

been instsalled, click OK.

Note The Lisa Workshop Pascal System software has been
installed.

o)

14. The Main Menu will resppear. Click Finished.
The minimum Pascal Waorkshop is now installed.

£4FE  Workshop Pascal System 3.0 m
[©1983, 1984 &apple computer inc.

Thts micro diskette is used to repair the Lisa

workshop Pascal System startup disk and to B ——

install the startup software. The startup disk is [ Repait J
attached to the internal connector. -

Click Finished if you are Ffinished,
Click Repair to Fix a damaged disk. [ Install ]

Click Install to put new startup software on the
disk.

Click Restore to restore the disk from backup

diskettes or archive tapes. [ Restore ]

Introcuction
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19. When this message appears, click Start Up.

(o ]
oo

The "Workshop Pascal 1" diskette will be ejected. Put it in a safe
place.

Your Lisa will go through a series of self-tests similer to those thst
occurred when you first turned it on.

Should the Lisa turn off or start up from the
disk?

TESTING. ..

Z B O

16. The Workshop will be started from the startup hard disk. If the Lisa's
clock/calendar has not been set, the Workshop asks you to set the
correct time and date. You should do this now, because some
functions in the Lisa spplications require a correct dste and time.

17. Use the Workshop Systermn Manager's Preferences tool to tell the Lisa
what peripheral devices are physicelly connected and what default
settings to use each time you turn on the Lisa. Starting the Workshop
is described in Section 1.3. The System Manager subsystem and the
Preferences tool are described in Chapter 2.

18. Declde what files you need from the remaining diskettes (“Workshop
Pascal 7-9"). Use the Workshop's File Manager to copy these files ta
the startup disk (or any hard disk, if you have more than one). See
Chapter 2, The File Manager, for instructions. Unless you plan to use
a file frequently, you may prefer to access it directly from the micro
diskette rather than teke up space on the hard disk.

Your Workshop Pascal software is now fully installed.

13 Hardware Configuration
In order to use & device with the Workshop, you must do two things: first,
tell the Workshop it exists; and second, connect it to the Lisa. Telling the
software sbout the hardware is known as configuring the system. The
configuration information you provide is saved on the boot disk snd in the

1-10
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Lisa's parameter rnemory, so you only have to reconfigure if you change to a
different boot disk or if you connect or disconnect devices.

If you have just instslled new software on your boot disk, you should check
its corfigurstion now.

131 Specifying Hardware Connections

The File Mansager's Online cornmand tells you what hardware the Workshop
softwere thinks is connected to your Lisa. If a device that is connected to
the Lisa is not listed by Onling, use the Preferences command in the Systemn
Manager command line to tell the Workshop sbout the device. If Online
pauses unexpectedly while listing devices, or if it reports an error, it is
probably looking for a device that the software thinks is connected. If the
device is not present, use Preferences to detach it.

Preferences also lets you specify various defaults such & which device to
hoot from, which printer to associate with the logical printer device
(-printer), normal and dirnmed brightness levels for the screen, and so on.

1.3.2 Printer Configuration

Before using & printer with the Workshop, you must set up the printer and
tell the Workshop where it is connected.

Refer to the instruction manusl that came with your printer for directions on
how to set it up. If you have more than one printer you will weart to
configure one of them &S the default printer, as described in Section 1.3.2.3.

1321 Setting up & Printer

The procedure for setting up a printer veries with the type of printer.
Follow the manufacturer's instructions.

During startup, or when you attach a printer using the Preferences tool, the
Workshop sends a control sequence to set the printer to 9600 baud, auto line
feed, DTR handshske, and no parity. If your printer is an Apple Imagewriter,
the default standards which have been factory preset should be satisfactory.
However, if you went to modify the perforrnance of the lmagewriter, see the
technical specifications in the Aople imegewriter Lser'’s Menueal Fard I
Reference.

1322 Corfiguring the Workshop for a Printer

Follow these steps to corfigure your Lisa for a printer:

1. From the Workshop cornmand line, press $to enter the System
Manager subsystern.

2. Fress Ffor Preferences. The Preferences tool is used to set up the
configuration of the Lisa system and the Workshop; refer to Section
3.3 for more inforrnation on Preferences.

3. Click on the Connect Device Software box to see what devices are
connected to the Lisa.

1-11
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4. Select the connector to which your printer is connected. All devices
that can be connected to that connector are displayed.

5. Select Printer; additional configuration options ere displayed.

6. When you are finished configuring your printer, select Quit from the
File menu.

7. Exit from the System Manager back to the Workshop command line by
pressing & for Quit.

1323 Specifying a Defsult Printer
If you have mare than one printer connected to your Lisa, you can specify a
default printer--the one you can refer to as -printer. First use the
Preferences tool to configure the printers and other devices connected to the
Lise. Then choose Select Defaults in Preferences. See Section 3.3, The
Preferences Tool, for more information.

Another way to specify the default printer is to type 2 for DefaultPrinter in
the System Manager command line and enter the device name of the defsult
printer (for example, #10#1 or its aliss RS232A). Or, if you want to keep the
current default, press [RETURN]. See Section 3.2, The Systemn Manager
Command Line, for more information on the DefaultPrinter command.

The default printer yvou specify using the Preferences tool is also the default
for the Office System if you have it installed; the default printer you specify
using the DefaultPrinter command affects only the Workshop environment.

14 The Waorkshop Shell
The Workshop shell is the highest-level program in the Workshop
environment. Programs you run from comrnand lines or using the Run
comrnand return control to the Workshop shell when they're finished. The
shell provides an exec file mechanism and performs a number of automstic
actions; its Command Interpreter communicates with you at the level of the
main cornmend line.  The Workshop uses the cormnmand line to provide you
with access to system functions at a single keystroke.

141 Exec Files
Exec files let you automate Workshop utilities and user programs, make
programmed decisions (for exarnple, whether to recompile a source prograrm),
modify the Workshop environmert, automate test procedures, and more. Exec
source files can contain a high-level command language, Workshop
commands, and input to user programs. Common uses of exec files include
standerd compile procedures and standard application runs. See Chapter 9,
Exec Files, for more information.

142 The Main Command Line
When you enter the Workshop environment, the Workshop's main command
line sppesars at the top of the screen. It shows:

1-12
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« Two subsystems, the File Manager and the System Manager, that have
their own cormnmand lines.

» The Run command, which lets you run Workshop utilities and any
program that you or someone else wrote to run under the Workshop.

» The main tools provided by the Workshop.

The main command line actually comes in two parts because the screen isn't
wide enough to show all the commands on a single line. The first part of
the main command line looks like this:

WORKSHOP: FILE-MGR, SYSTEM-MGR, Edit, Run, Debug, Pascal, Basic, Quit, ?

You can see the rest of the comrnands by pressing ?, the last symbol on the
line. To return to the first part of the command line, press [RETURN]. The
second part looks like this:

Assemble, Generate, MakeBackground, Link, TransferProgram

Type the first letter of a command to use a tool. For example, type £or &
to run the Editor. You can use sll of the commands no metter which part of
the main command line is showing when you type the command letter. The

Workshop looks for the tool on the boot volume; if it doesn't find it there, it
looks on the Prefix volumes.

Some commands will ask for additional informstion. Default values are
displayed in squere brackets ( [default] ). To accept a default value, press
[RETURN]. If vou don't want the default value, type in the value you want
and then press [RETURN). If you meke a mistake, press [CLEAR] to escape.
See Section 1.5.1.2, Defaults in File Name Prompts, for more information.

The main command line commands are described below. The letter you type
to access the command is shown in perentheses.

FILE-MGR (F)

The FILE-MGR command give you access to the File Manager subsystem,
described in Chapter 2. This subsystem is used to menipulate files, catalogs,
and volumes.

SYSTEM-MGR (S)

The SYSTEM-MGR commeand gives you access to the System Manager
subsystem, described in Chapter 3. This subsystem provides verious
configuration, process rnanagement, and utility functions.

Edit (E)

The Edit command gives you access to the Editor in order to create, modify,
end print text files. You can use the Editor to write exec files, data files,
and programming language source files, as well 88 memos or other
documents. The Editor is described in Chapter 4.

Run (R)

The Run command has two functions. You cen use it to execute an ofject
program (a Workshop utility program, a user-written program, or any other
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software designed to run under the Workshop), and you can use it to cause an
exec rile to be processed and executed.

The Run command asks you what file you want to run. The default is the
last program or exec file you ran. To run the same file again, just press
[RETURN]. To run a different file, type the program or exec file name
followed by [RETURN]. The name of an exec file must be preceded by < or
exec/.

If the Run command doesn't find the file under the name you supplied, it
edds the standard extension if you didn't give one (.OBJ for program files,
.TEXT for exec files) and looks for the file again. If you don't specify &
volume neme, the Run command searches through the first Prefix volume for
an exec file or through up to three Prefix volumes for a program file; then,
it necessery, it looks on the boot volume. Prefixes can be set through the
File Manager's Prefix command.

Debug (D)

The Debug command inserts a breakpoint at the first instruction in your
program, 8o you can use the Debugger. Then it executes the program just as

the Run command does. More information on the Debugger can be found in
Chapter 8.

Pascal (P)

The Pascal command starts the Pascal Compiler, described in Chapter 5.
More information on the Pascal language can be found in the Fascal
Reference Manual for the Lisa

Basic (B)

The Basic command starts the BASIC Interpreter. More information on

BASIC programming can be found in the FASIC-Flus Liser's Guide for the
Lisa.

Quit (Q)

The Quit command lets you leave the Workshop. If you opened files in the
Editor and didn't save them, you'll receive a reminder. The following prompt
line appears after you confirm thet you want to leave the shell:

wWarkShop_shell, Another_shell, Reboot, Power_off
Type #/to return to the Workshop environment.

Type Ato go to the Environments window. If you have the Lisa Office

System installed, you can go from the Workshop to the Office System by
means of the Environments window.

Type A'to reboot the Lisa
Type Fto turn off the Lisa
Assemble (A)
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The Assemble command starts the Assembler, described in Chapter 6.
Additional informetion on assembly language can be found in the ABRXAD
15,32-Fit Microprocsessor manual.

Generste (G)

The Generate command, described in Chapter 5, converts intermediate code
files produced by the Pascal Compiler into object code. (The Compiler
performs this step automstically unless you specify otherwise.)

MakeBackground (M)

The MakeBackground command lets you run a program ss a background
process while you continue using the Workshop for other functions. The
background process should not display on the console or request keyboerd
input.

Link (L)

The Link command executes the Linker, described in Chapter 7. The Linker
is used to prepere compiled or assembled programs for execution, or to link
together separately compiled pieces of a program.

TransferProgram (T)

The TransferProgram commeand starts the Transfer program, described in
Chapter 10. This program sllows your Lisa to communicete with a remote
computer.

143 Auwtometic Actions Taken by the Shell
Certain actions sre automatically performed by the Workshop shell. These
include running a user exec file during startup and shutdown, mounting disks,
and establishing the logical console and default printer devices.

1431 User Startup and Shutdown Procedures
During startup, the Workshop shell looks for a user exec file named
CISTART.TEXT and runs it if it exists. You can creste your own CISTART
(Command Interpreter startup) file to modify the Workshop environmert or
set up a user spplication. Any commands that are valid in a normal exec
file are valid in CISTART. See Chapter 9 for more information on exec
files.

The following CISTART file sets the Validate command so that file transfers
are not verified and file selections are not confirmed with messages like
"Are you SURE you want to copy..7" (see Section 3.2, The Systern Manager
Command Line, for more information):
$EXEC
Sys-Mar}v{alidat e}N{ojN{a} Q{uit)
$ENDEXEC

You can also creste an exec file named CIFINISH.TEXT that will be run

automatically when you leave the Waorkshop shell.
1432 Automatic Mounting of Disks
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Devices must be mourted before you can read from thern or write to them.
At startup time, the Workshop rnounts any physicelly attached disk thet has
been logically connected using the Preferences tool. (See Section 3.3.3,
Device Connections, for more information.)

1433 ~Automatic Setting of Prefixes
Prefixes tell the Workshop where to look for a file when you don't specify a
full pathname, The File Manager's Prefix command lets you specify three
levels of prefixes that remain in effect until you change them or until you
power off.

You can &also set the prefixes so that they are automatically reestablished
during startup, by answering ¥ to the Prefix command's question

Initialize this Prefix Set & boot time? (Y or N)

144 The Main Screen and the Alternate Screen

The Lisa can show you two different displays; they are known ss the masin
screen (-MAINCONSOLE) and the aXternate screen (-ALTCONSOLE). By
convention, the Workshop (except for the Debugger) displays output on the
main screen; that is, the logicel console, -console, is normally set to the
main screen. The Debugger uses the alternate screen so that its messages
are not intermingled with program output. The Console command in the
System Manager lets you choose which screen is the logical console.

To switch to whichever screen is not currently viewed, hold down the Option
key on the right side of the Lisa keyboard while you press the Enter key on
the nurneric keypad.

Your program can direct output to the slternste screen by opening and
writing to a file named "-ALTCONSOLE-x", where x is any file name.

15 Wwmkshop Cowentions and Standards
This section describes file name conventions and other standsrds used in the
Workshop. In general, these features are not available in user programs
unless you specifically provide for them. (Refer to The StdUnit Unit in the
third binder of this set for more information on how to program these
features.)

1.5.1 File System Comnventions
This section introduces file naming conventions and tells you how to respond
to prompts that ask for a file name. Most of the Workshop tools follow
these conventions.

A more complete description of the File System can be found in Chapter 2
and in the Qperating System Reference Manual for the Lisa

1511 File Names
When the Workshop prorpts you for a file, you must supply a valid
pathname; the following rules apply:
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« A pathname has three parts:

Device, volume, or Starts with "-"; defaults to Workshop

catalog name Prefix 1 if not supplied.

File name Composed of alphabetic and/or numeric
characters; spaces are permitted.

Extension Composed of alphabetic and/or numeric

cheracters; spaces are perritted. If present, it
is the final "." and any characters that follow.
The standsrd extensions are .TEXT, .0BJ, .I, and
.LIB.

s The length of the full pathname must not exceed 255 characters. The
length between dashes (-) or between & desh and the end of the
pathname must not exceed 32 charscters.

» Leading and trailing blanks or teb characters will be discarded by the
Warkshop.

= Uppercase and lowercsse are ususlly preserved as you specify them and
are ignored in distinguishing between file names.

when entering a list of files, indicate that you are finished by pressing
[RETURN].

15.12 Defaults in File Name Prompts

Prompts may display default values, shown in square brackets ([]1). If &
file name prompt contains no default value, enter [RETURN] or a backslash
(\) if you don't want to specify a file.

To accept a default extension, type the file name without an extension. For
example, when a prompt displays

[text]

and you do not enter an extension, "text" will be added to the file name you
enter.

To prevent an extension from being added, enter the file name with a period
at the end. The Workshop won't add an extension to a device, volume, or
catalog name, so you don't have to follow these with a period.

To accept a default file name, respond with [RETURN]. If you do not want
the default file or any other file, enter a backslash (V).

Alternate defaults are indicated by a slash (/). For example,
[-console]q text]
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lets you default to either the console device or a text file. This option is
made available in cases where you may want to display output on the screen
or save it in a file. Press [RETURN] if you want the Workshop to use the
console. Enter a file name if you want the Workshop to use a file. (If you
don't supply an extension, "text" is added)

A separate default may be shown for each part of a pathname. For exemple,

[-pareport] [-intrinsic] [.lib]
shows & default value for the device, file name, and extension. If you leave
out ary pert of the psthname, the Workshop supplies the default value for
that part. Sometimes perts of & pethname are shown within the same set of

brackets if the parts cannot be accepted independently of one another; for
instance

[-parapart-intrinsic] [.lib]

152 Getting Help
If you need help or went to see & list of program options, respond to a file
name prompt by typing ?followed by [RETURN]. Help information sppears
on your screen if it is available. (Not all programs provide help screens.)

153 Getting Out
You may want to stop what you're doing--cancel a program that's running,
cancel e command prompt, or temporarily stop a screen display. This
section tells you how.

1531 Canceling a Program
You can terminate the operation of most Workshop tools and utilities by
pressing the &-period keyw combination Most Workshop tools check for
®-period even when running under exec files.

Unless a user program wes written to recognize the #-period key
combination, pressing those keys will not terminate the program. (The
function PAbortFlag tells a program whether or not #-period has been
pressed. For more information, see PASLIBCALL, Section 5.4) If &-period
doesn't work, you cen do one of the following:

« Wait for the program to terminate.

= Press the NMI (nonmaskable interrupt) key, which forces the system into
the Debugger. The minus (-) key on the numeric keyboard is normally

set to be the NMI key. See Section 8.2.1.2, Terminating an Infinite
Loop, for further instructions.

1532 Canceling a Prompt
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The Clear key on the numeric keypad is an escape key. You can use it in
response to a file name prompt. For example, if you're in the File Manager
and you type O for Delete by misteke, press the Clear key to return to the
File Manager command line. You don't have to press [RETURN] after
pressing [CLEAR).

1533 Halting a Screen Display

To stop the screen display while a program is running, press the #-S key
combination. The program temporerily halts. To restart the screen display,
just press ®-S sgsin. This feasture works for all programs that do screen
output through the Pescal run-time system.

154 Standard Error Messages
Every error reported by the Opersting Systerm or the Workshop hes a nurnber
associated with it. If the file containing the text of the error messege is
available &t the time of the error, the full message is displayed; if the error
file is not available, only the error number is displayed.

The error files are:
OSEmrs ERR Errors reported by the Operating System
Pastrrs FRR Compile errors reported by the Pascal Cornpiler
WarkshopErrs ERR  Errors reported by the Exec Processor

For a list of all error numbers and their associated message text, see
Appendix A.

1-19



AME)y-+5

Chapter 2
The File Manager

2.1 Introduction to the File Manager ........ ... ... ... 2-1
2.1.1  The File System ..o 2-1
2.1.1.1 Directories and Catalogs .............c.covviiiiiinena. .. 2-1

2.1.1.2 Physical Devices...........ccooiiiiiiiiiiiiiiiiinie e, 2-3

2.1.1.3 Logical Devices.......ccooeiiiiiiiiiiiiiiiiiiiiieenes 2-3

2.1.2  File Specifiers . ..o e 2-4
2.1.2.1 How to Create a File Specifier .............cooovvennen. 2-4

2.1.2.2 The Working Directory .......ccoooeiiiiiiiiiiiiiiiiannn. 2-6

2.1.2.3 Standard File Extensions ..............c.ooiiiiiiiiiiiiina., 2-6

2.1.2.4 WildCard Characters ...........cooviiiiiiiiiivenaiiaannns 2-7

2.1.3 The File Manager Command Line ............c.coeevviiiiiiirnnnne Z2-10

2.2 Managing Volumes and Devices ...........c.ccoiiiiiiiiiiiiiiiiainaans 2-12
2.2.1  The Online Command ........ceeeiieerereeiieeiaeeieieeaiaeanns 2-12
2.2.2 The Initialize Command .........ccoooiriiiiiiiiiiiiiiiiinaee, 2-14
2.2.3 The Mount and Unmount Commands..................ooooeeeet. 2-15
2.2.4 The Scavenge Command............ccooiiiiiiiiiiiiiiiiiiiinin. 2-16

2.3 Copying and Deleting Files .......oooiiiiiiiiiiiiiiiiiiiiiiiieeienns 2-17
2.3.1 The Copy Command ..........ooiiiiiiiiiiiiiiiiiiiiiiiiiaiiinenees 2-18
2.3.2 The Backup Command ..........ooieviiiiiiiiiiiiiiiiiiiiieeas 2-18
233 The Transfer Command ..........cccivviiiiiiiiiiiiiiiiiienens, 2-20
2.3.4 TheDelete Command .........coooiiiiiiiiiiiiiiiiiiii e, 2-20

2.4 Changing File Attributes ............ ... ool 2-20
241 The Rename Command.......c..c.ceeiiiiiiiireiiinierenieireieneenens 2-21
2.42 The FileAttributes Command Line............coovvvvinniiennn... 2-21
2.4.2.1 ClearAttributes ........c.coeiiiiiiiiiiiiiis 2-22

2.4.2.2 Safety ..o i 2-22

2.4.2.3 Protect ..o e 2-22

2.4.2.4 AddPassword ...........cooiviiiiiiiiiiiiiiiie e 2-23

2.4.2.5 RemovePassword ........c.ooviiiiiiiiiiiiiiiiiiiieeas 2-23

2426 QuUit .o 2-23

2.5 Getting Information about Files ... ... ... ... ... ... 2-23
2.5.1 The List and Names Commands ...............ccooveviienninnnn. 2-24
2.5.2 The Equal Command..........ccoiviviiiiiiiii i 2-26

2.6 Additional File Manager Commands ....................ccooceennln. 2-21
2.6.1  The Quit Command........cccooiiiiiiiiiii i, 2-27
2.6.2 The Prefix Command...........ccoviiiiiiiiiiiiiiiiiiieiieeeennen. 2-27
2.6.3 The AddCatalog Command ............ccoceviiiiiiiiiiiiiannnnn... 2-29



2.1

211

2.1.1

AMA/-F5

The File Manager

Introduction to the File Manager
The File Manager is a subsystem of the Workshop that gives you access to
physical devices supported by the Lisa Operating System. In addition, the
File Manager lets you communicate with logical devices: —console,
—printer, —keyboard. and —#boot.

The File Manager has its own command line. The commands let you
* Find out what volumes are online.
» List volume catalogs.
* Initialize new hard disks or micro diskettes.
* Print files.
» Make copies of files.
* Rename or delete files.
* Perform other file manipulation functions.

The File System

The OS File Systemn supports a variety of input and output devices,
including &/ock-structured devices (hard disk and micro diskette drives) and
sequential devices (RS232 ports. consoles. printers, and so on).
Block-structured devices contain vo/umes which in turn contain cafe/ogs
and ///es. Some block-structured devices, such as micro diskette drives,
support removable disks; others, such as the Lisa 2/10's internal drive or
an external ProFile drive, contain a nonremovable disk. See the Operating
Systern Reference Manual for the L/sa for more information on File
System devices.

Files, catalogs, volumes, and devices are identified to the Workshop File
Manager by means of file specifiers. When the File Manager prompts you
for a file. respond with a file specifier as described in Section 2.1.2.1.

.1 Directories and Catalogs
A volume directory. or volume catalog is present on every volume. |t
contains the name and attributes of each file on the volume. The Initialize
command places an empty volume directory on a new disk volume. The
List command shows you the contents of the volume directory. Filenames
on a given volume must be unique.

A calalogis a special type of file that points to one or more files and/or
other catalogs. Figure 2-1 shows a typical catalog structure.
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NI IR

O Catalog
t::J File

arts

Figure 2-1
Structure of ARTS Catalog

NOTE

If you plan to work with disks that were initialized for use with a
previous version of the Workshop, read this note.

As of Release 3.0, catalog entries are hierarchical and are kept in
alphabetical order: commands that operate on a list of files run
faster with the new catalog structure than with the old "flat"
catalog, although the 3.0 Workshop can read volumes initialized
under earlier releases. (On the other hand, new volumes cannot be
read by earlier Workshop releases.) To take advantage of the new
catalog structure, initialize a new volume and copy the old volume
to it.
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2.1.1.2 Physical Devices
Any physical device can be referred to either by device name or by an alias,
as shown in Table 2-1. A block-structured device can also be referred to
by the name of the volume mounted on it. You can refer to your micro
diskette by device (—#13) or alias (—lower) or volume (say, —minidisk).
Sequential devices do not have volume names. To refer to a sequential
device as a file, specify its physical device name followed by a dummy
filename; for example, ~RS232A—X.

|

|

Table 2-1
Physical Device Names and Aliases

Physical Device Alias Description

#10#1 RS232A Serial Port A

#10#2 AS232B Serial Port B

#11 PARAPORT Parallel connector (Lisa 1)

#12 UPPER or PARAPORT Built-in hard disk (Lisa 2)

#13 LOWER Micro diskette drive

#15#1 ALTCONSOLE Alternate console

#15#2 MAINCONSOLE Main console

#x SLOTx Peripheral at expansion
slot x

#xity SLOTxCHANy Peripheral at expansion
slot x, connector y

#x#ty#z SLOTxCHANyDEV2 Peripheral at expansion
siot x, connector y.
device 2

2.1.1.3 Logical Devices

There are four logical devices that can be used to specify input and output.
The first three, —console, —printer, and —keyboard, are supported by the
Pascal runtime system; the physical devices to which they refer can be
changed by Workshop System Manager commands.  The fourth, —#boot,

is supported by the Operating System. The logical devices are desoribed in
Table 2-2 below.
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Table 2-2
Logical Devices

Logical Device

Description

—console

—printer

—keyboard

—3#boot

Default is screen output and keyboard input. Can be
changed by the Console cormmand in the Workshop
System Manager.

Default printer. The port to which the printer is
connected is set by the Preferences tool. !f you have
more than one printer, set the default by using one of
these Workshop System Manager commands:

* The DefaultPrinter command in the
System Manager command line; or

* The Select Defaults menu in Preferences.

The keyboard currently associated with —console;
what you type is not echoed on the console screen.

The boot device. Set by the OS.

2.1.2 File Specifiers

Files, catalogs, volumes, and devices are identified to the Workshop Flle
Manager by means of 7//e specifiers A file specifier is a form of
pathname that identifies a device, volume, catalog, file, or collection of
files to the File Manager.

When the File Manager prompts you for a file, respond with a file
specifier as described below.

2.1.2.1 How to Create a File Specifier
The format of a file specifier is shown in the diagrams below.

{ile—specifier
filename—or —pattern
(=)+{ logical—device
file— —Of —
ile—name—or —pattern ienarme
1‘( volume/catalog—spec |j lﬁ‘ wild—card—spec
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volume/catalog—spec

‘l volume —name l

physical —devicq

physical—device N

* physical—device~nam€
1‘{ physical —device—alias

physical—device—name physical—device—atias
PARAPORT
UPPER

s
SLOTx

(SLOTHCHARDEV: )
o(Rsz3i8
CED

(The device names on the left correspond to the device aligses on the right.)

logical —device

wild~card—spec

\—b{ string-1j
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A leading dash in a file specifier indicates that the first part is a volume
or device. |f the file specifier starts with a catalog name or filename,
don‘tuse a leading dash. |f a prompt asks specifically for a volume or
device, the leading dash is optional; for instance, you can specify the micro
diskette drive either as —#13 or as #13. File Manager commands that
ask specifically for volumes or devices are Initialize, Mount, Unmount, and
Scavenge,

For a block-structured device, you can specify either its physical device
name or the name of the volume that is currently mounted on it.

File specifiers can contain wild card characters, enabling them to specify a
collection of files. The wild card appears in the filename part of the file
specifier—to the right of the rightmost dash, if dashes are present.

2.1.2.2 The Working Directory
The working directory is the catalog where the Workshop looks for a file
if the file specifier does not include a volume or device name. The
working directory can include one or more subcatalog levels, It is initially
on the boot volume, but you can establish another catalog as the working
directory by using the Prefix command.

To find the current setting of the working directory, type £ or L-the

working directory is shown in square brackets in the prompts for the
Prefix command and the List command.

If you don't specify the volume in a file specifier, the File Manager adds
the working directory to the file specifier to form a complete pathname,
For example, if the working directory is —#11—arts—music, the file
specifier concerts—solo is combined with the working directory to
produce the pathname —#11—arts—music—concerts—solo.

2.1.2.3 Standard File Extensions
Files created by many Workshop tools have standard fi/e extensions that
identify the type of file. The extension is the last part of a filename,
preceded by a period. The standard file extensions used in the Workshop
are shown in Table 2-3 below.
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Table 2-3
Standard File Extensions

Extension Description
JEXT Text file in the format created by the Editor.

.0BJ Object code file created by the Assembler, the
Generator, or the Linker. Object files created by
the Linker. except for library files. are
executable.

R Intermediate (I-code) file produced by the Pascal
Compiler for input to the Generator,

.LIB Library directory file produced by the
IUManager.

You can also create your own standard by adopting a convention, giving
certain files the same extension. For example, you can add the extension

.trans to every file received from a remote computer through the
Transfer program.

2.1.2.4 Wild Card Characters
Wild card characters are like jokers in a deck of cards. The joker can be
used in place of another card; the wild card ocharacter can be used in place
of part of a filename in a file specifier. For example, the file specifier
below uses the wild card character # to search for all files with the file
extension .text:

¥ text

The wild card character stands for a sequence of zero or more characters
that can be ignored in the search for a matching filename. The surrounding
text in the file specifier (.text in the example shown above) must be
matched exactly, ignoring case.

Figure 2-2 summarizes the wild card characters, The syntax for a wild
card character is shown in Section 2.1.2.1.
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Wild Card Characters

Top Level All Levels
of Catalag of Catalog

(Option 7)

E
(Option Shift =

All Levels
of Catalog

tnsert all |0
of source |-

Figure 2-2
Wild Card Characters

If you want the File Manager to let you se/ect files before it performs
the requested operation, use the ? or ¢ wild card characters. |f you don't
want file selection, use the = or * characters.

When you request file selection, the File Manager presents you with a list
of files that match the source file specifier. Type ) to select a file,
to ignore it. You can move backward and forward through the list by using
the up and down arrows on the numeric keypad. When you have selected
all the files you want, press Return. The operation will then be performed
on the files you selected.

Catalogs are searched differently for a source file specifier depending on

the wild card character you choose. If you want all levels of a catalog to
be searched, choose the #= or & character. I1f you want only the top level

of a catalog to be searched, choose the = or ? character.
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Here are the general rutes for using wild card characters:

* A wild card character can be used in a file specifier in response to
any File Manager prompt for a pathname.

= Only one wild card character can appear in a file specifier, and it
must be in the filename part, not the volume or catalog part.

* In a sowrce file specitier (generally the first file asked for), the
wild card characters permitted are =, #, 7, and ¢&. The wild card
character in the source file specifier governs which filenames the
File Manager will se/ect

= matches any string in the top level of the catalog.

+ matches any string throughout all levels of the
catalog.

7 matches any string in the top level of the catalog,
letting you select filenames before performing the
operation.

¢ matches any string throughout all levels of the catalog,
letting you select filenames before performing the
operation,

* In a destination file specitier (generally the second file asked for),
= and § are permitted. The wild card character in the destination
file specifier governs how the File Manager will generafe the
destination filenames.

= jnserts the part of the source filename that matches
the wild card, replacing the = in the destination
filename.

$ inserts the entire filename part of the source
filename, replacing the $ in the destination filename.

* To enter the # character, hold down the Option key while pressing
the = key, To enter the ¢ character, hold down the Option key
while pressing the Shift and ? keys.

In the following example, single.= is the source file specifier and
married.= is the destination file specifier:

Rename what file(s)? single.=
To what new name(s)? married. =
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This example tells the File Manager to look in the working directory for
all files whose names begin with “single."—for example,

single. data. test
single.obj
single. text

Rename each file by replacing "single.” with "married.”; replace the wild
card = in the destination filename with whatever matched the wild card =
in the source filename. The selected files are renamed

married. data. test
married. obj
married. text

Here are some examples of the = wild card character in a source file
identifier:

= All files on the working directory volume...
=.ob]) ...ending with .ob}

tr=.text ...beginning with tr and ending with .text (such as
traffic. text, training. text, transfer.text)

The File Manager Command Line

The File Manager command line gives you easy access to all the File
Manager tools. To enter the File Manager subsystem from the Workshop
command line, type /~. An overview of File Manager commands is shown
in Figure 2-3.
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Managing Volumes and Devices

BACKUP
T

Changing File Attributes

\\\\m\ TTR'BUTES (CIearAttributes) ( AddPassword )

SRR

Safety ) (RemovePassword)
'Gettlng Information about Files ' ( Protect ) ( th )

LIST — NAMES—

Volume level Commands

%File-level Commands
Miscellaneous
77 :

alog-level Commands

I'J;Q\tber Commands

== ADD

Figure 2-3
Overview of the File Manager
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The File Manager command line has two parts. The first part looks like
this:

FILE-HGR: Backup, Copy, Delete, List, Online, Prefix, Rensme, Transfer, Quit, 7
Type 7 to display the second part of the command line:

AddCstalog, Equal, FileAttributes. Initislize, Mount, Names. Scavenge, Unmount
To redisplay the first part of the command line, press Return.

To execute any File Manager command, type the first character of the
command name. Most commands ask for filenames or other input.

If there is a default value for part of a filename, it is displayed in square
brackets ( [default] ). To enter the default, press Return; otherwise type
the value you want.

Prompts for a file specifier expect you to press Return after entering the
value. Certain other File Manager prompts, such as those asking for a
or /V response, take effect immediately.

2.2 Managing Yolumes and Devices

The File Manager tools for managing volumes and devices let you
* Find out what devices and volumes are currently on/ine
* /nitialize a new volume.
* Mount or unmount a volume.
» Scavenge a disk to repair it.

2.2.1 The Online Command (0O)

The Online command lists the volumes that are currently mounted, Online
looks at each device connected by Preferences to see if a volume is
mounted. [t then displays a list of currently mounted volumes, as shown in
Figure 2-4. Use Online to find out

* The names of mounted volumes.

* How many files are on a volume, and how many of these
are open.

* How much space is left on a volume.

* Which volume the Lisa was booted from.

* Which volume contains the working directory.

* Which device a particular volume is mounted on.

2-12
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Volumes on line

DeuName DevAlias UolumeName UolSize FreeBlks Files Open Attr
#i3 LOWER SCREENS 764 685 12 3 M
#1541 ALTCONSOLE 0 0 0 0 M
HISHZ MARINCONSOLE 0 0 0 1 M

#11 PARAPORT Amy’s Workshop 9690 1708 206 21 MBP
#1042 RS5232B {printer> 0 0 0 0 M
H242 SLOT2CHANZ <{printer 0 0 0 0 M

Figure 2-4

The Online Display

The columns in the Online display are described below:
DevName Name of the device on which the volume is mounted.

DevAlias Alternate name of the device.
VolumeName Name of the volume that is mounted.
VolSize Number of blocks on the volume.
FreeBlks Number of blocks still available.
Files Number of files on the volume.

Open Number of files open on the volume,
Attr Attributes of the volume:

B This is the Boot volume.

P This volume catalog is Prefix #1.

p Prefix #1 is a catalog on this volume.
M This volume is currently mounted.

If a device has a printer attached, <{printer> is shown in the VolumeName
column.

NOTE

If the Workshop pauses unexpectedly while displaying the Online list,
a device configured by Preferences is not present. Use the Connect
Devices menu in Preferences to disconnect the device,
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2.2.2 The Initialize Command (1)

The Initialize command prepares a hard disk or micro diskette for use in
the Lisa Operating System environments. Initialize formats the disk,
records its volume name, creates an empty volume catalog, and mounts the
disk. Initialize will erase an existing volume, but only after it has given
you a chance to change your mind. Sample dialog for a new volume and a
previously initialized volume is shown in Figure 2-35.

Initializing a new volume:

Initialize what device? -#13

How many pages to initialize? [whole devicel
Name of new volume? InitDemo

Max number of files allowed on volume? [54]
Beginning initialization operation...
Mounted volume InitDemo

Initializing C(erasing) a previously initialized volume:

Initiatize what device? -#13

Destroy current 0S Volume on #1137 y

How many pages to initialize? [whole devicel
etc.......

Figure 2-5
The Initialize Command

The dialog for the Initialize command is described below.
Initialize what device?
The disk to be initialized must be on the device. Specify the device name

or alias. If the disk has been initialized before, you can specify its volume
name.

How many pages to initialize? [whole device]

A page is @ 512-byte block. The total number of blocks for a device is
shown in the Online command list. Press Return to accept the default of
initializing the whole device. If you want to reserve part of the disk for a
volume of another format, such as a Macintosh volume, enter the number
of blocks to be formatted for Workshop use.

Name of new volume?

2-14
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2.2.3

Specify a name for the new volume. The name can be up to 32 characters.
Don't initialize a volume with a physical device name or logical device
name (—lower or —printer, for example)—if you do, the results are
unpredictable.

Hax number of files allowed on volume? [56]

The default value shown is for micro diskettes. To accept the default,
press Return. The default for other disks is computed by the formula

max files = min (4000, (7 = blocks on device / 100))

If you plan to keep a large number of small files or a small number of
large files on the volume, change the catalog size from the default.

Initializing includes formatting of micro diskettes. Hard disks are

formatted at the factory. When the operation is compieted, the volume is
mounted.

The Mount (M) and Unmount (U) Commands

Mounting makes an OS volume accessible to the Workshop. At boot time,
any volume on a device configured in the Device Connections table of
Preferences is mounted automatically. For instance, if a micro diskette is
present in the micro diskette drive at boot time, it is mounted. In
addition, the Pascal run-time system will automatically mount a micro
diskette at the time the run-time system receives or is waiting for
keyboard input.

The Mount command lets you explicitly mount a volume. Mount should be
used whenever you connect a new hard disk. Mount prompts you as
follows:

What device to mount (A device name) ?

Specify the name of the device on which the volume resides. The Workshop
gives you an error message if you try to mount a volume that is not

initialized or if you try to mount a volume on a device that already
contains a mounted volume.

The Unmount command takes a device offline. A/ways wwnount & device
before disconnecting it from a booted system. You can specify either the
device name or the volume name. Unmount prompts you as follows:

¥hat device/volume to unmount ?

To eject a micro diskette, use the Unmount command or press the
Apple-Shift-1 key combination,
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If you unmount the Prefix volume, the boot volume automatically becomes
the Prefix volume. Note that when you use the Scavenge command to
repair a disk, Scavenge unmounts the disk.

2.2.4 The Scavenge Command (S)
A volume can be damaged if the Operating System terminates
abnormally—for example, in a power surge or blackout—or if you
disconnect an external hard disk from the Lisa without first unmounting it.
If the disk is used afterwards, the same blocks may be allocated to more
than one file. The Scavenge command repairs a damaged volume by running
the OS Scavenger, which restores a volume's catalogs, files, and allocation
tables to a consistent state. Scavenge prompts you as follows:

Scavenge what device/volume ?

If a file is changed by the Scavenger, it is given the S attribute. This
attribute is displayed by the List command. The changes may or may not
affect the contents of the file. After running the Scavenger, list the
volume catalog. Check any file that has the S attribute before relying on
/ts contents. After checking the file, you can use the ClearAttributes
command in the FileAttributes command line to remove the S attribute.

The Scavenger unmounts the volume to be repaired. After the scavenge is
complete, the Scavenger remounts the volume. |f the working directory
volume is scavenged, the working directory reverts to the boot volume.

/f you need ta scavenge your boot vol/urme which cannot be unmounted, boot
from the Workshop Pascal 1 micro diskette. Follow steps 1 through 4 in
Section 1.2.3, Installing the Workshop Pascal Software. When the Main
Menu appears, click on the Repair button and follow the instructions on
the screen. The Scavenger will show you, one at a time, the disks
connected to the Lisa. Select the boot volume when the Scavenger shows
it to you. The repair operation may take several minutes. When the
Scavenger has finished repairing the boot volume, the Main Menu will
reappear. Click Finished; then you can either turn the Lisa off or start up
from the repaired boot disk.

2-16
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2.3 Copying and Deleting Files
There are four File Manager commands for copying and deleting files:

* Copy duplicates files onto the same volume or another volume.
You can also copy files to the logical devices —printer and
—console,

* Dackyp selectively duplicates files.

* Jransfer moves files by making duplicates and deleting the
originals. (If you Transfer a file to —console or —printer, the
original is not deleted.)

« Delete deletes files by removing their catalog entries.

You can copy or delete more than one file at a time by using a wild card
character in the file specifier, as described in Section 2.1.2.4.

The Copy, Backup, and Transfer commands allow you to copy files to
multiple valumes 1f you run out of room on a micro diskette during a
copy operation, you are asked whether you want to continue on another
diskette. If you answer Yes, you are led through a diskette change and the
copy operation continues, The volume names of the subsequent diskettes
need not match the first.

The File Manager doesn't normally compare the source file to the
destination file to make sure the the copy operation was successful. The
Validate command in the System Manager lets you change this default so
that copy operations are verified.

If files are being copied fo a catalog structure, catalogs explicitly named
in the destination file specifier must exist on the destination volume. To
create a catalag, use the AddCatalog command.

If files are being copied 7rom a catalog structure, catalogs not explicitly
named in the saurce file specifier will automatically be created on the
destination volume.

NOTE

The name Workshop.temp is used by the File Manager for
temporary files created during copy operations. Do not use this
name for permanent files.
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2.3.1

2.3.2

The Copy Command (C)

The Copy command lets you make a duplicate of one or more files on the
same volume or a different volume. You can give the duplicate the same
name as the original or a different name. Remember, however, that
filenames on a given volume must be unique.

Here is an example of a simple copy operation that copies a file from the
—master volume to the —backup volume without renaming it, using the $§
wild card character:

Copy from what existing file(s)? -master-July.23
Copy to what new file? -backup-$

To enter the same command on a single line, type the source file specifier
and destination file specifier separated by a comma:

Copy from what existing file(s)? -master-July.23, -backup-$

To copy a file onto the same volume with a new name, enter:
Copy from what existing file(s)? -master-July. 23, -master-Aug. 23

To copy all the files on @ micro diskette onto a hard disk, adding the prefix
"micro/" to each destination filename, enter:

Copy from what existing file(s)? -#13-s -#11-micro/$

To copy all the files in one catalog on the working directory volume into
another catalog on the same volume, enter:

Copy from what existing file(s)? arts-s craftg-=

The crafts catalog must previously have been created using the AddCatalog
command. Subcatalogs of the arts catalog (music, concerts, prose, and
novel) will automatically be created on the destination volume; refer to
the example in Figure 2-1.

The Backup Command (B)
The Backup command allows you to copy files selectively. Its prompts are
similar to those of the Copy command:

Backup from what existing file(s)?
Backup to what new file?

For each file on the source volume with a matching name on the
destination volume, the file contents are compared, |f the contents are
different, the source file is copied to replace the old destination file. If a
source file has no matching name on the destination volume, it is copied.
The files on the source volume remain unchanged.

e
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Figure 2-6 shows the results of a backup operation on a set of files. In
this figure, each shape represents a filename; its shade represents the
contents of the file.

J
CURRENT FILES -L BACKUP FILES == NEW BACKUP FILES

backup remains

€

backup remains

Figure 2-6
The Backup Command
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2.3.3

2.3.4

, ,/"ﬂ\\
i

The Transfer Command (T)

The Transfer command allows you to move files. The source file is copied
to the destination file; if the copy is successful, the source file /s deleted
If you have set the System Manager Validate command to confirm
selections for file operations you are first asked,

Do you really want source file(s) removed after a successful Transfer?

If you type A Transfer tells the Copy command to take over. |f you type
Y, Transfer proceeds. The Transfer prompts are similar to those of the
Copy command:

Transfer from what existing file(s)?

Transfer to what new file?
If you transfer files to —console or —printer, the source files are not
deleted.

The Delete Command (D)

The Delete command lets you remove one or more files or catalogs from a
volume.

To delete a single file:
Delete what file(s)? -ancestors-patriarchs-abraham. text

To delete several files, use the wild card + in the file specifier to search
all levels of the catalog:

Delete what file(s)? -ancestors-patriarchs-s

If you have set the System Manager Validate command to confirm
selections for file operations, the files to be deleted are listed:

ABRAHAN. TEXT is Selected
ISAAC. TEXT is Selected
JACOB. TEXT is Selected

Are you sure you want to Delete these files ? (Y or N)

2.4 Changing File Attributes

File attributes are characteristics of files and catalogs. Attributes include
safety features that prevent accidental deletion or unauthorized access as
well as information about the file's reliability. The Attr column in the
List command display shows the current attributes of a file. Table 2-4
shows how attributes are set and cleared. See Section 2.5.1, The List and
Names Commands, for more information.

The filename is considered a file attribute.
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2.4.1

2.4.2

The Rename Command (R)

The Rename command lets you change the name of a file, volume, or
catalog. You can rename a group of files or catalogs by using wild card
characters. Don't rename a volume to a physical device name or logical
device name (such as —lower or —printer); if you do, the results are
unpredictable.

The Aename command changes only the filename attribute, not the
contents of a catalog or file. See Section 2,6.3, The AddCatalog
Command, for instructions on how to recatalog a file.

To change the filename part of a file in a catalog structure, enter:
Rename what file(s)? LEDGER-FY85-APRIL.TEXT
To what new name(s)? LEDGER-FYB5-HAY. TEXT

You can place the file specifier for the new name on the same line as the
old name; separate the names with a comma. To rename all the text files
on a volume, enter:

Rename what file(s)? -#13-+ TEXT, -#13-=. WORDS

To change the case of the letters in a filename, rename the file to a
temporary name and then rename that to the name you want:

Rename what file(s) ? DEMOGRAPHICS.O0BJ. temp. casechange
Rename what file(s) ? temp.casechange. DemoGraphios.(Obj

The FileAttributes Command Line (F)

This command is used to set and/or clear some of the file attributes shown
in the Attr column of the List command display. Refer to Table 2-4 in
Section 2.5.1 for more information.

The FileAttributes command has its own command line:
FileAttributes: ClearAttributes, Protect, Safety, AddPassword, RemovePassword, Quit

Commands in the FileAttributes commmand line are described below. To
use a FileAttributes command from the Workshop Command line:

1. Type F for File Manager.
2. Type £ for FileAttributes.

3. Type the first letter of the FileAttributes command; for
example, 4 for AddPassword.

2-21



Workshop User's Guide The File Manager —

3

2.4.2.1 ClearAttributes (C)
The ClearAttributes command removes the following attributes from one
or more files:

C File was closed by the Operating System.
0 File was left open when the system crashed.
S File was changed by the Scavenger.

If any of these attributes appear when you list files with the List
command, there is a possibility that the files are missing information or
are damaged in some way. C is least serious, S is most serious. Flease
check the contents of these files before relying on them.

To clear file attributes, respond with a single filename or a wild card file
specifier to the prompt

Clear °'C’. °0' and 'S*' attributes on what file(s)?

2.4.2.2 Safety (S)
The Safety command allows you to set the safety attribute (L) on a file to
the /ocked position. A locked file cannot be deleted. You cannot lock a
catalog or a volume.

To lock or unlock a file, respond with a single filename or a wild card file
specifier to the prompt

Change safety condition for what file(s)?
and then reply to the prompt
Set safety switch so you cannot delete rilenawe 7 (Y or N)

Y locks the file; AV unlocks it.

2.4.2.3 Protect (P)
The Protect command is used to make an executable program into a
pratected master. A protected master can be run on any Lisa and copied
on any Lisa. However, the copies will run only on the Lisa that makes the
first copy of the file. 7h/is protection canmnot be removed although a
protected file can be deleted.

To make an executable object file into a protected master, respond with a
single filename or a wild card file specifier to the prompt

Proteoct what file(s) ? (Turns file into a copyable master.)
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2.4.2.4 AddPassword (A)

The AddPassword command provides password protection, a privacy feature
that prevents unauthorized access to a file. The Workshop tools cannot
open a file that is password protected. You must remove the password in
order to use the file, and you can't remove a password unless you know it.

To provide password protection, respond with a single filename or a wild
card file specifier to the first prompt; respond with your choice of
password to the second prompt:

Add password protection to what files ?
¥hat password ?

To use a password-protected file, remove the password, use the file, and
then add the password again to restore the protection.

2.4.2.5 RemovePassword (R)

2.4.2

The RemovePassword command lets you remove protection from a file
that has been protected with AddPassword.

To remove password protection, respond with a single filename or a wild
card file specifier to the first prompt; respond with the previously assigned
password ta the second prompt:

Remove password protection from what files ?
¥hat password ?

If you use a wild card, all of the files must have the same password.

6 Quit (Q)

The Quit command exits from the FileAttributes command line to the File
Manager command line.

2.5 Getting Information about Files

The List command provides information about files and catalogs on a
volume. It lets you know how much space has been used for files and how
much free space remains available on the volume. The Names command
tells you the names of files and catalogs on a volume. The Equal command
compares two files and tells you whether their contents are the same.
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2.5.1 The List (L) and Names (N) Commands
The List command lists the contents of a catalog. You can display a single
file, selected files, or all the files on a volume by using wild card
characters. List displays a variety of information about the files and
catalogs on a volume, alphabetically by filename. The Names command,
which is faster, displays filenames only. The syntax for these commands is

identical.

The File Mansger

Respond to the List or Names prompt with a file specifier or press Return
to use the default, which lists all files at the top level of the prefix

catalog. The prompt looks like this:

Volume name? (-<volume)>-<wildcard)) [-#11-=]

A wild card may be used alone or after the rightmost dash in the file
specifier; for Instance, = or —#11—pr=_text. When a # or ¢ wild card
is the last character in the file specifier, the List command indents
filenames to show the catalog structure: for instance, arts+.

An examnple of the List display is shown in Figure 2-7.

Contents of -#il-arts#

Filename Size Psize
arts 0 0
dance 2048 4
music 0 0
albums 2048 4
concerts 0 0
chamber 2048 4

orch 2048 4

solo 2048 4

prase 0 0
Jjournal 2048 4
novel 0 0
chars 2048 4

plot 2048 L}

story 2048 4
theater 2048 q

40 total blocks for files listed

Last-Mod-Date

08/16/84-10:141
08/146/84-11:39
08/14/84-10:41
08/16/84-11:39
08/14/84-10:41
08/16/84-11:38
08/14/84-11:39
08/16/84-11:38
08/146/84-10:41
08/16/84-11:40
08/146/84-10:42
08/16/84-11:41
08/16/84-11:40
08/16/84-11:41
08/14/84-10:44

127 blocks of 0S overhead for catalog and files listed

1117 blocks free out of 9490

Creation-Date

08/16/84-10:414
08/16/84-11:39
08/14/84-10:41
08/16/84-11:39
08/16/84-10:41
08/16/84-11:38
08/14/84-11:39
08/14/84-11:38
08/14/84-10:41
08/16/84-11:40
06/16/64-10:42
08/16/84-11:41
08/14/84-11:40
08/16/84-11:41
08/14/84-10:44

Attr
D
D

D

Figure 2-7
The List Display: Listing of ARTS Catalog

2-24

TN



MAY-85
Workshap User's Guide The File Manager
The List command displays the following information:

Filename Name of the file.
Size Logical file length in bytes.
Psize Physical file length in pages (512-byte blocks).
Last-Mod-Date Date and time the file was last changed.
Creation-Date Date and time the file was created.
Attr File attributes, one or more of the following:

C File was closed by the Operating System.

D File is a catalog (directory).

L File is locked and cannot be deleted.

0) File was left open when the system

crashed.
P File is a protected master.
S File was changed by the Scavenger.

File is password-protected.

Table 2-4 shows how file attributes are set and cleared. ClearAttributes,
Safety, Protect, AddPassword. and RemovePassword are commands in the

FileAttributes commmand line of

the File Manager. Scavenge, AddCatalog,

and Delete are File Manager commands.

Table 2-4
How File Attributes Are Set and Cleared
Attr Meaning Set By Cleared By
C Closed by OS  Operating System ClearAttributes
D Directory AddCatalog (permanent)
L Locked Safety Safety
0 Open at crash Operating System ClearAttributes
P Protected Protect (permanent)
S Scavenged Scavenger ClearAttributes
. Password AddPassword RemovePassword
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To list the contents of a volume, specify its volume name, device name, or
alias followed by a wild card character. Follow one of these examples:

-#11-= device nome
-#13-# device name
-DevelopmentVol-¢ volume name
-lower-? alias

To list the files and catalogs at all levels of the working directory. enter:
2

To place the listing in a text file instead of on the console, enter the List
file specifier followed by a comma and the name of the destination file:

-#11-arts-», -#13-artslist
Wwhen a filename has to be truncated to fit into a limited field of the
display, the missing characters are indicated by ellipsis points (...). If the

full pathname of a file in a catalog is too long to list, you may see the
following message:

--> Error, Filename too long due to subcatalog names: rFilenawe
To list the file, choose one of the following actions:

* Include more levels of the catalog explicitly in the file specifier;
or,

* Give the subcatalogs and files shorter names by renaming them.

2.5.2 The Equal Command (E)
The Equal command compares the contents of two files or two sets of
files and tells you whether they are exact/y the same. The command
prompts you as follows:

Compare what file(s)?
Against what other file(s)?

You can respond to the first prompt with both file specifiers, separated by
a comma.

Sometimes files are found to be unequal for reasons that you might prefer
to ignore. For example, if logically identical text files have different
markers set, or if one uses blanks compression and the other doesn't, they
will not be found equal by the Equal command. These files will be found
equal by the Compare utility for comparing text files, described in
Chapter 11,
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2.6 Additional File Manager Commands

2.6.1

2.6.2

The following sections describe the Quit command, the Prefix command,
and the AddCatalog command.

The Quit Command (Q)
The Quit command exits from the File Manager subsystem to the
Workshop command line.

The Prefix Command (P)

When you don't include a volume part in a file specifier, the Workshop
looks for the file in the warking directory. The working directory, also
called the prefix may be either a volume catalog or a lower-level catalog.
The working directory is set by the Prefix command; the default is the
boot volume catalog.

You can specify up to three prefixes, as shown in Figure 2-8. The working
directory is the first level; it lets the Workshop find programs or other
files when a volume or catalog is not included in the file specifier. 7/4e
second and third levels are for programs only. The Workshop 1ooks in these
prefix catalogs (Prefix #2 first, then Prefix #3) if you don't supply a
volume in the Run command and the program you want to run isn't in the
working directory.

-

E’refix #1]= [—#11,] (*/'=NoValue)| [-#11] new value?

N N

Prefix level: Current prefix Default prefix
#1 is the at this level at this level

working directory

Figure 2-8
The Prefix Command
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o
A prefix can be a volume catalog or a subcatalog. Specify the complete
pathname. The Prefix command prompts you as follows:

Prefix #1 = -1, (*/'=NoValue) [-#11] new value?

To specify the default prefix, press Return. To remove the current prefix
without specifying a new value, type a slash character (/). To specify a

new value, type the pathname. The new prefix volume must be mounted.
Here are some examples:

. new value? -#13

. new value? -lower
... new value? -TestVol
. nhew value? -#11-arts-music-concerts

. nhew value? /

You can set prefixes permanently, or just until you reboot. After you have
specified three levels of prefix, you see the following prompt:

Initialize this Prefix Set at boot time? (Y or N) [No]
To specify that the prefixes are temporary, type ~or press Return. To

cause these prefixes to be the default prefixes the next time you boot,
type »

If you unmount or eject the working directory volume, the boot volume
becomes the prefix volume. (The Scavenger unmounts a volume before it
repairs it.)
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NOTE

If you have made changes to INTRINSIC.LIB so that not all library
names begin with —#boot— or its equivalent, you may have a
problem running programs that use intrinsic units. The OS Loader
looks for files without a volume part in the working directory, not
on the boot volume,

To ensure that your intrinsic libraries are found when the working
directory is not the boot volume catalog, do one of the following:

* Change the names of your libraries in INTRINSIC.LIB to
pathnames of the form —#boot—libname, using the
IUManager utility described in Chapter 11; the standard
Workshop intrinsic libraries use pathnames of this form.
Then reboot so the OS will store the new names. This s the
preferred method. Or,

* Copy your intrinsic libraries to the working directory volume,
This allows you to support several different library
environments, though you could end up with a proliferation of
library files.

2.6.3 The AddCatalog Command (A)
The AddCatalog command tells you how to create a subcata/og a catalog
below the level of the volume catalog. Before you can catalog files at
lower levels, you must create the catalog structure using the AddCatalog
command.

There is no special command to put a file in a catalog. Once the catalog
structure has been created, filenames are cataloged automatically when you
create the file if one of the following conditions is true:

* The new file's name includes full volume and catalog parts; or

= The new file's name doesn't contain a volume part and the
working directory is a catalog.

To refer to a file in a catalog structure, provide either a full pathname or
a pathname with a catalog part that can be found in the working directory.
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The dash (—) is the catalog delimiter. The full pathname of a cataloged
file takes the form

—vol—cat—file
or, more generally,
—vol—cat1—catZ ... —catMfile

A filename of the form cat2—file is interpreted relative to the working
directory. It may refer to —vol—cat2—file or —vol—cat1—cat2—file,

and so on, depending on whether Prefix #1 is set to a volume or to a
catalog.

A file or catalog without a volume part is created using the current
working directory as a prefix. For example,

* Set Prefix #1 to —#11—arts—music.
* Copy a file to the destination concerts—flute.text.

* The new file is cataloged as
—#11—arts—music—concerts—flute.text.

To catalog the file arts—prose—novel—plot shown in Figure 2-1, first
create the catalog structure in the working directory; then create the file N
using the Editor, the Copy command, or another Workshop tool: ' ‘

Add what new catalog ? arts

Add what new catalog ? arts-prose

Add what new catalog ? arts-prose-novel

Copy from what existing files(?) firstdraft.text
Copy to what new file? arts-prose-novel-plot

The volume containing the catalog must have been initialized using
Workshop Release 3.0 or later. If you try to add a catalog to an older
volume, you will see this message:

--~-)> Error number 1285, Creating new catalog " -F/7-newcat”
Operation is not allowed on a volume with a flat catalog

If this occurs, copy the contents of the volume to another disk, reinitialize
the volume, and then add the catalog.
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The Rename command changes only the filename attribute, not the
contents of a catalog or file. To recata/og a file,

1. Use the List command to see if all levels of the new catalog
name exist.

2. If necessary, add the new catalog names using the AddCatalog
command. For example,

Add what new catalog ? matriarchs

J. Use the Transfer command to move the file from the old catalog
to the new one. For example,

Transfer from what existing file(s) ?
patriarchs-abraham. text

Transfer to what new file? matriarchs-sarah. text

2-3



Chapter 2
The File Manager

21 The File Manager

...................................................... 2-1
22 Ueing the File Manager . ___ .. i ieiiiaieeinan 2-1
23 The File Commands . . ... .. iiccccecmcemaeae s 2~-1
231 [ 7= Ut B |« 2-2
2.3.2 L] P 2-2
2.33 Delete .o 2-2
2.3.4 I - A AR 2-2
2.35 [ =] 1 5 2-3
2.3.6 L AT 2 7= Y 2-4
2.3.7 L= 1 = 2-4
238 UL L e e 2-4
239 EQUAL e 2-4
2.3.10  FlleAttributes ..o e 2-4
2311 Inttialize .. oo e 2-5
2.3.12  MOUNt e 2-6
A T B T N - o o N 2-6
2.3 04 ONIINE et 2-6
2,305 SCBVBNGE ..ottt e 2-7
23,06 UNmMoUNt e 2-8
24 The Warkshop View of the Files ____.. .. ... .. ... 2-8
241 0OS Volumes on Disk ..ot 2-8
24.2 File Specifiers ... . ... i 2-8
2.4.3 The Working Directory and the Prefix .................... 2-10
25 Using Wild Card Characters .__ ... .. . .. 2-11
26 How Do I List Existing Files? e 2-13
27 HowDo I Copy aFile? .. . iceaae-. 2-14
28 How Do I Delete a File? _.. . e, 2-14
29 How Do I Create and Use a Yolume? ... . oo, 2-15
2.10 How Do I Change the Name of a File or Yolume? __.._________.. 2-15

See also the Release 3.0 Notes for this chapter.



CHANGES/APDITION'S
Workshop 3.0 Notes The Flle Manager

Chapter 2
The File Manager

Overview of Changes to the Flle Mmagrr
The significant changes to the Flle Manager involve:

* The Operating System's new hierarchical catalog structure.
* Transfer operations onto more than one micro diskette.

* Password protection.

* The new OS device names.

The Operating System uses new physical device names, but still supports the
old names as gevice allases. You can specify a device uslng elther the name
or the allas; the OS refers to devices by name. The table shows new names.

Device Names and Phases

Name _ Allas Device

#10#1 RSZ232A Serial Port A

#10#2 RSZ3ZB Serial Port B

#11 PARAPORT Parallel Connector (Lisa 1)

#12 UPPER or PARAPORT Bullt-in hard disk (Lisa 2)

#13 LOWER Micro diskette drive

#15#1 ALTCONSOLE Altemate console

#15#2 MAINCONSOLE Main console

#X SLOTx Peripheral at expansion slot x

#x#y  SLOTXCHANY Peripheral at expansion slot x, connector y

#x#y#z SLOTXCHANYDEVZ Peripheral at expansion slot x, connector
y, device z

AoCatalog Command
Files on a volume can now be arranged under catalogs and subcatalogs. The
AaaCatalog command lets you create new catalogs. The pathname you specify
for a catalog should refer to a volume that has been initialized using the
Release 3.0 software.

The /woen is the catalog delimiter, so a file name referring to a file in a
catalog might look like —vol-cat-file or ~vol-catl-cat2-file, and so on. A flle
name of the form cat-flle is interpreted relative to the current prefix and thus
might refer to ~vol-cat-flle or -vol-catl-cat-flle, depending on whether the
prefix is set to a volume or to a catalog. A catalog specified by a pathname
without a volume part will be created using the current main prefix

There is no speclal command to put a flle in a catalog. Once a catalog has
been created, new flles get put into it in two ways:

Notes 2-1
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= If the new file’s name is specified by a full pathname with volume and
catalog parts, the flle is put in the specified catalog. (A catalog must exist
before a file can be put Into 1t)

= If the new file's name is a partial pathname without a volume part, and the
current prefix Is a catalog, the file is put In the prefix catalog (or a
subcatalog, if the file's pathname includes a catalog part).

when the OS tries to find a flle given a partial pathname, the file will be
found only if (1) the pathname has no catalog part and is located in the prefix
volume or catalog, or (2) the pathname has a catalog part corresponding to a
path starting with a catalog at the top level of the prefix volume or catalog.

/Transfer to Multiple Micro Diskettes
(See Sections 2.3.1, 2.3.2, and 2.3.7)
The Backup, Copy and Transfer commands now allow backups, coples, and
transfers to multiple volumes. If a list of files is being copled (or backed up,
or transferred) to a micro diskette and you run out of space, you will be told
which flle aion't fit and how many more blocks were needed, and you will be
asked whether you want to continue on another aiskette, If you answer Yes,
you will be led through a diskette change and the operation will continue.
Note that the volume names of the subsequent diskettes need not match the
first, even if the original destinatlon was specified with a particular volume
name (Instead of a device name).

List and Names Commands (See Sections 2.3.4 and 2.3.13)
There are two new attributes for items in the List display. The D attribute
indicates a directory (a catalog object) and the = attribute Indicates a
password-protected file (see Password Protection, below}

The List and Names commands now Indent names to show the catalog structure
whenever you list a contiguous set of flles. If you specify a wildcard character
followed by a string to match, the files shown will not necessarily be
contiguous, and will not be indented.

when a file name has to be truncated to fit into a limited field of the display
(els1 lnitJZe List command), the missing characters are now indicated by an
eltipsis (...

Prefix Command (See Section 2.35)
Preflxes may now be set to catalogs in addition to volumes. A prefix to a
catalog or subcatalog must be specified with a complete pathname.

The effect of the current prefix on the interpretation of file names Is discussed
under AddCatalog Command, above.

Notes 2-2
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WARNING

Setting the maln prefix (or working directory) may cause problems when
running programs that use Intrinsic units (this includes all the workshop
tools). The OS loader tries to find a program's intrinsic libraries using the
patnnames it finds In INTRINSIC.LIB; If these names are partial
pathnames, it looks on the prefix volume or catalog, mot e boot volme
To assure that your program's Intrinsic libraries are found, you can ao one
of two things:

* Copy the intrinsic libraries to the prefix catalog. This way, you can
support several different library environments on the same volume,
though you could end up with a proliferation of library files.

* Change the names of the librarles In INTRINSIC.LIB to pathnames of
the form -#800T-lbname (using the IUManager, described in Chapter
11, utllities), then reboot so the OS wlll store the new names. This
method is better, but be careful about changing things In
INTRINSIC.LIB.

If you unmount the main prefix volume by ejecting the diskette, Scavenging the
volume, or using the Unmount command, the boot volume becomes the prefix
voiume.

Rename Command (See Section 2.3.6)
To rename a file to a name that only differs from the original in the case of
the letters (e.g., DEMOGRAPHICS.08J to DemoGraphics.Obj), you must first
Rename the flle to a temporary name, then Rename that to the name you want.

Password Protection (See Section 2.3.10, FlleAttributes)
Two new commands for password protection are found under the FlleAttributes
command. AddPassword allows you to password-protect a file (or files, using
wildcards). RemovePassword allows you to remove a flle's password, but you
must know the password to remove it

The Workshop tools can't open a file once it Is password-protected; you must
remove the password before you can use the flle.

Initiallize Command (See Section 2.3.11 and 2.4.1)
volumes initialized under the new Workshop and OS have a hierarchical catalog
structure. Since this structure cannot be applied retroactively, an existing
volume mwst be reinitialized in order to take advantage of these features.
Commands that operate on a list of flles (e.g, List) run much faster on a
reinitializea disk, because In the new structure names are already sorted.

Notes 2-3
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Online Command (See Section 2.3.13)
The Online command now displays both the new OS gevice names and the old
names, which are now device allases. The new device names are listed in the
Overview at the beginning of this section, and shown In the syntax diagrams
under Flle Specifiers, below.

The prefix attribute P is now sometimes displayed as a lowercase p. Uppercase
P Indicates that the main prefix is the indicated volume, while lowercase p
Indicates that the prefix is a catalog on that volume.

NOTE

The Online command uses the configuration information set by
Preferences. If Online output says that it could not find #11 (PARAPORT)
on a Lisa 2710, use Preferences to detach the nonexistent device. If the
workshop pauses unexpectedly in the miadle of Online output, it means a
device is configured but not present. Make sure that Preferences' idea of
how the system Is configured Is correct.

Flle Specifiers (See Section 2.4.2)

File speciflers have changed to allow for subcatalogs, new device names, and the new
wild card characters. The diagrams that follow show the new format of file
specifiers, replacing those on pages 2-9 and 2-10 of the manual. (The logical device
names have not changed, but the diagram Is repeated here for convenience) A full
pathname must not exceed 255 characters; the pieces between dashes (-) must not
exceed 32 characters.

file-specifier T
| file-name-or-pattern

lCD—»I logical-device

file-name-or-pattern

» file-name
volume/catalog-spec |j 10{ wild-cerd-spec

volume/catalog-spec

volume-name - subcatalog °

physical-device .2

¥

L 4

Notes 24
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physical-device

—+| physical-device-name
1—0{ physical-device-alias T
physical-device-name physical-device-alias
—<—+{( PARAPORT ot

212 ~—»{ UPPER )
#13 N—»{( LOWER ]
N—»(SLOTx D
~—»( SLOTXCHANY T+
N—»{_SLOTXCHANYDEVz )1
~—»{_Rs232A ) aat
—»{(_Rs2328 )t
~—»{( ALTCONSOLE )
“—+( MAINCONSOLE

{The device names on the left correspond to the device aliases on the right.}

Notes 2-5
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logical-device

CONSOLE

' PRINTER '

KEYBOARD

2

wild-card-spec

The Flie Manager

L, )
string-1

rL

.
»

New = and ¢ Wildcard Characters (See Section 2.5)
Because of the new hlerarchical catalog structure, the meanings of the = and 7

wildcard characters have ch:

anged, and the new analogous wildcards =

(OPTION =) andt & (OPTION ?) have been added. The plain = and 7 wildcards
mean search for a match only across the top level of the catalog, while the
option wildcards mean search through all levels. The way in which the matches

are made 1s the same:

= matches any string in the top level of the catalog.
= matches any string throughout all levels of the catalog.

7 matches any string in the top level of the catalog, asking for confirmation
of each file name before performing the operation.

¢ matches any string throughout all levels of the cataloy, asklng for
confirmation of each flle name before performing the operation.

Notes 2-6
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21 The File Manager

The File Manager is a subsystem of the Workshop. It provides file and device
manipulation facilities, and handles most of the tasks of transferring
information from one place to another. Using the File Manager, you can do
such things as make copies of files, list directories, rename or delete files,
find out what volumes are on line, initialize new disks or diskettes, print files,

and so on. See the Quersting Systern Rerererice Marnsal ror e L7sg for more
information on the File System and supported devices.

22 Using the File Manager

To use the File Manager, press F in 1esponse to the workshop command

prompt. The File Manager begins executing, and displays the File Manager
prompt line:

FILE-MGR: Backup, Copy, Delete, List, Prefix, Rename, Transfer, Quit, ?
Pressing 7" displays the additional command line:

Equal, FlleAttributes, Initialize, Mount, Names, Online, Scavenge, Unmount
To redisplay the original command line, press [RETURN]

To execute any command, press the first character of that command name
while the File Manager command line is displayed. Most commands ask for
file names, or other input parameters. If there is a default value for a
parameter, it is displayed in square brackets ( [default] . To accept the

default, just press [RETURN] If you do not want the default, type in the
value you want

To manipulate files with the File Manager you need to address the file with a
Ale speciffer A file specifier can be an 0S pathname (representing a file on
a disk or diskette), an 0S volume name (for example, ~MYDISK), the name of a
physical device (for example -RS232A), or the name of a logical device (for
example -printer). File specifiers can contain wildcards enabling them to
specify a collection of files. See Section 2.5 for rmore information on
wildcards. See Section 2.4 for more information on file specifiers.

2.3 The File Manager Commands

The File Manager commands are listed in the File Manager prompt line. They
are: Backup, Copy, Delete, List, Prefix, Rename, Transfer, Quit, Equal,
FlleAttributes, Initialize, Mount, Names, Online, Scavenge, and Unmount.

Each of these operations is described below. Information on wild card
characters can be found In Section 2.5.
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231 Backup (B)

The Backup command executes a simple backup utility, similar to Copy. It
asks for source and destination file specifiers, which will most likely contain
wild cards (see Section 2.5). It then compares the source files to the
destination files. Whenever the contents of the two files are not equal, the
scurce file is copled. If a source file is missing from the destination, it is
copled. Thus it coples only different files from the source to the destination.

NOTE

The destination file is temporarlly named Workshop.temp, and the
source file is automatically copied. If the copy is successful, the
destination file is renamed with its original name, and the files are
compared. If the files are different, the first file Is deleted. Ordering
the process this way prevents deletion of the destination file before
verification that the source file is good.

Because the file name Workshop.temp is intemnally involved in the
Backup command, do not assign that name to your files.

232 Copy (C)

The Copy command coples files. It asks for a source file specifier and a
destination file specifier. You can use wlld cards if you want to copy more
than one file. The source file(s) are not changed by this command.

The default is not to verify copy operations. ‘You can change this default
with the Validate command in the Systemn Manager. If you change the
default, the source file is compared to the destination file after the copy
operation to ensure that they are the same. The Validate command is
described in Chapter 3.

Text files are handled specially when copied to the -printer or -console
logical devices. Leading blanks in a line of text might have been replaced by
a DLE,countz pair to save disk space. As such pattems are detected, they are
replaced by (count) blanks in the copy of the file sent to the printer or
console. All other files are sent byte by byte unchanged.

233 Delete (D)

The Delete command is used to delete a file or a number of files specified by
a wild card expression. It asks you to specify the files to be deleted.

234 List (L)

The List command lists information about the files matching the given file
specification. If all you need is the names of the flles, use the Names
command described in Section 2.3.13.
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* If the flle specifier Is a flle name (for example -MYDISK-example.text)
Information from only that file is listed.

= If the file specifier is a volume name (for example -MYDISK), information
about all files on the volume Is listed.

= If the flle specifier Includes a wildcard character (for example,
-MYDISK-=.text) information about all matching flles is listed.

The list command displays the following information:

Fllename

Slze

Psize
Last-Mod-Date
Creation-Date
Attr

The name of the flle.

The logical file length in bytes.

The physical file length in blocks (512 bytes).
Date and time the flle was last changed.

Date and time the flle was created.

File attributes, a combination of the following:

C File was closed by the Operating System.

L Flle is locked. It cannot be deleted until the flle
safety switch Is wmed off. (See FileAttributes
command later in this section.)

File was left open when the system crashed.

0
P File is protected.
S

File has been scavenged.
An exarnple of the list display is shown in Figure 2-1.

Contents of volume -paraport-=

Filename

SYSTEM.DEBUG2

SYSTEM, IUDIRECTORY

SYSTEM.LLD
SYSTEM.LOG
SYSTEM.O0S
SYSTEM, SHELL
XEJECTEM. 08J

235 Prefix (P)

Size Psize Last-Mod-Date

14848 29 03/03/83-13:4¢6
7168 14 07/18/83-09:31
9216 1B 04/02/82-00:24
2992 4 07/18/83-18:56
188928 349 05/04/83-10:08
8704 17 04/02/82-06:24
512 1 06/02/82-00:27

Figure 2-1
The List Display

Creation-Date Attr
04/10/82~21:57
02/23/83-10:33
02/23/83-10:24
06/08/83-17:49 0
05/04/83-10:08 CO
03/29/83-15:14 CO0
03/29/83-159:22

The Prefix command enables you to set up default volume names to search
when you specify a flle name without a volume name. You can set up to three
volume names that will be searched In order, when you try to run a program,
until the file Is found. The first prefix Is the name of the working directory.

2-3
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These commands are accessed by pressing the first character of the command.
They perform the followlng functions:

ClearAttributes (C)
The ClearAttributes command clears the C, 0, and S attributes on the

specified volume, file, or set of files with wildcards. These attributes are set
by the system, and have the following meanings:

c Flle was closed by the Operating System.
0 File was left open when the system crashed.
S File has been scavenged.

See the Scavenge command in Section 2.3.15 for more information.

Safety (S)

The Safety cornmand allows you to set or remove the safety attribute (L) on
any file. when the safety attribute is set, the flle is called "Locked™ and
cannot be deleted. To delete a flle with safety on, use the Safety command
to remove the attribute, then delete the file.

Protect (P)

The Protect command is used to make an executable object file into a
protected master. This is a form of copy protection for programs. Once a
file is made into a protected master, this protection cannot be removed. A
protected master has the following characteristics:

* It can be run on any Lisa machine
* It can be copled on any Lisa machine.

* Coples made will run only on the Lisa that made the /r3¢ copy of the
flle.

NOTE

Once a flle Is made into a protected master, there Is no way to

unprotect it. Be sure you understand the characteristics of a protected
master before you create one.

This protection scheme is for executable object flles. Note that
protecting a flle does not prevent you from deleting it.

Quit (Q)
The Quit command exits from the FlleAttributes subsystem to the Flle
Manager.

2311 Injdalize (1)

The Inltialize command is used to format and initialize the Flle System on a
diskette or ProFile. It asks you for the device name to initialize, the number
of blocks to initialize, and the volume name. If you want the entire device to
be initialized, press [RETURN] for the number of blocks (accepting the
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default). If the device is a diskette, it Is formatted (ProFiles are factory
formatted) Boot tracks are automatically written to any device that is
initiallzed. An initialized device Is automatically mounted.

The Initlalize command warns you If you attempt to initialize a disk that
already contalns a volume, because the contents will be erased. A volume s
initialized to allow a certain maximum number of flles. You can make this
number larger or smaller (If you know you will have a large number of small
flles, for example) when Initializing it.

2312 Mount (M)
The Mount command Is used to make an 0S device accessible. It requests a
device name. It should be used whenever you connect a new device, such as a
ProFlle. The Unmount command, described In SecUon 2.3.16, s used to
remove a device. All conflgured devices are mounted at boot time. The
configuration can be changed with the Preferences tool, which Is described In
Section 3.3.

23.13 Names (N)
The Names command s a faster version of the List command. It gives you a
list of file names only. It asks for a file specifier, and displays the names of
all flles matching the glven file specifier.

2.3.14 Online (0)
The Online command produces a list of all the devices that are currently
mounted and avallable, with the following information:

DeviceName The name of the device.
VolumeName The name of the volume.

VolSize The number of blocks on the volume.
FreeBlks The number of blocks still avallable.
Files The number of files stored on the volume.
Open The number of flles open on the volume.
Attr The attributes of the volume:

B The Boot volume.
P The Prefix volume (Prefix 1)
M volume s currently mounted.

The Online display Is shown in Figure 2-2.
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FILE-MGR: Backup, Copy, Delete, List, Prefix, Rename, Transfer, Quit, 7N

Volumes on line

DeviceName VolumeName VolSize FreeBlks Files Open Attr
PARAPORT Fred’s Horkshop 9698 754 178 16 MBP
SLOT2CHAN2 0 9 ) @ M
RS232A 9 2 9 e M
RS232B ] ) 9 2 M
MA INCONSOLE 2 2 8 1 M
AL TCONSOLE @ 0 o o M
Figure 2-2

The Online Display

23.15 Scavenge (5)
The Scavenge command runs the 0S Scavenger, which restores damaged files.
Files can be damaged any time the Operating System terminates abnormally.
The Scavenger searches through a disk and restores its directories, files, and
allocation tables to a consistent state.

To scavenge a disk, use the Scavenge command and specify the device name.
After the scavenge Is complete, use the Mount command to mount it again,
and continue using it. The boot volume cannot be unmounted; therefore it
cannot be scavenged. If the ProFlle is normally your boot volume and you
need to scavenge it, 1t Is necessary to boot from a diskette or another ProFile
and run the Scavenger from it

If a file Is changed In any way by the Scavenger, the file attributes are set to
S, for scavenged. This attribuie is displayed by the List command. The
changes mate to the file mignt or might not affect the data in the flle,
depending on what state the file was In when It was scavenged. Examine any
file that has the scavenged attribute before relying on its contents. After the
file has been checked, you can remove the scavenged attribute with the
FlleAttribute command.
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NOTE

A disk’s File System can get into an inconsistent state if the Operating
System terminates abnormally, because the directories and allocation
tables are kept in memory and only written out to disk periodically. If
there is an abnormal termination, such as a power fallure, the

to the state of the Flle System since these tables were written to disk
might be lost. Information can also be lost if you disconnect a ProFile
from the Lisa without first unmounting it. If the disk is used after
such an event, more data can be lost if the system allocates the same
blocks to more than one file.

The Scavenger always retums the disk to a consistent state, but It is
possible to lose data when the system crashes. This damage can
become even worse If the disk is used while in an Inconsistent state.

All scavenged flles should be checked before you depend on thelr
contents.

23.16 Unmount (U)
This command makes a device inaccessible (takes it off line). It asks for a
device name. For diskettes, use a volume name to unmount, or a device name
to unmount and eject, the diskette. Always unmount a device before
disconnecting it from a running machine.

24 The Workshop View of Files
Workshop users are provided with a view of files and devices that Is actually
a composite of what is provided by the Lisa Operating System, the Pascal
run-time system, and the File Manager itself. Each contributes a specific set
of facllities:

* The Lisa Operating System provides support for a variety of input and output
devices, including both black-structured devices (disks and diskettes) and
sequent/al gevices (RS232 ports, consoles)

* The Pascal run-time system provides support for several Joglcal-devices
. (console, printer, keyboard) which are not provided by the OS.

* The Flle Manager provides wild-card facllities which enable many Flle
Manager commands to be applied to a whole set of flles, rather than just
one at a time.

241 0S volumes on Disk
Every block-structured device {s organized as a single volume with a flat
directory structure. Volumes can be initially created on a disk by using the
File Manager's Initialize command. The Initialize command:

1. Formats the disk (If necessary).
2. Records its assigned volume name of up to 32 characters.

2-8
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3. Creates its initial, empty directory (also called a cala/og).
4. Mounts the Initiallzed disk.

when an object Is created on a disk, its file name of up to 32 characters is
entered in the disk’s directory. Flle names must be unigue within a volume so
that every object can be clearly identified.

2.4.2 File Specifiers
within the workshop, file specifiers are used to identify the volume, device,
file, or set of files an operation applies to. The diagrarns that follow show
the makeup of a file specifier and its components.

flle-specifier
flle-name
volume-name ‘}J{%\—‘( wild—card-specJJ
physical-device
logcal-device | /
pnyslcal—devicg »(__wpEr ) 7 >

;,( LOWER }__J

~——»(_ PARAPORT
—»( SLOTmCHAND )———1

~—o»(  Rsz32A j————J
L—o( RS232B ) ——

logical-device
*(

PRINTER

KEYBOARD
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wlld-carg-spec

String-1 | ° String-2 7—“’

Q
(&)

A physical device name refers to a specific hardware device or port, whether
or not there is actually anything connected or mounted there, when a device
Is block-structured and mounted, its physical device name can be used in a
file specifier instead of the disk or diskette's volume name. Since sequential
devices are not mass storage devices, they never have volume names. The
only way to specify them Is to use thelr physical device names followed by
dummy file names; for example, "~-RS232A-X". Logical devices are also not
mass storage devices and do not have volume names. They can be referred to
by their logical device names only.

2.4.3 The Working Directory and the Prefix

Sometimes, specifying the same volume name or physical device name again
and again is inconvenient. with the File Manager's Prefix command you can
establish a particular volume as the 0S's working directory. Otherwise, the
default working directory is the volume the system was booted from. If a flle
specifier omits the volume or physical device name, the file or set of files is
assumed to be in the working directory. For example, if the working directory
Is -MYDISK, the file specifier PROGRAMI1.0BJ refers to the same flle as
~-MYDISK-PROGRAM1.08.J.

-UPPER The upper diskette; drive 1.

- OWER The lower diskette; drive 2.

-PARAPORT ProF!le attached to the parallel connector.

-SLOTMCHANN  ProFlie attached to the Parallel Interface Card In siot m,
channel n (where m is a slot between 1-3, and n is
channel 1 or 2).
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NOTE
To avoid confusion within the system, do not assign a device name to a
volume.

There are also two serial devices, -RS232A and -RS232B. These provide
access to external RS232 devices.

There are three logical devices that can be used for input and output. These
devices are:

-CONSOLE Used for output to the screen and input from the keyboard.
The actual device that Is used as the console can be
changed by the Console command in the System Manager.
See Section 3.2 for information on the Console command.

-PRINTER Used to oulput to the printer. The physical connector that
the printer is connected to Is set by the Preferences tool,
described In Section 3.3.3. If you have more than one
printer, the one that will be used is specified by the
DefaultPrinter command described in Section 3.2

KEYBOARD Used as a nonechoing input device from the keyboard. This
is the keyboard on the console device.

Certain types of files in the system have staoard file extensions. These
extensions make it easier to keep track of the different types of flles. These
file extensions are:

JEXT This indicates a text flle in the format created by the Editor.

.08) This indicates an object code file. Object files are created by
the code Generater, the Assembler, and the Linker. Object files
created by the Linker are executable.

B Tnis indicates an intermediate (I-code) file produced by the
Pascal Compller. The Generate command converts an
intermediate flle into an object code file.

.LIB  This Indicates a library directory.

25 Using wild Card Characters
wild card characters allow you to specify a set of files to operate on. The
command Is performed on all flles whose pathname matches the set speclfied.
Wild card characters are "=", "7, and "$". Only one wild card character can
appear In a file specifier. These characters are used as follows:

string1-string2
The "=" character stands for any sequence of zero or more characters that

can be ignored In the search. The surrounding, strings (stringl and string2)
must be matched exactly, ignoring case. Elther or both strings can be nuil.
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Here are some examples of using the "=" wild card character as a source file
name:

ds=.text All flles beginning with ds and ending In .text.
=.0Db]) All flles ending with .ob).
= All flles.

when "=" Is used in a destination flle name, it Is replaced with the characters
that were matched by a wild card In the source flle. This enables you to do

operations like change the name of a list of flles as they are copled. Here
are examples of using "=" as a destination file name:

ds=text to bu/ds=text Change all flles starting with ds and ending
with .text so they begln with bu/.

qd.- to quickdraw.- Change all flles starting with qd to begin with
quickdraw.

string17string2

The "?” character |s the same as the "=", except that the system asks you to
conflrm each flle name before performing the operation. The "?" wild card
can be used only in a source string.

when you use a "?" in a source specifier, you are presented with a list of files
that match It. You can move backwards and forwards through the list by
using the up and down arrows on the numeric keypad. Press Y beside every
file that you want to be processed. When you have selected all the flles you

want, press [RETURN] The operation will then be performed on the files you
selected after confirmation.

when using the List command, you cannot use the "7 willdcard In response to
the prompt for a volume name.

stringls$stringz

The "$" character can stand for part of a destination flle name only. It is

replaced by the entire source file name. For example, if you have the source
files matching ds-.text:

dsfmgr.text
dssmgr.text
If the destination expression Is bk$, the output files will be:

bkdsfmgr.text
bkdssmar.text

Contrast this with the output expression bk=text, which results in:

bkfrmgr.text
bksmgr.text
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Hint: You can adopt conventions for naming files that pretend there is a
hierarchical file system: for example,

Source/F1l.text
Source/F2.text
Source/XYZ.text

26 How Do I List Existing Files?

You can use either the List command or the Names command to list existing
files. The Names comimand executes much faster than the List command, but
it gives you only the file names.

1. If you are not in the File Manager subsystem, enter it by typing F in
response to the Workshop command prompt.

2. Execute the List command by pressing L, or the Names command by
pressing N.

3. If you want to list an entire volume, enter the pathname of the volume or
device. If you want to list only a certain set of files, enter a wild card
expression or pathname describing the files to be listed. (The "?" wildcard
cannot be used in response to the List command prompt for a volume
name.) If you want a listing of the default volume, press [RETURN]

The listing produced by the List command is explained in Section 2.3.4.

You can send a copy of the directory to a file by following the specification
with a comma and then the name of the file to send the directory to. For

example,
~paraport-bk/= foo.text
sends the directory to foo.text
For more information on wild card characters, see Section 2.5 in this chapter.

27 How Do I Copy a File?

You can Copy a file and leave the original file intact, or you can Transfer a
file, which copies the file, then deletes the original file. To copy a file:

1. If you are not in the File Manager subsystem, enter it by typing F in
response to the Workshop command prompt.

Press C to start the Copy command. (Press T, for Transfer, if you want
the original flle to be deleted after the copy operation.)

3. Enter the pathname of the file you want copied. Press [RETURN]
4. Enter the pathname you want the file to be copied to. Press [RETURN]
The file is copied or transferred as you specified.

N
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If you want to copy a number of files with similar names, or all the files on a
volume, you can use wild card characters. See Section 2.5 for more

information on using wild cards. Wwild cards can also be used to rename all
the coples of the selected files.

The following are examples of copy and transfer operations:

Copy from what existing file(s)? myprog
Copy to what new file? -backup-$

(This copies the file myprog on the working directory to the volume
-backup with the same name, myprog.)

Copy from what existing file(s)? ds=

Copy to what new file? -backup-$
(This copies all files beginning with “ds" on the working directory to
the volume backup with the same file name.)

Transfer from what existing file(s)? -aosback-0sg=
Transfer to what new file? -oswork-$

(This copies all files beginning with "osg" on the volume -osback to the
volume -oswork using the same file name. When the files have been
copied successfully, the original flles are deleted.)

You can use a shorthand method of entering the file names by entering both
the source and destination file names, separated by a comma () in response to
the request for the source file.

Transfer from what existing file(s)? -osback-0sg=, -oswork-$
(This is the shorthand version of the above transfer operation.)

Copy from what existing file(s)? ds=,-backup-backds=

{This coples all files beginning with “ds™ in the working directory to the
volume -backup with back inserted as the beginning of each file name.)

The Backup command is another way to copy files. It is selective, in that
only oifferent files will be copied. You use the same procedure to backup a

file as to copy a flle. See Section 2.3.1 for more information on the Backup
command.

28 How Do I Delete a Flle?
To delete a flle:

1. If you are not in the File Manager subsystem, enter it by typing F in
response to the Workshop command prompt.

2. Invoke the Delete command by pressing D.
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3. Enter the pathname of the flle you want to delete.

4. The system asks you to confirm that you want to delete the file. Reply Y
to delete the flle or N to keep it

If you want to delete more than one flle, you can use wild cargs. See Section
25 for more information on using wildcards.

29 How Do I Create and Use a Volumne?
A volume can be created on elther a diskette or a ProFile disk. Each disk
can contain one volume. Creating a volume on a disk gives the disk a name
and sets up a directory for flles.

1. If you are not in the File Manager subsystem, enter it by typing F In
response to the workshop command prompt.

2. Press I to invoke the Initialize command. This command asks for:

a The device name (upper or lower for a diskette, slot2chan? or paraport
for a ProFile, and so forth)

b. The number of pages to initialize; the default is to initialize the whole
device.

¢. The volume name.

d. The maximum number of files on the device; the default is a good
value unless you are using a large number of very small flles or a few
very large flles.

The volume is Initialized, with an empty directory. (If the device is a
diskette, it is first formatted) The system wams you if you are initializing a
device that has an existing volume on it, and gives you a chance to change
your mind before destroylng the existing volume.

After initialization, the device Is automatically mounted so it can be used.

2.10 How Do I Change the Name of a File or Volumne?
The Rename command allows you to change the name of any flle or volume.

1. If you are not In the Flle Manager subsystem, enter it by typing F in
response to the workshop command prompt.

2. Execute the Rename command by pressing R.

3. Enter the pathname of the flle or volume you want to rename.

4, Enter the new name. (The same device name Is assumed for a flle))
The name of the flle or volume iIs changed.

You can use the Rename command to change the name of a group of flles by
using wild carg expressions.
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The System Manager

31 The System Manager
The Systemn Manager allows vou to set system defaults and specify the
system configuration. Using it, vou can:

= Set the Lisa system characteristics such as screen contrast, speaker
volume, and time lags for repeating keys.

» Inquire or set the hardweare clock's time and date.

= Set the configuration of external devices such as disks and printers.
» Set the default startup device.

» Set which device is to be the consale.

» Redirect output from the console to a file or external device.

» Monitor all currently existing processes, and remove processes.

3.2 The System Manager Commarnd Line
By pressing S in the main cormand line, you can enter the System Manager
subsystem.

The System Manager command line is:
SYSTEM-MGR: ManageProcess, OutputRedirect, Preferences, Time, Quit, ?

The Systemn Manager command line works the same as the main Woarkshop
command line. Pressing ? shows you the additional line of commands:

Console, FilesPrivate, Validate, DefaultPrinter
Each System Manager command is described below.

ManageProcess (M)

This command puts you into a process management subsystem, which allows
you to display the status of all currently existing processes, and to remove
processes. The process management subsystem is described in Section 3.4.

OutputRedirect (0)

This command allows you to send a copy of all output that is displayed on
the console to another device, such as the -primter, or to a file on a disk.
The command asks you for the pathname to send the copy to. In order to
return to displaying only on the console, use the command again and redirect
the output to the -console device (which is the default).
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NOTE

Console output frequently contains control characters and escape
sequences for such things as positioning the cursor and clearing the
screen; these special characters will be part of the redirected output as
well. If the output has been redirected to a printer, the control
characters may cause "special effects" such as overprinting. If the
output has been redirected to a text file, the characters will be
embedded within the text file (the Editor will show such characters as
irverted question marks).

Preferences (P)

This command starts the Preferences tool which allows you to set up the
configuration of the Lisa system and the Workshop. The Preferences tool is
described in Section 3.3.

Time (T)

This command allows you to set the hardware clock/calender's date and time.
See the /rea Qwners Guide for more infarmation on the system clock and
calendar. The date and time values are used for the creation and
madification dates on your files, so they should be kepl correct.

Quit (Q) , _
This command exits from the System Manager and returns to the main
Workshop command line.

Console (C)

This command allows you to change where the Workshop console is displayed.
It may be displayed on the main screen, which is the default, on the
alternate screen, where the Debugger displays, or on an external terminal
connected to the RS232A or RS232B connector. When the main or alternate
screen is used for the console, output can be stopped and restarted by
pressing #-S. If an external terminsl is used with XOn/XOff processing
enabled, then #-S stops output and #-Q restarts it.

The console can be moved to the alternate screen when you run a graphics
program, to prevent output from writelns from appearing on the graphics
screen (the main screen). To display the screen not currently displayed, hold
down the right-hand OPTION key, and press ENTER on the numeric keypad.
Wwhen the console is moved to the alternate screen, both the console output
(writelns) and the Debugger output will be mixed together on the same
screen.

FilesPrivate (F)

This command enables or disables the wild-card selection of private system
files. The Lisa Office System uses file names beginning with the { character
for its tools and documents, and the Workshop user should rerely be
concerned with such files. These files are called "privaete". When selection
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of private files is disabled (the default), the Workshop File Manager's wild
card mechanism will exclude them from its selections unless the file
specifier explicitly includes the leading {.

There are just a few private files which are used by the Workshop (for
example, {T11}JBUTTONS). You must enable the selection of private files if
vyou want a single file specifier to refer to the entire set of Workshop system
files.

validate (V)

This cormnrmand is used to set up how much verifying you want the Workshop
to do for you. There are two values you can set with this command. The
first is whether or not to verify file copies. The systemn verifies a copy by
comparing the original file with the copy to be sure they are the same. The
default is to never verify. You should have no reason to verify unless you
suspect something is wrong with your disk. The second value you can set is
whether or not your selections for File Manager commands are verified.
Selections are verified by listing the file names and asking you to confirm
the operation before it is performed.

DefaultPrinter (D)

This command is used when you have more than one printer connected to
your Lisa. It tells the system which one will be the —printer logical device.
It first gives you a list of all the physical devices that have been configured
by the Preferences tool as printers, then asks you for the device name of the
printer you wish to refer to as —printer.

33 The Preferences Tool
The Preferences tool lets you specify what disks, printers, and other devices
are connected to your Lisa, which should be the defaults, and how you want
the special convenience settings adjusted. When you start Preferences (by
pressing P in respense to the Systerm Manager command line), it displays a
window with five checkboxes:

Set Corweniences is used to customize the Lisa's screen brightness, key
gdelays, etc. See Section 3.3.1, Set Conveniences.

Select Defaults is used to specify your default printer and startup disk, and
the length of the automatic memory test. See Section 3.2.2, Select
Defaults.

Connect Device Software is used to connect your Lisa to peripheral
devices. See Section 3.3.3, Peripheral Device Connectians.

Install Device Software is used to install a device software driver. This is
used in cases where your Lisa does not already have the software it needs
for a particuler peripheral device you wish to use. See Section 3.3.3,
Peripheral Device Connections.
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Remove Device Software is used to ersse a software driver from your stertup
disk when you no longer want to use the peripheral device. See Section
3.3.3, Peripheral Device Connections.

After you have finished with Preferences, you can get back to the System
Manager by choosing Quit from the File menu.

331 Set Conveniences
when you first check the Set Conveniences box of Preferences, each
convenience setting slreacty has one option marked. These prechosen options
are known as default settings. Whenever you click the first item in the list,
Set All Convenience Settings to Lisa Defaults, the default settings are
chosen.

33.11 Screen Brightness and Contrast
Always adjust the screen brightness before setting the contrast. The
brightness is adjusted through the brightnesz control knob while contrast is
set through Preferences.

To setl the screen brighiness and contrsst:

L Find the brightness control knob {the higher of the two white knobs
extending from the back of the cabinet).

2. Turn the brightness control down until your screen is entirely black.
3. Turn the knob back up just until the black rectangle turns to gray.

4_ Slowly turn the knob back down, just until the rectangle is distinctly
black, with no video scan lines visible, and there is a clean line on all
borders.

5. Set the Normal Level (Contrast) by clicking different boxes under
Norrnal Level until the screen is at a comfortable contrast level for
you.

33.12 Screen Dim

In order to protect the screen from prolonged high-intensity illumination, the
screen dims when not in use. If a period of time passes without the mouse
being moved or any keys struck on the keyboard, the screen automatically
dims to a lower level of illumination. As soon as the mouse is moved or a
key struck it returns to the normal hrightness. You can set the amount of
time that passes before dimming with Minutes Until Screen Dims, and you
can adjust the level it dims down to with Dim Level.

3313 Speaker Volume
From time to time, the Lisa communicates by sounding various beeps and
tones. The meanings of these signals are explained in the Lisa Owner's

Guide. The Speaker Yolume setting controls the loudness of these beeps and
tones.
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Each time you click one of the boxes under Spesker Yolume, the Lisa sounds
twao tones, at the law and high extremes of the level you have chosen.
Experiment with different settings until you find one you like. -

33.14 Repedting Keys
Most of the Lisa keys repeat automatically when held down. The line of

stars that appesr when you click one of the Delay boxes demonstrates how
long you have to hold a key down before it starts repeating. The line of
stars that sppear when you click one of the Rate boxes demonstrates how
fast the characters will be repeated.

The correct settings depend on your typing speed and the way you use the
Lisa If you find that the Lisa often generates multiple letters when you
intended to type only one, change the repeat delay to a setting nearer the
long end of the scale. If you use the repeating keys often, you probably
want to specify a short delay and a fast repeat speed.

3315 Mouse Double—Click Delay
Some of the desktop functions are accomplished by double-clicking the
mouse button (rapidly clicking the button twice). The Mouse Double Click
Delay setting determines the time lag between release! of the rirst click and
the start of the second click that the Lisa interprets as one double- click.

Like the keyboeard repeat delays, this setting should reflect your habits and
work style. If the Lisa often treats your double clicks as two single clicks,
try adjusting the delay to a longer setting. If the Lisa often interprets two
single clicks as one double-click, try adjusting the delay to a shorter setting.

332 Select Defaults
Wwhen you check Select Defaults, Preferences lists all the printers and disks
currently connected to the Lisa, and the length of the memory test it
performs at startup time, indicating the current defaults.

To select your defaulils:

1. Default Printer- If you have connected any printers to your Lisa with
Connect Device Software (see Section 3.3.3, Peripheral Device
Connections), the printer(s) you specified will be listed under Use This
Printer as Default. Check the printer you normally wish to use. 1If
you have connected more than one printer, the default printer will be
the one identified as the logical device -primter, and used by the
Editor. If you wish to use some other printer for a particular
document, you can specify the physical device name of the printer
(such as -RS232A-p or -#10#1-p). (You can also change your default
printer with Preferences at any time) Note that if you have the
Office System on the same disk ss the Workshop, the printer you
specify will be the default printer in the Office System, too.
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2. Default Startup Disk: When the Lisa is turned on, it looks to the
startup disk for its initial instructions. Under Start Up From, check
the disk you wish to use ss a startup disk. For the Workshop this will
be a hard disk. The startup disk should be the disk containing all of
your Workshop software.

Note: If you wish a new disk to be the startup disk, you will need to
install the Workshop on the new disk. Once you have finished setting
your defaults and device connections, you will also have to turn off
the Lisa before the new disk becomes the startup disk.

3. Default Memory Test: Under Test Memory, check either Briefly or
Thoroughly. The memory test setting determines how thoroughly the
Lisa's memory is tested during the automatic startup test. If you
check Briefly, the test takes about 20 seconds. If you check
Thoroughly, the test takes about 40 seconds.

333 Periphaeral Device Connections
A peripheral device can be an external hard disk, a printer, a graphics
plotter, or any other mechanism connected to your Lisa. In order to use a
peripheral device, your wWorkshop software must Know where the device is
connected, how to communicate with it, and how to operate it. In software
terminology, the set of codes and instructions that tell your computer how to
operate a device is called a ariver. Your Workshop already includes software
drivers for some of the most common devices, and if you wish to connect
some other mechanism, you can install the proper software driver from the
micro diskette supplied with that particular device.

To establish the necessary software connection between your Lisa and &
peripheral device, the proper software driver must be linked to the hardware
connection that the device is attached to. This is accomplished through use
of the Preferences tool.

To connect device soflware:

1. Enter Preferences and click the Connect Device Software box. You
will see a screen thet lists sll the possible connectors (or ports) at the
back of your Lisa, and what, if anything, is attached to them.

If you are using a Lisa 2/5, your screen will display an additional box
labelled Parallel.

2. To link & peripheral device to your Workshop, click the box of the
connector to which the device is physically attached. The screen will
then display a listing of what devices your Lisa currently has software
to link to from that connector.

3. If the peripheral device you wish to use is now listed, simply click the
box next to its name. The device name will then eppeer opposite the
appropriate connector and you are finished with the linking process.
The device can be used immediately.
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If the device you wish to use is not listed after you click the
connector box in step 2, it means thet the connector you have clicked
cannot be used with that peripheral or your Lisa lacks the software
driver needed to link up with the device. If lack of software is the
problem, first install the necessary driver as described below under
Install/Remove Device Softweare, and then repeat these steps 1
through 3.

Expansion Cards

When you attach an expansion card to one of your three expansion slots (see
your Lisa Owners Guide, Attaching an Expansion Card), the card itself will
contain one or more connectars which you can use to attach peripheral
devices. Because more than one connector may be part of an expanion card,
an additional level of Preferences becomes necessary to link a device to the
Workshop through an expansion card.

To connect an expansion carg-
1. Enter Preferences and click Conhect Device Software.

2 Wwhen you click one of the Expansion Slot boxes, the screen will
display a listing of the cards that your Lisa can currently link to. (If
the card you wish to use is not listed, it means that your Lisa lacks
the driver needed to link up with that card, and you will need to first
install the necessary software as described below under Install/Remove
Device Software and then return to step 1)

3. Click the box of the card you wish to use, and a list of the
connectors on that cerd will be displayed (Connector 1, Connector 2,
etc.). Connectors on cards are numbered from the bottom up, thus,
the bottom connector is always number 1.

4. Click the box of the connector that you are going to use, and a list of
the devices that the Lisa can link to for that type of connector will
be displayed. (If the device you wish to use is not listed, it means
that your Lisa lacks the software needed to link up with that device,
and you will need to first install the necessary driver as described
be):low under Install/Remove Device Software and then return to step
1.

Note: In some cases there are different types of connectors on s
single expansion card, or a certain connector can only accept a
specific device. If a particular connector cannot accept & certain
device, the device will not be listed when you click that connector's
box even if you heve installed the appropriaste software driver on your
Lisa

5. Click the box of the device you wish to use, and it will be named
opposite the connector number. This indicates that you are finished
with the linking process. The device can be uzed immediately.
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Disconnecting or Changing Device Software

If you wish to attach a different device to a connector, simply repeat the
procedure described above end click the name of the new device. If you
wish to disconnect a device simply click Nothing in the list of devices.

NOTE

Deferred Detachment: If you click Nothing or some new device driver
for & connector that is linked to a disk storage device (such as a
ProFile), or a connector linked to a peripheral that is currently in
operation (a printer that is in the midst of printing a document, for
example), you will get a message telling you that the device cannot be
disconnected and asking if you wish to Defer Detachment. If you
answer Yes, the new driver (or Nothing) will not go into effect until the
Workshop is restarted (either by turning the Lisa off and then back on
or by going to the Environments window and clicking Restart) and you
will be unable to use that connector for anything else until then.

Install/Remove Device Software

If Preferences does not list the device you wish to use, you have to install
the device software driver. This is done with the Install Device Software
choice in Preferences and the micro diskette you received with the device.

To install device software:
1 Click the Preferences choice Install Device Software.

2. Insert the micro diskette in the disk drive. A list of the drivers
contained on the disk will be displayed.

3. Click the box beside the name(s) of the device(s) vou wish to install.
The software driver will be copied from the micro diskette and
installed on your Lisa.

Note: If you install from a micro diskette a driver that is already on
your Lisa (that is, a driver that already shows up under Connect
Device Software), the version on the micro diskette will replace the
version that had been on the Lisa.

4. When you have installed the device driver(s) you wish, click Connect
Device Software to leave the Install Device Software menu. Wwhen you
are finished with Preferences, the micro diskette can be ejected in the
normal manner ($-E).

To remove device sorftiweare:

1. Click Remove Device Software. A list of sall the software drivers
currently installed on your Lisa will be displayed.

2. Click the device drivers that you want to erase.
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3331

Note: You cannot erase a driver for a device that is in use. You
must cease using the device, and in some cases disconnect it, before
you can erase its driver.

Linking to Expansion Cards

As with any other device, your software must be told about an expansion
card connected to one of your Lisa's expansion slots. For a discussion of

using Preferences to link peripheral devices to your Workshop,. see Section
3.3.3, Peripheral Device Connections.

To hook up an expansion card:

L

8.

3332

With the power to your Lisa turned off, ingsert the expansion card in
the appropriate slot at the rear of your Lisa as explsined in Appendix
1 of your Lisg Owners Guide and the documentation included with
the card.

when the card has been properly attached, turn on your Lisa.
Enter Preferences.
Click the Connect Device Softweare box.

Click the box for the appropriate expansion slot number (Expansion
Slot 1, for example).

If the type of expansion card you are installing is listed, clivck the
appropriaste box and go to step 8.

If the expansion card you wish to install is not listed, take the micro
diskette that came with the expansion card and insert it in the micro
drive. Click in the Preferences box to reactivate the Preferences
window. Now click Install Device Software. The software driver(s) on
the disk will be displayed.

Click the box beside the narne of the expansion card you wish to
install.

If you are installing other expansion cards, repeat steps 1 through 6 or
7. If you are ready to connect a peripheral device to the expansion
card, follow the appropriate instructions in the sections below.

Linking to Printers

For a discussion of using Preferences to link peripheral devices to your
Workshop. see Section 3.3.3, Peripheral Device Connections.
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To connect a printer:

1.

Connect the printer to the appropriate connector at the back of your
Lisa, as explained in the documentation that comes with the printer
and Lisa Owners's Guide. If you intend to attach the printer to an
expansion card, you will first hewe to attach the card and link it to
the Workshop ss explained in the instructions that came with the card
and section 3.3.3.1 above.

Enter Preferences.
Click the Connect Device Software box.
Click the box for the connector you arc using for your printer.

a If you are connecting the printer to one of the built-in serial ports,
click either Serial A or Serial B. (Serial A is the port next to the
mouse port.)

b. If you wish to connect your printer to an expansion card, click the
appropriate box. (If the expansion card is not named in the options
list, you will have to install the card's softwere driver.)

Wwhen you select an expansion card, the Lisa asks which of the two
or three connectors on the card you wish to use. Connectors on
cards are numbered from the bottom up, thus, the bottom connector
is always number 1.

Once you have selected the connector you wish to use, the Lisa
displays & list of devices that can be attached to that connector.
Click the appropriate printer (Apple Imagewriter or Apple Daisywheel,
for example).

If the printer you wish to install is not listed, take the micro diskette
that came with the printer and insert it in the micro drive. Now click
the Install Device Scoftware box. A series of printer choices appears;
click the neme of the printer you wish to use. The printer software
driver on the diskette will he automatically installed, and the name of
the printer listed under Connect Device Software for vou to select.

Note: Expansion ceards usually have two or three connectors. In some
cases these connectors are different, and each one can only accept
specific devices. If, after installing the software driver as explained
above, you do not see the peripheral you want listed in the menu, try
one of the other connectors on the expansion ceard.

If you are installing additional devices or expansion cards, you can set
Preferences for them before proceeding to the next step.

Load the paper intc the printer as explained in the documentation that
came with the printer.

3-10
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Turn on the printer and run the printer's self-test to make sure the
printer, independent of the Lisa, will run correctly. See the manual
that came with the printer for instructions on running the self-test.

Linking to External Hard Disks

In addition to the 5-megabyte ProFile or 10-megabyte internal hard disk you
are already using, you can attach other hard disks to your Lisa for additional
storage.

For a general discussion of using Preferences to link peripheral devices to
your Workshop,. see Section 3.3.3, Peripheral Device Connections.

To connect an external hard oisk:
L After installing an expansion card st the back of your Lisa, connect

6.

the disk to the card's connector, as explained in the documentation
that comes with the disk and yvour Lise Owners’s Guide.

Enter Preferences.
Click the Connect Device Software box.

Click the box for the expansion card you are using. If the expansion
card is not listed, you will have to install the card software driver as
explained above.

When you select an expansion card, you will be asked to click which
of the two or three connectors on the card you wish to use.
Connectors on cards are humbered from the bottom up, thus the
bottom connector is always number 1.

Once you have celected the connector you wish to use, you will see a
list of devices that can be attached to that connector. Click the
appropriate herd disk.

If the hard disk you wish to install is not listed, take the micro
diskette that came with the disk and insert it in the micro drive.
Now click the Install Device Software box and then click the name of
the hard disk you wish to use when it is displayed. The disk software
driver on the diskette will be automatically installed, and the name of
the hard disk listed under Connect Device Software for you to select.

Note: If the hard disk comes with an expansion card, you may also
have to install the driver for the card. Check the instructions that
accompany the hard disk for the names of the drivers needed to
operate the hard disk.

If you are installing additional devices or expansion cards, you can set
Preferences for them before proceeding to the next step.

If you wish the new disk to be the startup disk, you will need to install the
Workshop on the new dizk.
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3334 Linking to Other Devices

Other devices may be connected to your Lisa, and selected with Preferences.
Far a general discussion of using Preferences to link peripheral devices to
vour Workshop, see Section 3.3.3, Peripheral Device Connections.

It is recommended that only devices approved for use with the Lisas, and
supplied with Lisa software drivers, be purchased for connection to the Lisa.
However, if you wish to use a peripheral that does not have a Lisa softwere
driver, but is connected to the Lisa by means of a parallel or serial cable,
you may be able to operate it by selecting the software driver for Parallel
Cable or Serial Cable.

For example, by connecting a device's serial cable to Connector B, clicking
Serial B under Connect Device Software, and then Serial Cable, you may be
able to use the device. Depending on the particular peripheral device, this

may or may not be adequate.

In technicsal terms, to use the Serial Cable driver the device must use an
RS232C serial cable, no more than 9600 baud, and either asynchronous &-bit
or 7-bit with parity-checking communicstions. In case of doubt, consult your
dealer.

In technical terms the Parallel Cable driver is for devices using the standard
Centronics™ Parallel Interface Protocol.

34 Process Management

The process management subsystem is used to monitor and kill suspended
and background processes. It is started by pressing M (for ManageProcess) in
response to the Systermn Manager command line. (See the Operating System
Reference Manual for information on processes.)

The process manager dieplaye the following command line:
ManageProcess: KillProcess, ProcessStatus, Quit

KillProcess (K)

The KillProcess command terminates a currently existing process, including a
background process.

ProcessStatus (P)

The ProcessStatus command gives you information about all currently
existing processes. It provides the following information:

Pathname  The name of the process's object file.
Process JD The unique identifier assigned to the process.
State The current state of the process: Active, Suspended, or

Waiting.
Quit (Q)
The Quit command exits from the process management subsystem back to
the System Manager command line.

3-12
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The Editor

4.1 Introduction to the Editor
The Editor lets you write and change source programs, exec files, letters,
and other documents in standard text files. Text files created by other

programs—the listing file produced by the Linker, for example—can be read
and modified by the Editor.

Like LisaWrite and MacWrite, the Editor uses windows, pulldown menus,
and the mouse to provide an easy-to-use text-editing environment. For
example, you can cufand pasfe—delete text and insert it elsewhere in the

document—faster than you could with paper, scissors, and tape. You can
also

* Open more than one document at a time for editing.
* Cut and paste text from one document to another.

* Find and replace text based on a search pattern.

» Save an open document in another file.

* Select a font from among five type sizes and two type
styles.

* Set a marker to let you move automatically to the place
you marked in the document.

* Request automatic page numbering.
* Print an entire document or a selected portion of it.

4.1.1 The Editor Screen
A typical Editor screen Is shown in Figure 4-1. The document at the top
of the screen is the act/ve docurnent (the one currently in use). In the
active document, the title bar is highlighted and the rest of the window
frame is gray. In an inactive document, the entire window frame is white.
Figure 4-1 shows three windows: the active document. an inactive
document. and the Clipboard. Pressing and releasing the mouse button
when the pointer is outside the windows causes the active document to
become inactive. When no document is active, only the Windows menu and
the File menu are visible in the menu bar.

Several documents can be open at one time. When you choose Open from
the File menu, the document you open becomes the active document and is
displayed on top of any other open documents. To make another document
active. click with the mouse anywhere in its window. If it is completely
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hidden, choose its name in the Windows menu to make it active and bring ‘ !
it to the top ot the pile.

Any text that you cut or copy is automatically placed on the Clipboard; you
can then paste it into the same document or another document. You can
also use the contents of the Clipboard in a search,

Menu bar T iyindows File Edit_Search Tupe Style _Print_Marters Elevator
[ - covs-cxanpleledit TEXT | '
L

-}
PROGRAH Edit:

Title bar
(highlighted I it e i it R |
for active USES {40} View Scroll
document) {U Ob)/QuickDraw QuickDraw, boxes arrows

iiu Obj/Memtypes Memtypes,

fU 0bj/05Int? 05Intf,
$U Ob)/Toollntf } ToolIntf;

Size
control
box

Title bar
(inactive
document)

sareens  exarvple/editR. TEXT

-- Retource input for small sample application \
Written by Hacintosh Technical Support

Windows

Clipboard
Macintosh Technical Support

4-1
The Editor Screen

4.1.2 Using the Mouse
The Workshop Editor is designed for use with a mouse. Moving the mouse
on a flat surface moves the pointer on the screen in the same direction.
You use the mouse to get and put away documents, open menus, choose
menu items, select text, cut and paste, change the view in a window—all
the basic Editor procedures. The pointer on the screen tells you the
current |location of the mouse.

The pointer associated with the mouse changes shape as you move it around
the screen, depending on what it is pointing to. It's a fext pointer (see
below) when it's pointing to the text in a document and an &7aw when
it's pointing to a place outside the text area such as the menu bar, a title
bar, or the view controls. When the Editor is busy for more than a few
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4.1.3

seconds with the operation you just requested, the pointer becomes an
hourg/ass Here are the three pointer shapes:

X
g

Viewing Text
When you open
window, a box

Text pointer—points to text in a document.

Arrow—points to menus, window frames, and other nontext
areas.

Hourglass—tells you to wait until the current operation is
done.

a text file in the Editor, the document is displayed in a
that shows you one portion of the document at a time just

as a movie projector shows you one frame of film at a time. You can
change the view in the window by scro//ing—advancing the view—or by
setting markers. Scrolling uses the view controls located in the right side

of the window

« Scroll
arrow

frame:

arrows move the view a line at a time. Choose the
that points to the part of the document (up or down)

you want to see. Click on the scroll arrow to see the next
line of the document. To scroll continuously a line at a
time, move the pointer to the scroll arrow; then press and
hold the mouse button. When the text you're looking for
appears on the screen, release the mouse button.

View boxes move the view a windowful at a time. They

work the same way the scroll arrows do.

The elevator moves the view directly to a different part of
the document. Move the pointer to the elevator; then press
the mouse button and drag the elevator to the desired
location.

The elevator’s location in the window frame is proportional
to the current view's location in the document. When the
elevator is at the top of the window frame, you are viewing
the beginning of the document., When the elevator is in the
center of the window frame, you are viewing the middle of
the document. To move quickly to the end of a document,
move the elevator to the bottom of the window frame,

Another way to change the view in the document window is by using
markers which allow you to give a name to a location in @ document, See
Section 4.2.6, The Markers Menu, for more information.
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When you open a file, the Editor creates the window and displays the
beginning of the document. Depending on the layout of the document and
the number of windows you plan to have open at one time, you may want
to move the window or change its shape.

7o change the size and shape of the window, move the pointer to the s/ize
contro/ box \ocated at the bottom right corner of the window frame,
press the mouse button and drag until the "ghost" window frame is the size
you want; then release the button. To make the window shorter or taller,
drag up or down. To make the window narrower or wider, drag left or
right. To make the window smaller or larger, keeping its proportions the
same, drag diagonally toward its upper-left or lower-right corner,

To move the window to another location on the screen, move the pointer
to anywhere in the tit/e bar (at the top of the window frame): press the
mouse button and drag to the new location; then release. The window is
displayed at the new location.

4.1.4 Entering Text
You type information into an Editor document just the way you would type
on a typewriter, using the Shift, Backspace, Tab, and Return keys. The
information is entered beginning at the /nsert/on po/nt a blinking vertical
line. You can enter text anywhere in the document by moving the pointer

to the place you want to begin typing and ¢//ck/ng—pressing and releasing
the mouse button. This sets the insertion point and is called a s/ng/e-c/ick

The active document always contains either an insertion point or selected
text. When one or more characters are selected, you see them highlighted;
when zero characters are selected, you see an insertion point. /7 there /s
an insertion point, what you type Is adoed: If text has been selected what
You lype replaces the selected text. When you open a file for editing, the
Editor puts the insertion point at the beginning of the document.

Whenever the current insertion point is not visible on the screen, you can
display it by choosing Show Current Insertion Point from the Search menu,

You can also use the arrow keys on the numeric keypad to move the
insertion point: see The Arrow Keys, below, for details.

4.1.4.1 The Arrow Keys
You can move the insertion point by using the mouse or by pressing the
arrow keys. The four arrow keys border the upper-right corner of the
numeric keypad, to the right of the main keyboard. These keys are useful
for stepping through a table,

Each time you press an arrow key, the insertion point is moved in the
direction of the arrow: one character left or right, one line up or down, as
shown in Table 4-1. If the insertion point is at the beginning of a line, the

4-4



MAT-E5
wprks/;bp Lser's Guide " The Editor

left arrow moves it to the end of the previous line. Similarly, the right
arrow moves the insertion point from the end of a line to the beginning of
the next line,

You can also use the Apple key in combination with the arrow keys to
move the insertion point. For example, to move the insertion point to the
beginning of the line, hold down the Apple key and press the left arrow key.

Table 4-1

How the Arrow Keys Work
Key Moves the Insertion Point...
Left Arrow One space left
Right Arrow One space right
Up Arrow One line up
Down Arrow One line down
Key Combination Moves the Insertion Point...
Apple-Left Arrow To beginning of line
Apple-Right Arrow To end of line
Apple-Up Arrow To beginning of document
Apple-Down Arrow To end of document

4.1.4.2 Auto-iIndent and the Enter Key
The Editor has built-in automatic /maentat/on to make it easier for you to
write structured programs. The auto-indent feature remembers how many
leading spaces you put on a line and begins subsequent lines with the same
number of leading spaces; the Return key activates the auto-indent feature.
For example

If you start the following line with five spaces
and then press Return
the next line is indented five spaces
and so on.
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4.1.5

To return to the original left margin, use one of the two Enter keys
instead of the Return key. The Enter key on the main keyboard is to the
right of the space bar. The Enter key on the nurneric keypad is below the
down arrow key. These keys work identically in the Editor. They function
like the Return key except for auto-indent. The Return key indents the
next line; the Enter keys don't.

Selecting and Changing Text

Text you want to change must first be selected. Once you have selected
text, you can

* Type something to replace it.
* Paste something over it.
= Cut or backspace to delete it.

7o select a word move the pointer to any point within the word and
aouble-click (press and release the mouse button rapidly twice in
succession). To expand the selection a word at a time, continue holding
down the mouse button after the double-click while you move the pointer
to the right. Moving the pointer left contracts the selection,

To select @ /ine. move the pointer to the line and #jp/e-c/ick Selected
text is Aighlighted (white characters on a black background). To expand
the selection a line at a time, continue holding down the mouse button
after the tripie-click while you move the pointer downward, ™Moving the
pointer up contracts the selection,

To sefect ane or more characters, move the pointer to the beginning of the
text you want to select; click and hold the mouse button down; then drag
the pointer to the end of the text and release the button. You can drag
right, left, up, or down, including as many lines as you like. If you move
the pointer past the top or bottom of the window, the window will scroll
s0 that the [ast text selected remains in view,

An alternate way to select text is to place the insertion point at the
beginning of the text you want to select (move the pointer and click).
Move the pointer to the end of the text, then hold down the Shift key and
click (Shift-cl/ickl All the text between the insertion point and the
pointer is highlighted. You can select more than a windowful of text
using this technique by scrolling after setting the insertion point,

4.1.6 Using Menus

The menu bar at the top of the Editor screen gives you access to many
Editor functions including getting and saving documents, cutting and pasting
text, searching, and printing.
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7o see the contents af @ ment, move the pointer to the menu name and
then press and hold the mouse button; release the button when you're
finished looking.

7o choase a menu rtern, hold the mouse button down while you move the
pointer untijl the item you want is highlighted; then release the button.
The item is selected,

When menu items are mutually exclusive, the current setting has a check
mark in front of it. In the Type Style menu, for instance, the current font
style and size are checked. In the Windows menu, the active document is
checked.

When menu items are toggle items, the current setting is displayed. A
toggle flips back and forth from one setting to another. Every time you
choose a toggle menu item, its setting changes to the opposite. Choose
the menu item to toggle the setting. In the Search menu, for example,
choose Search is Literal to toggle it to Search is Tokenized, and vice versa.

Menu items that appear in gray type and remain unhighlighted when you
move the pointer to them can't be chosen right now. For example, you
can't choose Copy from the Edit menu unless you've selected some text.

4.1.7 Starting and Quitting the Editor
Start the Editor by typing £ from the Workshop command line. The
Editor prompts you for a filename. To edit an existing document, enter
the filename of a text file. A .text filename extension is assumed; if the
file doesn't have a .text extension, end the filename with a period.

7o start a new document. choose Tear Off Stationery from the File menu
and then press Return. Stat/onery is the blank paper the Editor gives you
to create a new document. You can also create your own custom
stationery; for more information, see Section 4.2.2.1. The Editor names
the new document Untitled-01; when you open a second new document, it
is named Untitled-02; and so on. You give the new document a permanent
name when you save it.

Ta leave the Eoitor and return to the Workshap command /ine, choose Exit
from the File menu or press the Apple-Q key combination. You can quit
with open documents; when you use the Editor again the documents will
still be open. If you have changed the documents, however, be sure to save
them before you leave the Warkshop—otherwise the changes will be lost.
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Many of the actions you can perform in the Editor are listed in menus. To
choose a menu item, move the pointer to the menu name, press to open
the menu, drag down the list until the item you want is highlighted, and
release. A menu item that appears in light gray cannot be chosen at this

time,

The menu titles are shown on the menu bar, which appears at the top of
the Editor screen. Table 4-2 is a list of the menus and their functions:

Table 4-2
The Editor Menus

Menu
Windows

File

Edit

Search

Type Style
Print

Markers

Description

Lets you make a document active; lists
all open documents,

Lets you open and put away files, eject
diskettes, and exit from the Editor.

Lets you cut, copy, and paste text, set
tabs, shift text left or right, undo the
last change, and select all of the text
in the document.

Lets you find and replace text, scroil
to a line, and scroll to the insertion
paint.

Lets you choose a font.

Lets you print all or part of a
document,

Lets you mark text with a name for
automatic scrolling and selection.
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Some menu items are shown with the Apple symbol followed by a letter.
Typing the Apple-letter key combination gives you the convenient option of
choosing the menu item from the keyboard without using the mouse. Table
4-3 shows you the key combinations you can type to choose menu items.

Table 4-3

Choosing Menu Items from the Keyboard

Type This
Apple-A
Apple-C
Apple-D
Apple-E
Apple-F
Apple-G
Apple-L
Apple-M
Apple-0O
Apple-Q
Apple-R
Apple-S
Apple-V
Apple-X

To Choose This Item

Select All of Document
Copy
Duplicate...
Eject Diskette
Find...

Go to Line #
Shift Left

Set Marker...
Open...

Exit Editor
Shift Right
Find Same
Paste

Cut

From This Meny

Edit
Edit
File
File
Search
Search
Edit
Markers
File
File
Edit
Search
Edit
Edit
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4.2.1 The Edit Menu

The Editor

The Edit menu operations are summarized in Table 4-4 and described in
detail in the sections that follow.

Table 4-4
The Edit Menu

Menu Item
Undo Last Change

Cut
Copy

Paste

Shift Left

Shift Right

Set Tabs...

Description

Puts the document back to the way it was
before the previous operation.

Places selected text on the Clipboard and
removes the text from the active document,

Copies selected text to the Clipboard but does
not remove it from the active document.

Copies text from the Clipboard to the
insertion point in the active document, or
replaces selected text.

Deletes the leftmost character in selected text
if the character is a space. The rest of the
line moves left,

Inserts a space character to the left of
selected text. The rest of the line moves
right,

Lets you set the interval between tab stops.

Select All of Document Selects all text in the document.

4.2.1.1 Undo Last Change

Many edit operations can be reversed by choosing Undo Last Change. With
this menu item you can remove text you just typed, paste back text you
just cut, and cut text you just pasted in.

Undo Last Change is designed to help you recover from mistakes—for
example, you press a key by accident and replace a large biock of text that
was selected. Choose Undo Last Change from the Edit menu before you do
anything else; the document reverts to its state before the key was

pressed.
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Not all operations can be reversed. For example, you cannot undo Find and
Paste All from the Search menu. When the last operation cannot be
undone, Undo Last Change appears in gray type in the Edit menu.

4.2.1.2 Cut, Copy, and Paste

The basic editing operations—Cut, Copy, and Paste—make use of the
Clipboard window. The Clipboard holds one section of text at a time, as
little as a single character or as much as an entire document., Text is
automatically placed on the Clipboard when you either cut or copy text
from the active document; the previous contents of the Clipboard are
erased. Pasting copies the contents of the Clipboard to the place you
specify without changing the Clipboard, so you can paste the same
information to several places without recopying it.

Ta cut or copy text select the text to be cut or copied, then choose Cut
or Copy from the Edit Menu. Cut and Copy place the selected text on the
Clipboard. Cut also deletes the selected text from the active document.

To paste the contents of the Clipboard into the active docurnent move the
insertion point to the place of insertion, then choose Paste from the Edit
menu. To replace text in the active document with the contents of the
Clipboard, select the text you want to replace; then choose Paste.

To move text in a docunent select the text to be moved, choose Cut
from the Edit menu, move the insertion point, and choose Paste from the
Edit menu. The text is removed from its original position, placed on the
Clipboard, and copied into the new position.

To copy text fram ane docurnent to another, select the text to be copied
and choose Cut from the Edit menu. This places the selected text on the
Clipboard. Then move the pointer to the place in the other document
where you want to paste and click to set the insertion point, This
document is now the active document. Choose Paste from the Edit menu
to paste the contents of the Clipboard into the active document,

4.2.1.3 Shift Left and Shift Right

Shift Left and Shift Right let you move text left or right by deleting or
inserting spaces. These options are useful for changing the indentation
pattern of a structured program. Each time you choose the menu item,
the selected text moves one space. If text follows the selected text on the
same line, it also moves. If more than one line is selected, the Editor
shifts one line at a time until all the selected lines have been shifted.
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To shift text fef{ select text that contains at least one leading space and
choose Shift Left from the Edit menu. The text is shifted left one space,
If the selected text does not contain a leading space, the line remains
unchanged.

7o shift text right select text and choose Shift Right from the Edit menu.
A space is inserted to the left of the selected text, shifting it to the right.

4.2.1.4 Set Tabs

The Editor's standard paper, which you use by choosing Tear Off Stationery
from the File menu, is set with typewriterlike tab stops every five
characters. In other words, when you press the Tab key the insertion point
moves five spaces to the right. No special tab character is used—five
spaces are actually inserted into the document. Therefore, if you
backspace after tabbing, the insertion point moves left one character at a
time, not five.

To change the stendard tab interval choose Set Tabs from the Edit menu.
The Editor prompts you with

Set Tabs every ?

Type the number of spaces you want inserted in the document when the Tab
key is pressed, and press Return.

4,2.1.5 Select All of Document

You may need to select all the text in a document to copy it into another
document, shift it to change the margins. or for some other purpose. You
can follow the rules for selecting text given in Section 4.1.5, or you can
simply choose Select All of Document from the Edit menu,




me e BN B B S A B B S S &S & S B BN & .

Workshop User's Guide
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The File menu is summarized in Table 4-5 and described in detail in the

sections that fcllow,

Table 4-5
The File Menu

Menu ltem

Save & Put Away
Save a Copy in...
Save & Continue

Revert to Previous

Version

Throw Away Window

Eject Diskette
Open...

Duplicate...

Tear Off Stationery...

Exit Editor

Description

Puts a copy of the active document in the file it
came from and closes the window,

Puts a copy of the active document in the file
you specify; the window remains open.

Puts an updated copy of the active document in
the file it came from; the window remains open.

Returns the active document to the way it was
when you last saved it; discards subsequent
changes.

Discards the active window.
Ejects the micro diskette,

Opens a file and and displays its contents in a
window.

Makes a copy of a file on disk.

From a standard stationery file, opens a blank
document and makes it the active document,

Returns from the Editor to the Workshop
command line. Open documents remain open.

4.2.2.1 Opening a Document

Ta apen an existing aocument, choose Open from the File menu. The

Editor prompts you with

Open Document named ?

Type the name of a text file and press Return. The contents of the file are
displayed in an open window, which becomes the active window. The
window shows the beginning of the file; the insertion point is set to the

first character.

4-13
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The default filename extension is .text. |f your file doesn’'t end with
.text, put a period at the end of the filename so the Editor won't add the
default extension. You don't have to specify the volume if your file is on
the Prefix volume.

If the text file you specify is already open, the Editor prompts

“rilename” is already open. Hake another copy of it? [Y or N]

Type Y to open another document for the file. The new document
contains a copy of the last version you saved, not a copy of the open
document. When you have more than one document open for a file,
whichever document you save updates the disk. To save the new document
in its file, make the new document active and choose Save and Put Away;
then make the old document active and choose Throw Away Window. To
create a new file for the new document, choose Save a Copy in... and enter
a new filename; then choose Throw Away Window.

To start a new docurmeni choose Tear Off Stationery from the File menu.
The Editor prompts you with

Tear Off Stationery named ? [ bootvol][PAPER]

Press Return to use the Editor's standard stationery, the PAPER.TEXT file
on the boot volume. A blank document named Untitled-01 is placed in an
open window, which becomes the active window. You will be asked to give
the document a filename when you save it.

7o create your own stationery, choose Tear Off Stationery to create a
standard blank document. Insert any text you like, such as the heading for
a memo. Make changes to the tab interval and type styie as necessary;
then save the stationery file, giving it any name you choose. To use this
stationery, choose Tear Off Stationery from the Edit menu, enter the
filename of the stationery, and press Return,

To start a new document from an ex/sting fi/e choose Duplicate from the
File menu. The Editor treats the file like stationery and opens a document
named Untitled-01 that contains a copy of the file. You will be asked to
give the document a filename when you save it.

4.2.2.2 Saving a Document
Any documents you work on in the Editor are updated only in memory until
you ask the Editor to save them.
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To put away the active docurnent choose Save & Put Away from the File
menu. The latest version of the document is put away in the file it came
from and the window disappears. |f you're putting away a new document,
the Editor asks

Save as Document named ?

Enter the pathname of the file you want to save the document in and press
Return.

To copy the active document into another fife choose Save A Copy in...
from the File menu, enter the filename when the Editor prompts you, and
press Return. A copy of the document is saved and the window remains
open. The file the document came from is natupdated. [f the file you
specify already exists, the Editor asks

Replace existing “rilensmd"? [Y or N]
Type )Y to save the copy in filename, N to abort the request.

To back yp the active docurment choose Save & Continue from the File
menu. The latest version of the document is saved in the file it came
from and the window remains open. It's a good idea to save the document
every fifteen minutes so that you don't lose hours of work in case of a
power failure,

4.2.2.3 Revert to Previous Version
To thraw away recent changes to the act/ve docurnent choose Revert to
Previous Version from the File menu. The contents of the window are
replaced by the version of the file you last saved. The window remains
open. This is equivalent to throwing away the window and reopening the
file. This menu item is useful when you make an error in an operation like
Find & Paste All that you can't recover from with Undo Last Change.

4.2.2.4 Throw Away Window
To discard the active docunent, choose Throw Away Window from the File

menu. The window disappears. |t you have made changes to the document,
the Editor asks

CAUTION: Throw away changes to filensme ? [Y or N]
Type Y to discard the changes, &V to abort the request.

The file on disk is not changed by this command—it contains the last
version you saved. If the dooument is new and was never saved, ho copy
will exist on disk.
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4.2.2.5 Eject Diskette
To eject the micro diskette choose Eject Diskette from the File menu,
The diskette is ejected.

Open documents remain open—they are not automatically put away.
However., Save & Put Away and Save & Continue will warn you

STOP: [while opening] Pathname invalid or no such device

7a save the active document when its micro diskette has been ejected
reinsert the micro diskette before choosing Save & Put Away or Save &
Continue. Alternatively, choose Save a Copy in... and specify a filename on
another available disk.

4,2.2.6 Exit Editor
To quit the Editor; choose Exit Editor from the File menu. Open
documents remain open, This allows you, for instance, to read a volume

directory using the File Manager and return to the Editor without having
to save and reopen your Editor files.

When you quit the Editor, changed files are not saved automatically.
Changes you made are lost if you leave the Workshop without saving. The
Quit command in the Workshop command line warns you if you have
changed a file without saving it and asks

Do you want to leave the WorkShop and kill the editor? (Y or N)

Type Y to leave the Workshop and discard the changes. Type & to remain
in the Workshop—you can then go back to the Editor and save the file,

4-16



PRY-F5
Workshop User'’s Guide The Editor

4,2.3 The Print Menu
The Print menu is summarized in Table 4-6 and described in detail in the
sections that follow.

Table 4-6
The Print Menu
Menu Item Description
Print All of Document Prints the active document.
Print Selection Prints the highlighted portion of the active
document.
Full Footers Prints date, filename, and page number at the

bottom of each page.
Page Numbers Only Prints page number at the bottom of each page.

Dot Matrix Printer Lets you specify that a dot matrix printer is
attached to the Lisa.

Daisy Wheel Printer Lets you specify that a daisy wheel printer is
attached to the Lisa.

4.2.3.1 Choosing Page Footers
When a document is longer than one page, a footer is printed at the
bottom of each page.

To number pages, choose Page Numbers Only from the Print menu. The
page number is centered on the last line of each page as follows:

Page 1
To number pages and print the date and filename, choose Full Footers from
the Print menu. The date and filename are enclosed in brackets and

centered on the last line of each page; the page number is right justified on
the same line as follows:

[Date B/0ct/84; File -#13-david. text] Page 1
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4.2.3.2 \dentifying the Printer Type
The Editor uses the default printer; you can set the default in the System
Manager. You must use the Print menu to tell the Editor what type of
printer it is.

To specity the printer type choose either Dot Matrix Printer or Daisy
Wheel Printer from the Print menu,

4.2.3.3 Printing a Document
To print the active document choose Print All of Document from the
Print menu. The document is printed on the default printer with the page
footers you specified.

To print a part of the active docunent select the text you want to print
and choose Print Selection from the Print menu. The highlighted text Is
printed on the default printer with the page footers you specified.

4-18
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4.2.4 The Search Menu
The Search menu, which lets you find and replace text, is summarized in
Table 4-7 and described in detail in the sections that follow. All searches
begin at the insertion point. The text you're searching for is called the

targel
Table 4-7

The Search Menu
Meny Item Descripti
Find Searches for a target you specify.
Find Same Searches for a previously specified target,
Find Contents of Searches using the first line on the Clipboard as
Clipboard the target.
Find & Paste All Replaces all occurrences of the target, from the

insertion point to the end of the file, with the
contents of the Clipboard.

Search Is Tokenized/Search Is Literai
Tokenized search looks for the target separated by
delimiters. Literal search ignores word
boundaries.

Search is Case Sensitive/Search Is Not Case Sensitive
Case-sensitive search looks for an exact match, A
search that is not case sensitive ighores uppercase
and lowercase differences.

Search is Wraparound/Search is Not Wraparound
Search that is not wraparound goes from the
insertion point to the end of the document.
Wraparound search goes from the insertion point
to the end, then wraps around from the beginning
back to the insertion point.

Go To Line # Moves the insertion point to the requested line
and scrolls the line into the window.

Show Current Insertion Point
Scrolls the insertion point into the window.

4-19




Workshop User's Guide The Editor

4.2.4.1 Finding Text
To search for text in the active docurnent move the insertion point to the
place you want the search to begin and choose Find from the Search menu.
The Editor prompts you with

Target ?

Type the target text you want the search to match on and press Return,
The Editor finds and highlights the matching text. If end of search is
reached and no match is found, the Editor responds,

Target “terget text” not Found
Press the space bar to continue.

7o search for the same target again choose Find Same from the Search
menu. The Editor finds and highlights the next occurrence of the text.
Find Same works whether or not the text was found last time you
searched.

To search for text without Uyping /¢ find an occurrence of the text in this
document or another document, Choose Copy from the Edit menu to place
the text on the Clipboard. Move the insertion point to the place you want
the search to begin and choose Find Contents of Clipboard from the Edit
menu, The Editor uses the first line on the Clipboard as the target.

4.2.4.2 Replacing Text
To replace every occwrence of specified text move the insertion point to
where you want the replacement to start. Choose Find from the Search
menu and enter the target; the Editor highlights the first occurrence.
Change this occurrence, select the revised text, and choose Copy from the
Edit menu to place it on the Clipboard. Then choose Find & Paste All
from the Search menu to change the rest of the document. Every match
of the target is replaced with the contents of the Clipboard.

4.2.4.3 Customizing the Search
The three menu items described in this section are fagg/e items; that Is,
choosing a toggle item changes it to its opposite. Choosing it again
changes it back. Toggle these items to the settings you prefer before you
choose Find, Find Same, Find Contents of Clipboard, or Find & Paste All.
The item stays set until you toggle it again.

70 1ind a target that crosses word boundari/es toggle to Search Is Literal
in the Search menu.
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70 find a target that is bounded by delimiters toggle to Search Is
Tokenized in the Search menu. The delimiters include the space character
and punctuation marks such as period, semicolon, comma, exclamation
point, question mark, EOF (end of file), and EOL (end of line). In the
sentence

Among Stanford students a tan. said Stan. is standard.

a token search for "tan" will find only the second occurrence. A literal
search will find all four occurrences.

70 find a target regardiess of case toggle to Search is not Case Sensitive
in the Search menu.

7a find an exact match on case, toggle to Search is Case Sensitive in the
Search menu. In the sentence

Dozens of Zen meditators prefer FROZEN YODGURT.

a case sensitive search for "zen" will find only the first occurrence. A
search that is not case sensitive will find all three occurrences.

To search from insertion point to end of docuneni toggle to Search is Not
Wraparound in the Search menu. |f the target is not found, you can toggle
to Search is Wraparound and then choose Find Same.

To seareh from insertion point to insertion point toggle to Search is
Wraparound in the Search menu. If the Editor searches to the end of the
document before finding the target, it continues at the beginning of the
document and searches to the insertion point.

4.2.4.4 Scrolling the Window
7o scroll to the insertion point when it is not visib/e choose Show Current
Insertion Point from the Search menu. The insertion point appears in the
window.

To move the insertion point and scroll to a /ing choose Go To Line #
from the Search menu. The Editor asks

Go to which line ? [current line number)
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4.2.5

The prompt shows the line number where the insertion point is currently
set. Type another number and press Return. The Editor moves the
insertion point to the beginning of the requested line and. if the line is not
visible in the window, scrolls to the line. If the line is outside the bounds
of the file, the Editor reports

Line number out of range

Press the space bar to continue. Then try again with a lower number.

The Type Style Menu

The Type Style menu lets you select a font for printing and displaying text
on the screen. The font you select is used throughout the document. The
current font style and size for the active document are checked in the Type
Style menu. You have a choice of two styles:

This is Classic type.
This is Modern type.

There are five sizes for each style:
8 Point 20 Pitch
8 Point 15 Pitch
10 Point
12 Point

12 Point PS (@ proportionally spaced font)

Font size affects the number of characters that fit on a line. A higher
point size means the font is relatively taller; a higher pitch means the font
is relatively more condensed in width. The document will be printed in the
same type style as displayed on the screen if that type style is available on
your printer. You can fit the most characters on a line with 8-point,
20-pitch type.

The paragraph you are reading is a proportionally spaced Madern font.
Proportionally spaced fonts make readable text, but unreadable programs
and tables.

To select a type style choose either Modern or Classic from the Type
Style menu.

To select a type size choose one of the five sizes from the Type Style
menu.
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4.2.6 The Markers Menu

A marker is like a bookmark; it saves your place while you work eisewhere
in the document so you can easily scrall back. A place in the document can
be marked either by moving the insertion point there or by selecting text
at that place.

The Markers menu lets you associate a name with a specific place in a
document. The name is listed in the menu. The menu contains the Set
Marker command, the Delete Marker command (visible only when at least
one marker is set), and a list of up to 18 markers. When you delete a
marker, the name is removed from the list,

Every file has its own set of markers, so you can use the same marker
names in different documents, The Markers menu displays the marker
names for the active document. (Markers for a text file are saved in its
header block; see Section 4.3.2.1, Pages and Headers, for more
information.)

To set a marker, move the insertion point to the text you want to mark
and choose Set Marker from the Markers menu. The Editor asks

Set Harker Named 7?7

Type any name up to 20 characters long and press Return. The marker is

set. The next time you open the Markers menu you will see the marker
listed,

Ta scrall ta @ marker, choose the marker name from the Markers menu.
The marked text appears in the window. |f the text was marked with the
insertion point, the insertion point is moved to that place. If the text was
marked by selecting it, the text is now highlighted.

7a delete a marker, choose Delete Marker from the Markers menu, The
Editor asks

Delete Harker Named ?

Type the name of the marker you want to delete and press Return, The
marker is deleted. The next time you open the Markers menu the list will
not contain the marker.

To reuse an existing marker, move the insertion point to the text you want
to mark and choose Set Marker from the Markers menu. Respond to the
prompt with the name of an existing marker. The marker Is reset to point
to the new location,
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4.2.7 The Windows Menu
The Windows menu lists the names of all open documents, with a check
mark indicating which is the active document. When no documents are
open, only the Clipboard appears in the menu. You can make a different

document active either by clicking anywhere in its window or by using the
Windows menu,

Open documents are like a pile of papers on a desktop. As each document
is opened it is placed on top of any other open documents. When another
document in the pile is made active, its window is brought to the top
layer. Sometimes a document becomes completely hidden in the pile. You

can bring it to the top of the pile by selecting its name from the Windows
menu.

To make a oocument active and bring rt to the top choose the document
name from the Windows menu.

4.3 Technical Information
Here is some technical information about the Editor.

4.3.1 Initialization Errors
Error 309 indicates that you were unable to start the Editor due to lack of
disk space. To recover, follow this procedure: S
1. Delete some files to provide additional disk space.

2. Kill the Editor process by using the ManageProcess subsystem
of the System Manager.

3. Type £ to start a new Editor process,

if you attempt to start a new Editor process without killing the old one,
the Editor will fail with Error 304.

4.3.2 Text Files

The Editor and language processors in the Workshop expect a standard text
flle as input. Technical characteristics of text files are described below,

4.3.2.1 Pages and Headers

The internal structure of a text file on a block-structured device is as
follows:

* A page consists of two 512-byte blocks.

* Each page contains some number of complete lines of text and
is padded with null characters (ASCI! 0) after the last line as
necessary to complete the page.

* Two 512-byte header blocks are present at the beginning of the
file. The header blocks may be empty.
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The Editor uses the header blocks to record file-specific information such
as font, markers, and tab interval. “You can read the header blocks in
Pascal by using the blockread function with a blocknum of 0; databuf
must be a 1.024-byte buffer. /f you store information in the header blocks
and subsequently apen the file in the Editor, the header blocks will be
changed, 1T you do not follow the Editor’s header format, your file may
not be readable in the Editor. To create a text file that the Editor can
read, write binary zeroes in the header blocks.

4.3.2.2 Blanks Compression

Leading spaces on a line can be compressed into a two-byte code. The
first byte contains a DLE character. The second byte contains the ASCIi
value for SPACE in the high-order nibble and the number of spaces being
compressed in the low-order nibble. The DLE character is represented by
ASCII 16 decimal ($10 hexadecimal). The space character is represented
by ASCH 32 decimal ($20 hexadecimal),

4.3.2.3 Maximum Line Length

The Editor has a maximum line length of 255 characters. You'll get an
error message if you create a line of more than 255 characters. You'll get
a warning if you read in a file containing a line of more than 255
characters, (Even using the smallest type font., you can‘t display more than
about 150 characters in a line.)

4.3.2.4 File Size Limited by Available Memory

4.3.3

The Editor works on a file in memory. |f not enough memory is available
to read in a file, you'll get an error message. Close all open windows and
try again. If there's still not enough memory for the file, use the FileDiv
utility to split it into separate files of manageable size. It can be put
together again with the FileJoin utility. These utilities are described in
Chapter 11.

Response Time

If the Editor becomes sluggish when you have severai documents (or a few
large documents) open at the same time, put some of them away; then
continue.
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Chapter 4
The Editor

Statlonery (See Section 4.2.3)
If you want to use stationery on a volume other than your boot volume, type in

the volume name after you choose Tear Off Stationery.

Note that the flle name "PAPER.TEXT" is reserved for the default stationery
template and should not be used for other purposes.

Editing Multiple Files (See Section 4.2.4)
If the Editor becomes slugglsh when have many docurnents open at the
same time (or a few large documents), put some of them away, and then
continue,

Using the Arrow Keys to Move the Insertion Point (See Section 4.3.1)
You can now use the arrow keys on the numeric ke to move the insertion
point. The arrow keys are the +, +, /, and , keys with the black triangle in a
box on them, as shown below. Pressing an arrow key moves the insertion point
one position in the direction of the arrow--either one character to the right or
left, or one line up or down. If the insertion point is at the beginning of a
line, the left arrow will move it to the end of the previous line; the right arrow
will move it from the end of a line to the beginning of the next line.

You can also use the & key in combination with the arrow keys to move the
insertion point farther. Holding down the & key and pressing the left or right
arrow will move the insertion point to the beginning or end of the line,
respectively. Holding down the @ key and pressing the up or down arrow will
move the insertion point to the beginning or end of the document, scrolling the
window if necessary to display it.

+

]

SHIENI LN

The Arrow Keys
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Selecting the Last Line of a Document (See Section 4.3.3)
A triple-click will not select the last line of a document unless the line ends
with a carriage retum.

windows Menu
The windows menu lets you keep track of the windows you have open. It lists
the names of all open windows, with a check mark indlcating which is the
active window. To make a different window active and bring it to the top,
choose that window's name from the menu. An example of the windows menu

is shown.
Windows

Clipboard

- #12-MyProg. TEXT

—lower—memo.TEXT
vUntitled—03

Markers Menu
The Markers menu lets you assoclate a name with a specific place In a
document, and easlly find that place agaln later.

To set a marker:

1. Select the portion of text that you want marked. This can be an
Insertion point, or any selection of text.

2. Choose Set Marker Named ? from the Markers menu,

3. Type the name you want the marker to have. Marker names can consist
of any characters, including spaces, up to 20 characters,

8. Type [RETURN]

Nothing in your document will be changed, but the marker name will appear in
the Markers meru. when you choose the marker name from the menu, the
window will scroll so that the point or selection of text associated with that
marker is visible. You can set up to 18 markers in a document.

whenever you have at least one marker set, there is a Delete Marker Named ?
item In the Markers menu. This allows you to delete any of the markers you
have set, when you don't need them anymore.

To delete 8 marker:
1. Choose Delete Marker Named ? from the Markers memu.
2. Type the name of the marker you want deleted.
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3. Type [RETURN]
The marker name will be removed from the Markers menu.

The items in the Markers menu are assoclated with a particular document, so
the menu will change when you move between documents, but the markers you
set will stay associated with each docurnent until you delete them (even when

you leave the Editor or the Workshop) An example of the Markers menu is
shown,

Set Marker ... %
Delete Marker ...

main program
sort procedure
bug?

end

File Menu (See Section 4.5)
The following commands have been added to the File menu:
Throw Away Window
Discards the active window. If you have made any changes to the document,
the Editor asks if you really want to discard the window. If you have

previously saved the document, the copy on disk remains; only the contents of
the window are discarded.

Eject Diskette ,
Ejects the micro diskette. You can also eject by holding down the @ key and
typing E

Search Meru (See Section 4.7)
The following changes have been made to the Search menu, as shown on the
next page. Note that the options determining how the search is to be done
(whether case is important, etc.) are no longer marked with a check mark.
Instead, only the options currently in effect are showry to switch between the
two options in each set, choose the menu item.
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Find ... wF
Find Same %S

Find Contents of Clipboard

Find & Paste RIll

Search is Tokenized
Search is Not Case Sensitive
Search is Not Wraparound

Go To Line # %G
Show Current Insertion Point

Find Contents of Cl
Search for the contents of the Clipboard. If the Clipboard contains more than
one line, the Editor looks for only the first line.

Search is Tokenized/Search Is Literal
If Search is Tokenized appears in the menu, the Editor looks for the search
string as a separate word. If Search Is Literal appears, the Editor looks for any
occurrence of the search string, even if it appears in the miadle of another
word. To toggle between the two options, choose the menu item. (The Search
Is Tokenized/Search is Literal cholce replaces the Separate Identifiers and All
Occurrences menu items.,) The cefinition of a worg here is any comblnation of
alphanumeric characters, dollar signs, and undertars, bounded by spaces,
punctuation, or other symbols.

Search Is Case Sensitive/Search is Not Case Sensitive
If Search is Case Sensitive appears in the menu, the Editor looks for the search
string with the case of the letters exactly as you typed it. If Search is Not
Case Sensitive appears, the Editor looks for any occurrence of the search
string, regardless of case. To le between the two options, choose the menu
Item. (The Search Is Case Sensitive/Search is Not Case Sensitive choice
replaces the Cases Must Agree and Cases Need not Agree menu items.)
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Search 1s Wraparound/Search 1s Not
A search Is always done starting at the insertion point. If Search is

Wraparound appears in the menu, the Editor searches from the insertion point
to the end of the document, then starts at the beginning of the document, and
searches to the insertion point. If Search is Not Wraparound appears, the
Editor only searches from the insertion point to the end of the document. To
toggle between the two options, choose the menu item.

Go To Line #
The Go To Line # command lets you scroll the window to show text starting at
a particular line number in a document. The Editor asks you what line you
want to go to. If you specify a line number greater than the number of lines
in the document, you will get a message to that effect. The Go To Line #
command can also be executed by holding down the @ key and typing G

Show Current Insertion Point
Choosing Show Current Insertion Point scrolls the window to where the
insertion point is. If the insertion point is already in the window when you
choose Show Current Insertion Point, the command does nothing.

Type Style Menu (See Section 4.8)
The Type Style menu has been changed so that you can choose separately the
size of the type in which a document is displayed, and whether the type style
is modem or classic. The classic type fonts have serifs; the modem fonts do
not. The new Type Style menu Is shown below.

Type Style

v'Modern
Classic

8 Point 20 Pitch
8 Point 15 Pitch
v 10 Point

12 Point

12 Point PS
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Print Menu (See Section 4.9)
The Plain Keywords and Differentiated Keywords items are no longer on the
P1int menu. Keywords are always printed as plain text.

Editor Initialization Exrors
If the initialization of the Editor falls due to lack of disk space (Error 309), and
space on the aisk is then mace free, the next attempt to start the Editor will
also fall (Error 304). You must enter the ManageProcess subsystem of the
Systemn Manager, Kill the Editor process, and then try again.

Text Flles
The Editor, language processors, and other workshop utilities expect a standard
TEXT flle as Input. The internal structure of a text file in a block-structured
device Is described In the Pascal Reference Marnial:

* Each page (two 512-byte blocks) contalns some number of complete lines
of text and Is padded with null characters (ASCIH 0) after the last line as
necessary to complete the page.

* Two 512-byte header blocks are also present at the beginning of the file,
These may or may not contain information.

* A sequence of leading spaces (ASCIHl 32 decimal, $20 hexadecimal) can be
compressed into a 2-byte code namely, a DLE character (ASCII 16
decimal, $10 hexadecimal), followed by a byte contalning the value 32
declmal plus the number of spaces represented.

Maxdmum L of Lines
The Editor now has a maximum line length of 255 characters. You'll get an
error message if you create a line of more than 255 characters, or a waming If
read in a file containing a line of more than 255 characters. (This change
s unlikely to affect you, since even using the smallest type font, you can't
display more than about 150 characters in a line.)
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4.1 The Editor

The Editor is used to create and modify text files. These files can be used
for many purposes including input to the language processors and as exec files.

If the file you are editing is too big to fit on the screen, a portion of the file
is displayed. This "window” into the file can be moved to display any part of
the file you want. An example of the Editor display is shown in Figure 4-1.

File Edit Search Type Style Print ‘
@] il EpiT.Menus. ex |l

z

File

Save & Put Away

Seve & Copy in ...

Save & Continue

Revert to Previous Yersion

Open ...
Duplicate ...
Tear Off Stationery ...

Exit Editor
3

Edit
Undo Last Change

Cut/X
Copy/C
Paste/V

Shift Left/
Shift Right/R

Figure 4-1
The Editor Display

The basic editing operations are inserting characters, cutting a portion of the
text, and pasting text into a new location. Text that is cut goes into a special
window called the Clipboard. Text on the Clipboard can be pasted into any
place in the file or into another file.

All editing action takes place at the insertion point. The insertion point is
marked by a blinking vertical line where the next character will be placed.
Any characters typed or pasted from the Clipboard are inserted at this point.
This Is true even if the Insertion point is not currently displayed In the
window. The window is automatically scrolled to show the insertion point.
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NOTE

The Editor is memory based This means that there is a physical limit
on the size of the file that can be edited. If a file is 100 big to edit,
it should be split into more than one file of manageable size. The

FileDiv and FlleJoin utilities can be used for this. They are described

In Chapter 11.

The mouse is used to scroll the text in the window, move the insertion point,
select text to be cut or copied, point to menus, and select items on menus.

8.2 Using the Editor

Start the Editor by pressing E in response to the Workshop command prompt.
The Editor prompts you for a text file name. If you want to edit an existing
file, enter its name. If you want to create a new file, choose Tear Off
Stationery from the File menu. The Editor prompts you for the stationery
name. Press [RETURN] for the default, which is blank paper, or enter a name.
For more information on stationery, see Section 4.2.3.

The file that you are working on Is called the active document. You can have
several documents open and accessible at any one time, but only the active
documnent can be edited. The active window is indicated by a darkened title
bar and scroll bars, and is always on top of all the windows.

To leave the Editor, select Exit from the file menu, and you will return to the
workshop command line.

4.2.1 Editing Operations

The basic editing operations are cut, paste, and copy. To cut or copy text,
you must first select the text to be cut or copied. Select text by moving the
mouse while holding down the button. See Section 4.3 for complete
information on selecting text. Text that is selected and then cut is removed
from the active document and placed in a special window called the
Clipboard. Text that is copied is placed on the Clipboard and also left in
place in the active document.

The contents of the Clipboard can be pasted at any point in the active
docurnent by placing the insertion point where you want the text inserted and
choosing Paste from the Edit menu.

422 The Menus

Operations are provided in five menus: File, Edit, Search, Type Style, and
Print. The File menu is used to access documents and stationery, to put away
files, and to exit the Editor. The Edit menu contains the editing operations.
Search provides for finding strings in the active document. The Type Style
menu selects the font for document display. The Print menu controls printing.
Each of these menus is described in more detail in the sections that follow.
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You select an operation from a menu by moving the arrow pointer to the
menu name on the menu bar and holding down the button. The menu is
displayed. Choose the menu item by moving the mouse down until the item
you want appears in reverse video. Releasing the mouse button starts the
operatlon.

423 Creating and Using Stationery
Stationery for a special purpose, such as a letterhead, can be created with the
Editor. Stationery is just a regular text file containing the desired text. To
use any stationery other than the default blank paper, choose Tear Off
Stationery from the File menu, and type the name of the document containing
the stationery when it asks you for the stationery name.

To create stationery, make a document containing the text you want on the
stationery. Save this document on the disk. To use this stationery, choose
Tear Off Stationery from the Edit menu, and give it the flle name of the
stationery you created.

4.2.4 Editing Multiple Files
More than one document can be open at one time, but only one document is
the active document. To read in a document when you already have an active
document, choose Open from the File menu. It asks you for the document
name. The new document is read into a window on the screen and becomes
the active document. To make another document that is already open the
active document, use the mouse to move the pointer into a portion of that
document and click the mouse button. If you have several documents open,
you might have to move some out of the way.

This capability of warking with more than one document at a time can be
used to copy text from one document to another by using the following
sequerice of operations:

* Open the document containing the text you want to copy.

« Select the text you want to copy and choose Copy from the Edit menu.
This places a copy of the text onto the Clipboard. You can use Cut if you
want the text to be removed from its original file.

* Open the document you want the text to be copied to. It becomes the
active document.

* Place the insertion point at the place you want the text to be inserted, or
select the text you want to replace.

* Choose Paste, which copies the text from the Clipboard to the active
document.

Further information on each of these operations can be found in the sections
that follow.
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43 Selecting Text
The basic editing functions are cut, copy. and paste. Before you can cut or
copy text, you must select the text to be cut or copied. Before you paste, you
place the insertion point where you want the text to be placed. You select
text and place the insertion point by using the mouse to move the pointer on
the screen.

within an active document, the pointer will have one of three shapes:
Text pointer in a document
Arrow pointer for menus and scroll bars
Hourglass when an operation will take over 20 seconds

Use the mouse to move the pointer on the screen. The shape of the pointer
changes when you move in and out of the document window.

Within the window, the text pointer is used to move the insertion point and to
select text.

In selecting text, you can select characters, words, or lines. You can also
select any number of characters, words, or lines. Selected text is displayed in
reverse video.

43.1 Maoving the Insertion Point
The insertion point is indicated by a blinking vertical line where the next
character will be inserted. All insertion, whether from typing or pasting,
takes place at this point in the file, even if it is not visible in the window.

To move the insertion point, move the pointer to wnere you want it to be and
click. Note that the insertion point moves when you select text.

432 Selecting Characters
To select characters, move the text pointer to the beginning of the characters
you want to select, press and hold the mouse button while moving to the last
character you want to select.

An altermate way of selecting characters, which is especially useful when
selecting a large block of text, is as follows. Move the pointer to the
beginning of the text you want to select and click the mouse button. Then
move the pointer to the end of the text you want selected and shift click.
Shift click means to hold down the shift key on the keyboard and click the
mouse button. You can use the scrolling controls to display the end of the
text you want selected if it is toc big to fit in the window.

433 Selecting Words and Lines
To select a word, move the pointer into the word and click the mouse button
twice. To select a line, move the pointer into the line and click the mouse
button three times.
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To select multiple words or lines, click the mouse button the required number
of times. and hold. Move the pointer to the last word or line you want
selected and release. If you double-click, and hold down the mouse button
while you move the insertion point to the left or right, the selection expands
or contracts by words. If you triple-click, and move the insertion point up or
down, the selection expands or contracts by lines.

An altermmate method, especially useful when you want to select more text
than will fit in one display window, is as follows. Click the required number
of times to select the first word or line. Scroll the window if necessary to
display the last item you want selected. Move the pointer to the last item
you want selected, shift click, and the entire block of text becomes selected.

434 Adjusting the Amount of Text Selected
To change the amount of text selected, move the pointer to the position that
you want the selection to extend to and shift click. This can be used to
either expand or contract the selection.

4.4 Scrolling and Moving the Display
wWhen a document is longer than will fit into the display window, only part of
the document is displayed at one time. You can change what part is
displayed by “scrolling” through the display. The vertical bar on the right side

of the active window is the scroll bar. An example of a text window showing
the scroll bar is in Figure 4-1.

The display window can be changed in size and moved on the screen. This
enables you to have multiple documents displayed on the screen. These

operations are done using the title bar and size control box as explained in
Section 4.4.2.

aa.1 Scrolling the Display
There are three ways of moving the display window through the document.
The first is by using the elevator. The elevator is the white rectangle in the
scroll bar. Its position in the grey portion of the scroll bar indicates the
relative position of the currently displayed text window in the document. If
the elevator is near the top, you are near the beginning of the document. If
it is near the middle, the text displayed in the window is near the middle of
the document, and so on. To change the paosition of the text window, you can
move the pointer into the elevator, click and hold the mouse button down
while you move the elevator to the position in the document you want to
display. When you release the button, the display will show the new position.

The second way of moving the window makes use of the view buttons. The
view buttons are the boxes at each end of the scroll bar. If you move the
pointer to a view button and click, the display moves one windowful toward
the beginning or end of the document, depending on which button you clicked.
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The third way of moving the window uses the scroll arrows, which are just
above and below the view buttons. If you move the arrow pointer to the
bottom scroll arrow and click, the display window will move one line toward
the end of the document. If you hold the button down, the window will
continue to move a line at a time until you release it. The upper scroll arrow
works the same way, except it moves the window towards the beginning of the
document.

8.2 Moving the Window

You can move the window on the screen and change its size. This lets you
display multiple documents on the screen. You can make any visible window
be the active window by moving the pointer into it and clicking.

To move a window, move the pointer to the title bar, press the mouse button
and hold it while you move the window. When you release the button, the
window is redisplayed at the new location.

To change the size or shape of the active window, mcve the pointer to the
size control box, press the button, and move the pointer until the window is
the right size and shape. Release the button and the resized window will be
displayed. The size control box is the box in the lower right hand corner of
the window. Only the active window can be resized.

45 The File Functions

The file menu provides functions for reading in and writing out documents,
updating documents, copying documents, ang exiting the Editor. The File
menu is shown in Figure 4-2. Each function is explained below.

Save & Put Away
This writes out the active document and closes it

SaveaCopy in. ..
This writes out a copy of the active document to another document name.
You are prompted for the name of the document to write to.

Save & Continue
This saves all changes made so far by writing out the document to disk,
without closing the document.

Revert to Previous Version

This returns the document to the way it was before you started editing it, or
when you last saved it. This is done by reading in the document from the
disk.
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File

Save & Put Away

Save a Copy in ...

Save & Continue

Revert to Previous Version

Open ...
Duplicate ...
Tear OFF Stationery ...

Exit Editor

Figure 4-2
The File Menu

This tells the Editor to get a new document. It prompts you for the document
name, then reads it in and makes it the active document. The Editor supplies
the .TEXT extension on the file name. If the file name that you want does
not end in .TEXT, you must end the file name with a period. See Section 1.5,
The Workshop User Interface.

Duplicate . . .

This enables you to read in a copy of an existing document to edit into a new
document. It is read in with the default name “untitled”

Tear Off Stationery . . .
This gets a new piece of stationery and makes it the active document. See
Section 4.2.3 for more information on stationery. The stationery is given the
default name “"untitied”.

Exit Editor

This first asks you if you want to put away any modified documents. If you
answer yes, they are written out to disk. Then it exits the Editor. If you
make the Editor resident, you can exit and restart the Editor without losing
any information between invocations. Section 3.4, Process Management, gives
instructions on how to make the Editor resident.
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4.6 The Edit Functions
The Edit menu provides editing functions and tab setting. It is shown in Figure
4-3.
The three basic edit functions are cut, paste, and copy. These make use of
the special window called the Clipboard. The Clipboard can hold one piece of
text. Text is put into the Clipboard by selecting it in the active document,

and either cutting it or copying it. Text is copied from the Clipboard and
inserted at the insertion poifit with the paste operation.

| Edic 3

tnda Last Change

o %X
Copy &{
Paste [ 1%
$hift Left %!
SHIFC Right %13
Set Tabs ...

Select Al of Document %A

Figure a-3
The Edit Menu
For example, to move text from one place in a document to another:
1. Select the text to be moved.

2. Choose Cut from the Edit menu. The text is removed from the active
document and placed on the Clipboard.

3. Place the insertion point where you want the text to be.

4. Choose Paste from the Edit menu. The text on the Clipboard is inserted
at the insertion point.

The Edit menu also enables you to adjust selecteq text left or rignt by
inserting or deleting spaces, and to set tabs.
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Some edit functions can also be done by holding down the ® key and pressing
another key. The key that corresponds to each function is shown in the Edit
menis, as you can see in Figure 4-3,

Undo Last

This command puts the document back to the way it was before the previous
operation, if possible. You will receive a wamning message if the last
operation cannot be undone.

Cut

Cut places a copy of the currently selected text onto the Clipboard and
removes the text from the active document. You can also Cut by pressing the
X key while holding down the & key.

Copy

Copy places a copy of the currently selected text onto the Clipboard, but
does not remove it from the active document. You can also Copy by pressing
the C key while holding down the & key.

Paste
Paste inserts a copy of the text on the Clipboard at the insertion point in the

active document. If a section of text is selected, Paste replaces it. You can
also Paste by pressing the V key while holding down the & key.

Shift Left

Shift Left moves selected text left by deleting a single space from the left of
each line. It does not delete any characters other than spaces. It is most
often used to adjust the left margin of a block of text. You can shift left by
pressing the L key while holding down the & key.

Shift Right

Shift Right is similar to Shift Left, except that it moves the selected text to
the right by inserting spaces at the beginning of each line. This can also be
done by pressing the R key while holding down the & key.

Set Tabs . ..

Set Tabs enables you to set the spacing of the tab stops.

Select All of Document
This command selects the entire document. You can also select the entire
document by pressing the A key while holding down the & key.

4.7 The Search Functions

The Search menu gives you the ability to search for a text string in the
active document. The basic operation is Find, which locates the next
occurrence of the string and selects it. Find & Paste All replaces each
occurrence of the string with the contents of the Clipboard. Several options
are provided to specify how the match is to be found. The Search menu is
shown in Figure 4-4.
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| Search | S

Find ... ®F
Find Same ®S
Find & Paste AIl

vSeparate ldentifiers
All Occurrences

vCases Need Not Agree
Cases Must Agree

Figure 4-4
The Search Menu

All searches start at the insertion point, and go to the end of the document.
There are three search nperations in the Search menu, as follows:

Find . ..

Find prompts you for the string to search for, then finds the next occurrence
of the string. If a match is found, it is selected. If not. the system tells you.
The Find command can also be executed by pressing the F key while holding
down the & key.

Find Same

Find Same repeats a previously specified Find, and selects the next occurence
of the string. You can do a Find Same by pressing the S key while holding
down the & key.

Find & Paste All

Find & Paste All finds all occurrences of the specified string from the current
insertion point to the end of the file, and replaces each of them with the
contents of the Clipboard.

The other four items in the Search menu tell how a match is to be found.
There are two areas to describe: searching for tokens or characters, and if
case must be matched. The options currently in effect have a check mark in
front of them. To change the option, you choose a new one.

The first set of options tells whether to search for tokens or to search
literally:
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Separate ldentifiers
when Separate ldentifiers is chosen, the search operation looks for a “token”
or word to match the search string. A token is a word bounded by spaces.

All Occurrences
when All Occurrences is chosen, the search operation matches any string
containing the same characters, even if it is only part of a word,

The next options indicate if case is significant in finding a match:

Cases Need Not
when Cases Need Not Agree is chosen, any string with the same characters is
a match, regardless of whether they are in uppercase or lowercase.

Cases Must Agree
when Cases Must Agree is chosen, the string with the same characters, and
matching case, is selected.

48 The Type Style Functions

The Type Style menu enables you to change the display font. The Type Style
menu is shown in Figure 4-5. A check appears in front of the font in which
the document is currently displayed. You can change the font by selecting
another font from the menu.

The font selected affects how many characters can be displayed on a line, and
whether or not the display is proportionally spaced. When a document is
printed, it is printed in the same type style it is displayed In, If that type
style is available on your printer.

Type Style |

20 Pitch Gothic
15 Pitch Gothic
v'12 Pitch Modern
12 Pitch Elite
10 Pitch Modern
10 Pitch Courier
PS Modern

PS Executive

Figure 4-5
The Type Style Menu
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49 The Print Functions

The Print menu provides functions for printing a document. You can print all
or part of a document, choose what form of footers are to be printed, specify
if Pascal keywords are to be emphasized, and tell what type of printer is
being used. The Print menu is shown in Figure 4-6.

The Print functions are as follows:

Print All of Document
The Print All of Document command prints the entire document.

Print Selection
The Print Selection command prints only the currently selected portion of the
document.

Both of the print commands wait if the printer is not ready.

The remaining options in the Print menu involve how the print is to be
performed. They are organized into three sets of two options. The currently
selected option in each set is indicated by a check mark. You can choose any
combination of options you want.

Print All of Document
#Brint Sefection

vFull Footers
Page Numbers Only

vPlain Keywords
Differentiated Keywords

v Dot Matrix Printer
Daisy Wheel Printer

Figure 4-6
The Print Menu

The first opuons control what type of foolers are printed at the bottom of
the page.

4-12



workshop Users Guide

Full Footers

when Full Footers Is chosen, each page printed has a footer consisting of the
document name, the page number, and the date. If the document is less than
one page long, no footer will be printed.

Page Number Only

Choosing Page Number Only results in only a page number on the bottom of
each printed page. If the document is less than one page long, no page
number will be printed.

The next options are used for printing Pascal programs.

Plain Keywords
Choosing Plain Keywords causes Pascal keywords to print as normal text.

Differentiated Keywords

Choosing Differentiated Keywords causes Pascal keywords to print with
underlining. In addition, the read procedure, write procedure, and other
standard Pascal procedures and functions are underlined.

You choose the type of printer to print on with the next options. Select the
type of printer you have attached to your Lisa: Dot Matrix Printer or Daisy
wheel Printer.
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CHANGES [ADDITIONS

Workshop 3.0 Notes The Fascal Compiler

Chapter 5
The Pascal Compiler

New Compiler Commands (See Section 5.3)
Five new Compiler commands have been added: $ASM, $E, $M, $P, and $U.
$ASM controls whether or not the listing shows the assembly code generated
by vour Pascal statements. 3E lets you automaticelly invoke the Editor. $M
lets you generate Macintosh code. $P starts a new page in your listing. $U
controls the Compiler's search for a regular or intrinsic unit's interface.

For a detsiled update, consult the 3.0 Release Notes for Chapter 12, The
Compiler, of the Fascal Reference Manual for the Lisa.
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5.1 The Pascal Compiler

The Compiler translates Pascal source statements into object code. This
translation is done in two steps. The first step, parsing, converts the program
into semantically equivalent tree structures called 1-code. The second step
translates the resulting I-code into machine language.

A complete definition of Lisa Pascal is found in the Pascal Reference Marnal
for the Lisa A Pascal program can call assembly language routines. More
information on assembly language is in Chapter 6 of this manual.

The Operating System provides a number of routines that can be called from a
Pascal program to perform various system functions. These routines are in the

SYSCALL unit, which is described in the Qperating System Reference Meral
for the Lisa.

The Pascal run-time support routines are in the library I0SPASLIB.0BJ. The
support routines for floating point operations are in IOSFPLIB.0BJ. After
generating the object code, it is necessary to link the program with
10SPASLIB.0BJ before you can run it. If you are using real numbers, you must
also link with 10SFPLIB.0BJ. For information on how to link the program, see
Chapter 7 in this manual.

52 Using the Pascal Complier

The Compiler expects a text flle containing a Pascal source program as input.
You can create this text file using the Editor.

when you have prepared a source program, use the Compiler to translate it
into object code. Start the Compiler by pressing P in response to the
Workshop command prompt. The Compller first asks:

Input file[.TEXT]

Type the name of the file that contains the source program. You do not need
to add the .TEXT extension. The Compiler then asks:

List file[.TEXT]

Type the name of the file that you want the listing to go to, or press
[RETURN] if you don't want a listing. You can display the listing on the

console by using the -console pathname. The Compiler next asks you where
to store the I-code form of the program:

I-code file[<input name>][.1}
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If you want the I-code to be stored in a file with the same name as the
source flle, but with a .I extension instead of the .TEXT, just press [RETURN]
If you want another name, type the name and press [RETURN

After the last input, the Compiler translates the program into I-code and
stores it in the I-code file. If there were any errors, they are displayed in
the listing file, or on the console if there is no listing file. When a message
is displayed on the console, you are given a choice of aborting the compile by
pressing [CLEARY], or continuing the compilation to look for more errors by
pressing the space bar. A few errors give additional information after you
press the space bar. Errors can also be placed in a separate error file by
using the $£ Compiler command.

5.2.1 Using the Code Generator
To translate the [-code into object code, press G in response to the Workshop
command prompt. The code generator first asks:

Input file [.I] -

Type the name of the I-code file. You do not need to add the .I extension.
The generator then asks:

Output File [<input name>][.0BJ] -

To accept the default name, press [RETURN] If you want a different name
for the output file, type the name and press [RETURN] The .0BJ extension
will be added to the name for you.

The output file from the code generator is object code, but it is not
executable because it does not contain the Pascal run-time support routines.
The run-time support routines are contained in IOSPASLIB.0BJ, and
IOSFPLIB.0BJ for floating point operations. These routines must be added to
the object file by using the Linker. See Chapter 7 in this manual for more
information on the Linker. ¥

5.3 The Pascal Compller Commands
Compiler commands allow control of code generation, input file control, listing
control, and conditional compilation. The commands all start with a §, and
are placed as comments in the source program where you want the command
to take effect. All the Compiler commands are listed in Table 5-1. A
complete explanation of the Compiler commands i3 found in the Pasca/
Rererence Menual for the Liss.

¥ The rods feney alor f,‘\w\”\za‘/" Ihe irc m \"ﬂ“"» of cach voutme,
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Table 5-1
Pascal Compiler Commands

Command Meaning

$I filename Include contents of filename in this compilation.

$U filename Search filename for units used.

$C+ or $C- Turn code generation on (+) or off (=) for a procedure.
Default $C+.

$R+ or $R- Turn range checking on (+) or off (-). Default $R-.

$S segname Start putting code modules into segment segname.

$X+ or $X- Turn automatic stack expansion on (+) or off (-).
Default $X+.

30+ or $D- Turn procedure name generation for Debugger on (+)
or off (-). Default $D+.

$E filename List Compiler errors in filename.

$L filename Produce Compiler listing in filename.

$L+ or $L- Turn source listing on (+) or off (-). Default $L+.

$DECL list Declare compile time variables.

$SETC Assign a value to a compile time variable.

3$IFC Begin conditional compilation section.

$ELSEC Begin ELSE clause of conditional cornpilation.
$ELSEC is optional.

$ENDC End of conditional compilation section.

5.4 The Pascal Run-Time Environment
The Pascal run-time environment provides a unit PASLIBCALL which allows
you tg use some special system functions. It also provides special heap
manipulation functions.

5.4.1 The PASLIBCALL Urit
The unit PASLIBCALL provides you with some additional system functions. In
order to access the PASLIBCALL routines, you must use the units SYSCALL
and PASLIBCALL:

USES
{SU syscall} SYSCALL,
{sU paslibcall} PASLIBCALL;

This gives you access to the routines listed below. These routines are
contained in I0SPASLIB.0BJ, so programs using them require no additional
inputs to the Linker.
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function PAbortFlag : boolean

Pascal Cormpiler

This function tells whether or not the &-period key combination has been
pressed. It enables programs to exit out of long operations. The flag is
cleared when PADortFlag is called. 1f you want your program to stop
when you press ®-period, you must use this function in the program to
detect that the key combination has been pressed. For exampie:

{This program fragment hangs in an infinite loop until #-period

is pressed}
aborted :=false

Repeat {Wait for ®&-period. You might want to do other things

here}
aborted :=PAbortFlag;
until aborted.

procedure ScreenCtr (contrfun : integer );

This procedure provides standard screen control functions, and enables
programs to perform screen control without having to to use escape
sequences. Escape sequences are explained in Appendix C. The parameter
It is defined in the constants as

specifies the screen control function.
follows, in the PASLIBCALL unit:

Function

clear screen

clear to the end of screen
clear to end of line

move cursor to home position
cursor left one position
cursor right one position
cursor up one line position
cursor down one line position

Screen control example:

Value
Constant Decimal Hex
CclearScreen 1 1
CcleartScreen 2 2
CclearELine 3 3
CgoHome 11 B
CleftArrow 12 C
CrightArrow 13 D
CupArrow 14 E
CdownArrow 15 F

{This program fragment clears the screen, and positions the

cursor on the third line}

ScreenCtr (CgoHome);
ScreenCtr (CclearScreen);
ScreenCtr (CdownArrow);
ScreenCtr (CdownArrow);

5-4
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procedure GetGPrefix (var prefix : pathname);

This procedure provides your program with the first level prefix setting in
the File-Mgr in the Workshop.

procedure GetPrDevice (var PrDevice : e_name);

This procedure returmns the corresponding default printer device name so
that you can perform additional device control functions using
DEVICE_CONTROL. (The Querating Systern Refererice Manisl for the LIsg
explains the device control call) The default printer device name is the
one corresponding to the logical device ‘-printer’. Note that the device
name retumed contains a leading '-".

procedure PLINITHEAP (var ernum refnum:integer;
size, delta:longint
ldsn:integer;
swapable :boolean);
where:

emum is the error number returned if the procedure has any
problems making a data segment having a mem_size of
size bytes. Appendix A contains an explanation of the error
codes for the Workshop.

size is the number of bytes in the heap.
refrum  is the refnum of the heap.

delta is the amount you want the data segment to increase when

the current space is used up. If you use a large heap, use a
large number for delta.

ldsn is the logical data segment number used for the heap. The
default is 5. For more information see the Qperating System
Reference Marsal for the Lisa.

swapable is the boolean that determines if the system can swap the
heap data segment out to disk if it needs to.

This procedure can be used when you have special needs; for example,
when you want to specify your own ldsn or heap size. When you use
PLINITHEAP, you must call it before calling other heap routines. For
more information on the heap, see Section 5.5.
542 The Pascal Heap
The Pascal heap is one contiguous piece of memory, a data segment, which
works automatically without any initialization call. See Chapter 11 of the

Pascal Reference Marwil for the Lisa for information on the normal heap
functions.
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When a Pascal program starts execution, no heap space is allocated (no data

segment made). On the first call to one of the heap routines or on the first

PLINITHEAP call, the heap is created with either a default size of 16k bytes
or the size specified in the PLINITHEAP call.

PLINITHEAP makes the heap as a private data segment so that the Operating
System removes it when the process calling PLINITHEAP terminates. Note
that when the heap is initialized, size and delta are put on 512 byte block
boundaries. Therefore, if you use the PLINITHEAP call and specify values for
size and deita that do not fall on block boundaries, the procedure increases
the values to the next block boundary.

If the heap runs out of space while it is being used, the size of the heap is
increased by the default of 16k or the delta specified in PLINITHEAP. The
default Idsn used is 5. If you want a different ldsn for the heap data
segment, call PLINITHEAP. Remember that the size of a data segment is
limited by the ldsn you use. For ldsn 16, you can get only 128k (actually 96k
safely), for 1dsn 15 you can get only 256k, for ldsn 14 you can get only 384k,
and so forth. See the Qperating System Reference Manual for the Lisa for
more information on Idsn’s and data segments.

If swapable is true, the heap is made with disc_size equal to size so the data
segment is not memory resident. This uses up disc_size bytes on the startup
disc. The default for swapable is false. when swapable is false, the
procedure creates a data segment that has a disc_size of D (zero), which
makes it memory resident.

The built-in Pascal heap routines are NEw, MEMAVAIL, MARK, RELEASE, and
HEAPRESULT.

* If you call NEW and not enough space is available, the size of the heap is
increased by either the default of 16k or the delta size specified in
PLINITHEAP.

* MEMAVAIL provides the maximum number of words you could ever expect
to get, taking into account the ldsn you used as well as the amount of free
space the Operating System currently has available. If another process is
using memory concurrently, its use of memory also affects MEMAVAIL.
MEMAVAIL does not show the amount of memory left in the heap's data
segment alone, since the heap's data segment can grow and shrink over
time.

* MARK sets a pointer to the lowest free area on the heap. It is used with
RELEASE to deallocate variables from the heap.

RELEASE deallocates variables from a marked area of the heap. If you
release the heap to a point within the original size of the heap data
segment, the heap data segment is reduced to its original size. More
information on MARK and RELEASE can be found in the Pgscal Reference
Marual for the Liss.
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= HEAPRESULT returns a 0 if the last heap operation was successful,
otherwise it contains the Operating System error number indicating what
failed. A list of the Operating System errors is in Appendix A
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Chapter 7
The Linker

New Linker Options (See Section 7.3)
The Linker accepts the following new options:

+C moduleName segmentName
Make a copy of moduleName in segmentiName. Used for

performance reasons to prevent cross-segment calls and the possible
need for a segment swap.

+F Means the link ie a link of system code that runs in Domain O, and
therefore cannot use MMU's 1-16. The default is -F.

+] Include interfaces in an intrinsic library link. The default is +lL.
(Note: this is a change--in previous releases, interfaces were not
included.)

+0 Emit OS data record for main programs. Used by the OS for initial
program loading. The default is +0.

+X Mac link--generate an object file specially designed for the
Macintosh Resource Compiler. The default is ~X.

+Z Warn if codesize is too large. The default is +Z.

The -H and +S options (for setting initiel disk space and stack size) no
longer have ary effect.

Intrinsic Units (See Section 7.5)

' You can now link to irtrinsic units you've created yourself; vou are no longer
limited to those provided by Apple. For information on writing intrinzic
units, see the Release 3.0 Notes to the Fascal Reference Nenual Chapter 9,
Units.
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7.1 The Linker

The Linker combines object files. Its input consists of commands and object
files. Its output consists of object flles, link-map information, and error
messages. The output of the Pascal compller must be linked with
I0SPASL1B.0BJ before it can be executed. Other object files, including

intrinsic unit libraries, and object files produced by the Assembler, can also be
linked into the output object file.

when a program is compiled into an object file, it contains the following sorts
of things:

= Object code, in the form of relocatable machine language, that expresses
the algorithm of the program.

* Symbolic (named) references to all locations that were not known at
compile time. These include externally compiled routines (units and
intrinsic units) and the Pascal library support routines (I0SPASL1B.0BJ).

= Other information to be used by the Linker.

The purpose of the Linker is to resolve all the symbolic references (link
references to definitions), and output an object file that can be executed. The
Linker also sorts the code modules into named segments. These segments are
swapped into memory at run time by the Operating System.

The Linker does its work in two phases. In the first phase, it reads all the
input files, and finds all symbolic references and their corresponding
definitions. Errors such as duplicate and missing references are detected
during phase one. In the second phase, the Linker copies code from the input
files into the output files in executable format.

If the Linker can't find something that is addressed symbolically, this is an
error. An error message will be printed, indicating the missing module. This

rocess of finding the real addresses that correspond to the symbolic addresses
s called resolving the extemasl references

The Linker expects to find the file INTRINSIC.LIB. INTRINSIC.LIB is a
directory of llbraries and intrinsic units, and includes information for the use
of the Linker. INTRINSIC.LIB defines all the intrinsic units supplied with the
workshop system.

To create an executable file, the Linker must have the following inputs:
= The object file from a main Pascal program.
= IOSPASLIB.0BJ to provide the standard Pascal procedures and functions.
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* 10SFPLIB.0BJ, if you are using any floating point variables.

* Object files for any other external procedures referenced by the main
program. These can be Pascal units, assembly language routines, or
Intrinsic units defined in INTRINSIC.LIB.

The Linker combines these flles and creates an executable abject file. If it is
unable to link these files correctly to create a legitimate output file, the
Linker displays an error message. 1f there is an error, the object file is not
proguced.

when linking @ maln program, all references to external gbjects must be
resolved. Partial links are not supported.

whlle it Is linking a maln program, the Linker does a oead cooe analysls and
does not Include any routines that are not referenced. Unnecessary routines
are eliminated from the main program, and from the regular units given as
Inputs to the link.

7.2 Using the Linker

The Linker Is started by pressing L in response to the Workshop command
prompt. The Linker prompts you for the input files, the listing file, and the
output file. Options can be entered after entering "7 In response to the input
file prompt. After all file names and options are entered, the link begins,
Hence the set of options in effect is the same throughout the link. 1t is rot
possible to change options part way through the link. When entering an input
file name, it is not necessary to enter the .0BJ extension; the Linker will
provide that as needed for input files.

The Linker will accept option comimands and input file names from a
command flle. A command flle is a text file containing the file names and
options, one per line. If a blank line exists in the flle, the Linker treats this
as the [RETURN] that signals the end of the input files. You use a command
flle by typing "<" followed by the name of the text file the commands are in.
It is not necessary to enter the .TEXT extension; the Linker wiil provide that
as lneeded for all input command files. Create the text file by using the
Editor.

The cefault listing is -console. You can send the listing to a text file by
entering its name in response to the listing file prompt. When sending the
listing to a text flle, you do not need to provide the .TEXT extension, since
the Linker provides it.

After entering the ouput file name, the link begins. 1f no errors occur during
the link and all external references are resolved, the output file is executable.
A message Is printed at the end of the link to tell you if the output is
executable.

7.3 The Linker Options

To enter the Linker options mode, type "7 [RETURNJ in response to the
prompt for an input file. To leave options mode and return to entering input
files, press [RETURN] in response to the options prompt. The order in which

7-2



Workshop Users Guioe The Linker

options are entered is unimportant, because they have no effect until the link

begins. The last value entered for an option is the value used when the link
is performed.

Options are represented by a single character. A "+" in front of the character
makes that option take effect. A “-" sets the Linker so that option will not
happen. In addition to being set on or off, some options have additional
parameters. Numeric parameters can be in either decimal or hexadecimal.
Hexadecimal numbers are indicated with a leading “$". The current setting
of all options can be displayed by entering a "?" in response to the request
for an input file or an option.

The Linker options are as follows:
+A Alphabetical listing of symbols. The default is ~A
+D Debug information. The default is -D.

H1 num -H sets the initial disk space allocated to the program's stack.
The default is to automatically include space for the program
variables and the value specified in the +S option.

+L Location ordered listing of symbols. The default is -L. The
location is the segment name plus offset.

+M fromName toName
+M maps all occurrences of the segment fromName to the
segment toName. This allows you to map several small segments
into a single larger segment. You can thereby postpone
segmentation decisions until link time by using many segment
names in the source code.

NOTE

Because options have an effect only when the link begins, it is not
possible to map a segment name to several different names using this

option. Also, you cannot use this option to map segments to or from
the blank segment.

+S num +S sets the starting dynamic stacksize to ‘num’. The default is
10000.

+T num +T sets the maximum allowed location of the top of the stack to
‘um’. The default is 128K

+ W + W tells the Linker to get intrinsic unit information from a file
other than INTRINSIC.LIB.

? Prints the options available and their current values.
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7.4 How Do I Link a Main Program?
A maln program consists of a Pascal program linked with all routines
necessary for it to run. A maln program is the only type of executable object
flle produced by the Linker. To link 8 mailn program you must have the
following:

* A compiled Pascal PROGRAM object flle.
* Object files for any other units the program uses. This Includes files for

regular units and assembly language routines. Any intrinsic units used
must be defined In INTRINSIC.LIB.

* IOSPASLIB.0BJ, and IOSFPLIB.0BJ (if any real variables are used)

when you have all the above flles, proceed as follows:

1.

2.

Execute the Linker by pressing “L" when the Workshop command prompt is
displayed. The Linker displays a header and asks you for an input file.

Enter any desired options. To enter the options mode, press “? [RETURN]'
in response to the request for an input file. See Section 7.3 in this
chapter for information on Linker options. Press [RETURN] after each
optlon entered. when you have entered all the optlons, press [RETURN] to
begin entering input file names.

Enter the file names for all the object files, pressing [RETURN] after each
one. The file names can be entered In any order. You do not need to
enter the .0BJ extension; the Linker will automatically append it.

Press [RETURN] to indicate the end of the Input files.

The Linker prompts you for a listing flle. Enter the flle name desired, or
press [RETURN] to accept the default of displaying the listing on the
~-console.

The Linker prompts you for the output file. Enter the name of the
executable file you want produced. You do not need to enter the .08J
extension; it is supplied automatically.

The linking process begins when you press [RETURN] after entering the output
file name. If the link Is successful, the message "Output is executable” will be
displayed. If the link 1s not successful, error messages are displayed.

7.5 Regular and Intrinsic Units
The two types of units are regular units and intrinsic units. Each is a
separately compiled code module that may be used by a maln program or
another unit. The syntax of a Pascal unit is explained in the Pasca/
Reference Marval for the LIsa.

A regular unit is combined with a main program by the Linker and included in
the resulting object flle. An intrinsic unit, on the other hand, is stored
separately on the disk, and loaded at run time. Thus, only one copy of an
intrinsic unit Is kept on the disk, no matter how many main programs use it.
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In addition to being shared on the disk, an intrinsic unit is also shared in
memory.
NOTE

The current implementation has no provision for users to create new
intrinsic units. All intrinsic units are supplied by Apple Computer.

75.1 How Do 1 Link with a Regular Unit?
A regular unit is a separately compiled segment of code. It is written in
Pascal, and compiled like a regular program. See the Pascal Reference
Marwsal for the Liss for information on how to write a unit. See Chapter S
in this manual for information on compiling the unit.

After you have created a unit, the routines in it can be accessed from any
other program or regular unit you write. The Linker combines a main program
with all units it uses. The result is an executable object file containing all
the needed routines.

To use regular units with a main program, follow the procedure in Section 7.4.
As input, you must give the Linker:

* The object file of the main program.
* The object files of all units used by the main program.
* JOSPASLIB.0BJ, and I0SFPLIB.0BJ (if any floating point variables are used).

The Linker combines all these object files into an executable object file. It
also does a dead code analysis to eliminate any routines that are not used, to
reduce the size of the object file.

7.6 The Linker Listing
A listing is produced each time a program is linked. This listing can be sent
to a file, or displayed on the console (the default) The +A option gives you
an alphabetical list of the symbols (procedure names) used in the link. The +L
option gives you a list of the names in order of their location. The listing is
produced in stages, as follows:

1. The input files are read, and a summary of the resources used is printed.

2. The linking process begins. Information about the size of each segment is
printed.

Errors are reported as they are found, and you are told whether or not the
output s executabls.

If you requested optional listings, they are also printed. An example of a
Linker listing with no options requested Is shown in Figure 7-1. Linker
listings are mainly used for debugging at the machine code level. See
Chapter 8 for more information on the Debugger.
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Beginning wemory - 262488

After static allocation, mewory - 1068149

Input file [L,OBJ1 ? TRANSVOL

Input file [.0BJ} ? I0SPASLIB

Input flle [.0BJ) ?

Listing file [CONSOLE1)/L,TEXT) -

Qutput file [.0BJ] - IRANSFER_FLS

Reading flle) TRANSVOL.OBJ

Reading f{le: [0SPASL1B,0BJ

Read 2 files, max » 108

4 segquents, max » {28

16 woduley, wax » 1450
32 entrles, max = 20008
30 ref. lists, wax = £008
124 references, max = 16800

Link ing HMain Program.

fctive: 4 of 16 read,

Visibler { of 32 read.

Glnbal datar $808067C

Cownon datar 1200089

Lipking segmnent N: B ¢ flle (J1) segr § slzes 2908
Beginning wewory - 184487
Ending wewory - 104932

9 Errors detected,
Ihe outpbut 1S executavle,

Elapsed tise: 298 and 304/1008 seconds.
That‘s all Folks !!! . .,

Figure 7-1
A Linker Listing

7.7 Resolving External Names

An external name is a symbolic entry point into an object module. All such
names are visible at all times--there is no notion of the nesting level of an

extemal name. External names can be either global or local. A Jocsl narme
begins with a § followed by 1 to 7 digits. Local names are generated by the
Pascal compiler. A globsl name is any name that is not a local name.

The scope of a global name is the entire program being linked. Unsatisfied
references to global names are not allowed. Only one definition of a given
global name can occur in a given link. The one exception to this is that the
Linker accepts duplicate names where one instance is in a main program or
regular unit, and the other is in an intrinsic library file. In this case, a
warning is issued, and the entry in the main program or regular unit is used.

The scope of the local name is limited to the file in which it resides. All
references to a given local name must occur within the same input file.
when a link is done, global names are passed through to the output file
unmodified, but local names are renamed so that no conflicts occur between
local names defined in different files.

7.8 Module Inclusion

when linking an intrinsic unit, all code modules in the unit are included.
when linking @ main program with regular units, the Linker does a dead code
analysis and does not include any modules that are not called.
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7.9 Segmentation
Segmenting a program makes it possible for portions of the program that are
not being used to be swapped out to disk, thus making better use of memory.
The way a program is segmented affects its performance.

Segmentation is controlled by three things:

* The $S Compiler command and the .SEG Assemnbler option, which assign
segment names to source code modules.

* The +M Linker option, which enables you to remap compiler segment
names Into new segment names.

= The ChangeSeg utility, which enables changing the segment names prior to
nking. See Chapter 10 for information on ChangeSeg.
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Exec Files

9.1 Introduction to Exec Files
Sitting at your computer and typing Workshop commands is like driving a car
yourself. Using exec files is like teaching a chauffeur the route, then saying,
"Take me there again" and sitting back while the chauffeur drives. With

exec files you can execute Werkshop commands automatically, without
retyping them each time.

An exec file is actually a program. You can psse parameters to the exec
file, and you can execute its statements conditionslly. Its programming
language consists of the erec commands described in this chapter plus
Workstop cormmands you already know.

For instance, you can create a test procedure called TESTEXEC that runs a
set of application prograrns. Then each time you modify a program you can
rerun the entire test simply by typing the Workshop Run command

R<TESTEXEC
Here's what TESTEXEC looks like:

$EXEC
Rsales
Rexpenses
Rgenledger
$ENDEXEC

The first and last lines of TESTEXEC ere exec commands. The cther lines
each contain a Workshop Run command.

Like other programs, an exec program doesn't run directly from its source
statements--it has to be processed first. You use the Editor in the
Workshop to create an exsc source file. Then st process time you invoke
the Exec Processor to create an &xe£c run rile which is run by the Workshop
at run time. s shown in Figure 9-1.
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Figure 9-1. Qverview of Exec Files

911 The Exec Processor
The Exec Processor operates under the Workshop Run command. When you
type
R¢pathname
or
REXEC/pathname

in the Workshop command line, the < or EXEC/ (upper or lower case) tells the
Exec Processar to process an input file. The input file is usually an exec
source file but it may be a previously created exec run file.

The exec run file--the output of the Exec Processor--contains only Workshop
commands. The Exec Processor looks at veriables in the exec source file
and determines their process-time value; then, based on conditional execution
of exec commands, it determines which Workshop lines to place in the exec
run file. The Exec Processor's final step is to give the exec run file to the
Workshop, which runs it.

An exec source file normally has a file name with a "“text" extension. An
exec run file always has the same file name with a ".text" extension:

Exec Source File Exec Run File

nyexec_text ==) myexec__text
nyexec ==) myexec. _text
my._exec._text ==> ay_exec. _text
my .exec =z} my _exec_ _text

The normal Exec Processor function is "process-and-run," but a number of
commands and options are provided for greater flexibility. For instance, the
DOIT command tells the Exec Processor to give the current contents of the
exec run file to the Workshop to run immediately; the Workshop then returns
control to the Exec Processor &0 it can continue processing the the source
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file. The Keep and Rerun Processor options sllow you to save the exec run
file and run it again without reprocessing. (For more information on exec
run files, see Section 9.3, Running an Exec Frogram.)

NOTE

To terminate processing when the Exec Processor is running, press
®-period.

912 Distinguishing between Exec Lines and Workshop Lines
There are two kinds of exec source lines: exec lines and Workshop lines.

Exec lines contaln exec commands, written in a language similer to Pascal;
these comrnands are described in Section 9.2, Writing an Exec Program.
Exec commands allow you to change variable values, skip over Workshop
lines under exec control, perform I/0, and control the Exec Processor.

Each exec command must begin on a new text line; it can occupy more than
one text line. The Exec Processor looks for a corntinuation line only if the
command is syntactically incomplete. In the following example, line 5

completes a valid comrnand, so line 6 is flagged as an error:
1. repeat

3. until reply = 'YES'
6. or count > 5

To notify the Exec Processor that the command continues, rewrite line 5 so
that it is syntactically incomplete: .

5. until reply = 'YES' or
6. count > 5

Workshop lines contain either responses to the Workshop command ling-~
such as File-Mgr and Linker cornmands--or input to any programs you run
under the Workshop. Workshop lines should be typed in the exec source file
just the way you would enter them from the keyboerd, following the
dollar-sign cornvention you have chosen (see below).

9.1.2.1 The Dollar-Sign Corwention
The dollar-sign (8} comeention sllows the Exec Processor to distinguish
hetween exec lines and Woarkshop lines.

If the first line of your exec program, the EXEC command, begins with a
doller sign, the Exec Processor considers every line thalt begins with a doller
sign to be an exec line, except if the line is the continuation of a comment;
other lines ere considered Workshop lines.

9-3
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If the EXEC command does #o? begin with a dollar sign, every line withowt
an initisl doller sign is considered an exec line, and you must precede every
Workshop line with a dollar sign.

NOTE

The comrnand formats in this chepter are shown without an initial dollar
sign, but many of the examples use the dollar sign on exec lines. If
you write an exec that calls another exec, the two exec files need not
use the same dollar-sign convention.

9.13 Introduction to Variables and Parameters
A variabie is a string whose contents can change during execution of an exec
program. Variables sllow you to generalize an exec progream so that you can
use the same exec in a variety of situations.

Yarisbles in exec language are local to the exec thet declares them. If you
give a variable the same name in two different exec files, you will still have
two separate local verisbles.

A parsmetsr is a varisble to which you expect to give an initial text value
from outside the exec program. You can pass a list of parameter values to
an exec when you invoke it either from the main command line or from
another exec.

Yarisbles and parameters are identified either by s name or by a number.
They are written in one of the following ways:

%¥n  where n is a veriable number (0-9): %3

X where x is a veriable name in an exec line: varl

[x] where [x] is a veriable name in a Workshop line or an exec
irvvocation: [param3]

9.131 Variable Names and Numbers
You can declere up to twenty named verisbles or parameters. The first ten
of them can be referred to by number &s well. Numbered variables have the
advantage of not having to be declered; named veriables provide more
meaningful documentation. VYalues are assigned to variables in the same
way whether you use names or numbers. You can use both numbers and
names in 8 given exec program, and you can refer to the first ten varisbles
either by name--if you declered thern--or number.

when you use veriable numbers, these rules apply:

« The numbered veriables ere shown as a percent sign followed by a
number from O to 9: %0 through %9.
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* You can supply initial values for numbered verisbles in an invocation
parameter list (see Section 9.3.1). The value for #0 must be first in
the list, the value for $1 next, and so on in numeric order.

When you use variable names, these rules apply:

» Yariable names must be declared in the EXEC command's variable
declaration list. The list is enclosed in parentheses and contains
verieble names separated by commas; for instance,

(payday, paytype, profitshare,bank).

* You can supply initial values for narned variables in an invocetion
parameter list. The values must be listed in the order in which the
corresponding variable names were declared; for instance,

(05/04/85 hmxly, 0276 FirstState) supplies values for the veriable
declaration list sbove.

= A variable name must be alphanumeric and must begin with an
alphabetic character; the name can be as long ss you like, but only the
first eight characters are significant.

* A veriable name in a Warkshop line, an expanded string constant, or an
exec invocation must be enclosed in square brackets ( [ ]) to distinguish
it from ordinary text.

= You can refer to the Tirst ten named variables either by name or by
number. If you declare five veariable names, they correspond to
variables %0 through %4.

The two examples shown below function iderticaelly. The first example uses
numbered varisbles:

exec {NUMBERED YARIRBLES
%0=gource file name, Xl=counter}

if exists("%0_text") then
set %1 to eval(Xi-1)
$F{iler}D{elete} %0 text
$0{uit the Filer)

endif

endexec

9-5
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The second example uses veriable names (note the veriable declaration list
following the EXEC cornmand):

exec (oldsource, counter) {NAMED VARINBLES)
if exists("[oldsource].text") then
set counter to eval{counter-1)
$F{iler)D{elete)[oldsource] .text
$Q{uit the Filer}
endif

éﬁaex ec

9.1.3.2 Setting Variable Values

You can alter the value of & veariable by using the SET, DEFAULT, and
REQUEST exec commands described in Section 9.2.1.

The initial velues of variables at process time are supplied in an irmocation
parameter list--a list in parentheses following the exec name in a Workshop
Run command, a SUBMIT command, or & user function. Yalues in the list
consist of text separsted by commes. If a psrameter value is not provided
for a given variable, its inital value is the null string.

Whether you use numbered or named veariables, the invocation parameter list
is the same. For instance, the following Run command will work with either
example in Section 9.1.3.1 above. The value of the %0 or oldsource varisble
is "-backup-oct6”; the value of the ¥1 or counter varisble is "4".

R<files(—backup-oct6, 4)

You can supply initial values for some, none, or all of the veriasbles your
exec program uses. The Workshop Run command below contains initial
values for parameters ¥0 and %¥2--or their named equivalents. A value for
X1 is not supplied.

R{(exsales(-lower—customers, , Accounts Receivable)

To demonstrate the use of variables to make an exec more versatile, let's
generalize the makeoneprog exec, shown in the next exarnple.

9-6
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$EXEC { "makeoneprog” —— This exec file compiles and
links a specific Pascal program named ONEPROG. }
P{ascal compile}ONEPROG
{ no listing file }
{ default object file }
L{1ink}ONEPROG
IOSPASLIB
{ end of linker input }
{ no list file }
ONEPROG{ output file name }
$ENDEXEC

If you want to compile and link a Pascal program named OTHERPROG, you
can't use the makeoneprog exec file. To compile and link any Pascal
program, change the name of the Pascal program in the exec from ONEPROG
to ANYPROG and declare it as a varisble. We'll call the new exec

makearnyvirog

$EXEC (ANYPROG) { "makeanyprog” —— This exec file
compiles and links an Pascal
progream .}
P{ascal compile}[ANYPROG]{program—name variable}
{ no listing file }
{ default object file }
L{ink) [ANYPROG ]
I0SPASLIB
{ end of linker input }
{ no list file }
[ANYPROG]{ output file name }
SENDEXEC

You can run makeanyprog to compile and link the ONEPROG program. The
initial value "ONEFROG" replaces every occurrence of the variable
ANYPROG when vou use the following Workshop Run command:

R<makeanyprog(ONEPROG)

To compile and link the OTHERPROG program, you can run makeanyprog
again, simply changing the Run command:

R«makeanyprog(OTHERPROG )

914 Syntax of Exec Lines and Workshop Lines
This section contains rules for writing exec lines and Workshop lines. You
can use it first as & general introduction and later as a reference tool.

The Exec Processor places a Workshop line in the exec run file after
performing the following processing:

9-7
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« Removing the inital dollar sign, if amy.

* Processing tildes.

= Substituting the current values of veariables.
* Rernoving comments.

» Eliminating leading and trailing spaces (unless the Blanks process-time
option was specified).

Special characters sre used ss delimiters and as siénals to evoke special
processing by the Exec Processor; they include

Exec/Workshop distinguishing character

Numbered variable character

Yariable name delimiters (W)

Comment delimiters

Simple string constant delimiters (E)

" "  Expanded string constant delimiters (E)
Tilde literalizing character (W)

< Exec irwocation character

(W) means this character has special significance only in Workshop lines. (E)
means this character has special significance only in exec lines.

- iy, P aa
- S Nl

Cormnerds can be included in exec or Workshop lines. A line thet consists
of nothing but comrnents is corsidered an exec line or a Warkshop line
depending on the doller-sign convention. A comment can extend over more
than one line, a5 in the exec program examples in Section 9.1.3.2. Any
information in braces ({ }) is considered a comment and is ignored by the
Exec Processor. For example, the Workshop line

A%0
can be documented with comments; in the example shown below, the first
line is a Workshop line and the second line is an exec line:
fA{ssemble}X0{source file}
${Use a separate line if more comments are necessary.)

It's good practice to write sll separate comment lines 8s exec lines because
a Workshop line with nothing but comments ceuses a [RETURN] to be placed
inn the exec run file.

Lpper and lower case in Workshop lines is passed intact to the exec run file.
In exec lines, case is significant only in string constants; that is, varl is the
same variable name as VAR, but 'YES' is not equal to 'yes'.

Spaces are delimiters in exec lines (extra spaces are ignored). In Workshop
lines, leading and trailing spaces are rermnoved before the line goes into the

9-8
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exec run file unless you specify the Blanks option at process time; whether
spaces are significant within Workshop lines depends upon the program you
are running.

The dollar sign ($) is used to distinguish between Workshop lines and exec
lines. See Section 9.1.2.1, The Doller-5ign Convention, for more information.

The tilde (") is used ss a literalizing cheracter (Workshop lines only). The
special cheracter that follows the tilde is not interpreted by the Exec
Processor but is placed in the exec run file as is; for example,

"$40,723.78  "{Cost of Sales} 35.5°%

In this example the dollar sign is no! interpreted according to the dollar-sign
convention. The information within braces, which would norrmally be
discarded as a comment, /s placed in the exec run file. (Because a tilde
cancels the effect of the left brace as a commment delimiter, the right brace
has no meaning and does not require a tilde.) The % is not interpreted as
the first character of & numbered variable.

To represent the tilde itself in a Workshop line, use two tildes in a row.

Tthe exec invocation character (¢} should be followed by the pathname of an
exec file. This character is used to call & user exec function; in the
following example, devname is an exec file that returns a function result:

$set checkvol to <devname([checkvol], -myvol)

The imvocation character can also be used in a Workshop Run cornmand to
cause chaining to another exec program (see Section 9.4.1, Exec File
Chaining):

R<linkif

Simple siring constarks (exec lines only) consist of text surrounded by single
gquotation marks: text'.

NOTE

The meximum Jength of any string is 255 characters.

Expanded string constants (exec lines only) consist of text and/or varisbles
surrounded by douwble quotation merks: "Text [var] text” or "Text %0 text®.
The Exec Processor places the current velue of each variable in the string
before executing the exec command.

Siring functions (exec lines only) are built-in functions or user-defined
functions that return a string value. See Section 9.2.4; compare 5oolean
runctions.

Kring expressions (exec lines only) contain one or more of the following:
simple string constants, expanded string constents, string functions, and
veariables.
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92

Boolean constards (exec lines only) are true and false.

Boolean functions (exec lines only) are built-in functions that return a
Boolean result true or false. You cannot write an exec that returns a
Boolean value.

Boolean expressions (exec lines only) are expressions that return a Boolean
result true or ralse. They can contain the following: Boolean constants,
Boolean functions, compsrisons of string expressions or nurneric expressions,
and combinations of the preceeding with logical operators. See Section
9.2.3.1, String and Nurmneric Comperisons in Boolean Expressions, for more
inforrnation.

Numeric corstants (exec lines only) are integers, not enclosed in quotes; for
example: 0, -255, 1984. Numeric constants sre permitted in numeric
expressions, where they are treated as numbers, and in string expressions,
where they sre treated as strings.

Auneric expressions (exec lines only) ere resolved erithmetically, not es
strings; they return a numeric result that cen be used only where specified in
the syntax for esch exec command. To produce & string containing the
result of a numeric expression, make the numeric expression the argument of
the EVAL function. Numeric expressions consist of numeric corstants,
string functions that yield a numeric value, variables that contain a numeric
value, and numeric operators (see Section 9.2.4.5, String Arithmetic Using the
EYAL Function).

Writing an Exec Program
This section describes all the available exec commands. These commands
are executed by the Exec Processor, before the exec run file is run.

921 Declaring snd Setting Variables

The commands described in this section tell you how to declare named
varisbles and how to change the value of & veriable.

9211 The EXEC and ENDEXEC Commands

Every exec program must begin with the EXEC command and end with the
ENDEXEC command. The EXEC command is where you identify the names
of any named veriables you use in the exec.

The first line of an exec programn has the format
EXEC (variable-declaration-list)

where (variable-declaration-list) is a list in parentheses containing varisble

names separated by commas. It is required only if you use varisble names

for perameters or internal variables (see Section 9.1.3.1, Variable Names and
Nurnbers). For example,

$exec (leapyear, debits)

9-10
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declaeres veriasbles named leapyear and debits.
The lsst line of an exec prograrn hss the formet
ENDEXEC
The last line in the exec program doesn't have to be the last line in the file.

It's possible to imbed an exec program in s Pascal progrem or another

programrning language source file by using the Imbed Processor option; see
Section 9.3.2, Processor Options, for more inforrnation.

9212 The SET and DEFAAT Commands

The SET and DEFAULT comrmands let you sssign a value to a varisble within
the exec program.

The SET cormmmand replaces the current value of a varisble with a new value;
it overrides an initial value specified in the irnvvocation perameter list. The
format of the SET cormmand is

SET variable TO string—expression

The formet of string expressions is described in Section 9.1.4, Syntax of Exec
Lines and Workshop Lines. Examples of the SET commeand follow:

$set %0 to '-backup-octé’
$set counter to '4’

The DEFAULT comrnand is executed only if the specified variable has the
null string as its value. DEFAULT does not override an initial value supplied
in the inmvocation parameter list. The format of the DEFAULT command is

DEFAULT variable TO string-expression
If execA contains these commands

$exec (vol, month, day)
$default vol to "-paraport”
$set month to "July”
$default day to "17"

and is run with this invocation parameter list
R(execA(, September, 23)
then—--after the commands ere executed--the results sre as follows:

The value of month becomes "July®
The value of vol becomes "—paraport”
The value of day becomes "Z3"

9213 The REQUEST Command

The REQUEST command prompts the user for keyboard input. Like the SET
command, the REQUEST commmand replaces the current value of the variable.

9-11
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REQUEST causes the Exec Processor to wait until [RETURN] is typed. The
format of this command is

REQUEST variable WITH string-expression
For instance,
$request %0 with "month?”

String-expression is displayed on the console as a prompt. Variable is set to
whatever value the user types in response to the prompt.

922 Input and Outpest
In addition to using the irvocation parameter list and the REQUEST
command, you can provide input to an exec program and create output from
it through the commands discussed in this section. You can

= Read a character or a line from the keyboerd or a text file (READCH
and READLN commands).

= Write to the screen or a text file (WRITE and WRITELN commands).
» Open and close a text file (RESET, REWRITE, and CLOSE commands).

= Obtain filenames from a directory (RESETCAT command and NEXTFILE
function).

= Check for successful completion of 170 (IORESULT function). Al of the
shove commands set the IQRESIAT function.

9221 The RESET, REWRITE, and CLOSE Commands
Use these exec commands when reading or writing text files. RESET opens a
file for input; REWRITE opens & file for output; CLLOSE closes an open file.
These commands set the IORESULT function, which is described in Section
9.2.25.

The format of the commands is

RESET file-id, filename
REWRITE file-id, filename
CLOSE file-id

File-id is associated with a file when the file is opened; it identifies the file
for subsequent read, write, and close commands. It is a global file identifier
that is allocated when the file is opened. 1t is desllocsted either when the
file ie closed or when the exec progream finishes running. 1t is not a string
variable and can be used only where a file identifier is expected. It does
not heve to be declared in the EXEC command. Its name follows the rules
for variable names. Its idertifier can be any number of alphanumeric
cheracters, but only the first eight characters are significant; the first
character must be alphabetic.
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Filename is any string expression that yields a valid pathnarne; it must refer
to a text file.

Here sre some examples of exec commands that open and close files:

$reset fileone, "execdata.text”
$rewrite errmsg, "-pay-afg-address.update._errs.text”
$close errmsg

92227 The READCH and READLN Commands

With the READCH snd READLN commands you can read data from the
keyboard or from a textfile and essign it to a variable. READCH reads one
character. READLN reads one line--up to and including the next [RETURNI.
These cormmmands set the IORESULT function. The format of the commands
is

READCH (file-id) variable

READLN (file-id) variable

(File-id) asscciates the read command with the pathnarne specified in the
RESET command. If (file-id) is not specified, the READCH or READLN
commmand reads from the keyboard. This causes your exec to pause until &
value for variable is typed; for READLN, the value must be followed by
[RETURN]. Wwhen reading from the keyboard, it's & good idea to prompt the
user using WRITE or WRITELN to indicete what information the exec
program is waiting for.

Variable idertifies the variable that will hold the information to be read. If
end-of-file is encountered while reading, variable is set to 'EOF'. In the
first example below, a character is read from a file into a numbered
veriable, %% in the second example, a line is read from the keyboard into a
named varisble, title

$readch (fileone) %3 {read one character from a file}
$readln title {halt/read a title from the keyboard}

9223 The WRITE and WRITELN Commands
With the WRITE and WRITELN cornmands you cen write deta to the screen
or to a textfile. WRITELN ends its output with [RETURN] and WRITE does
not; otherwise the commands ere identical. These commands set the
IORESULT function. The formeat of the commands is

WRITE (file-id) stringl, string2, ... stringN

WRITELN (file-id) stringl, string2, ... stringN
(File-id) is required only if you are writing to a textfile; it associates the
write command with the pathname specified in the REWRITE cornmand for
the same file.
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Stringl through stringN represent amy number of string expressions separated
by commas. The strings ere written consecutively--at the current cursor
location in the case of screen output, or st the current location in the file in
the case of textfile output. Here are some examples:

$write '‘Ready to stop? Type Yor N .. ' _
$uriteln (percentege) “"value of %4 is X7 X"
$writeln ‘Finished writing to file ', outfile
9224 The RESETCAT Command and NEXTFILE Function
The RESETCAT command opens an OS directory; NEXTFILE is a string
function that returrs the name of a file in the open directory. These

commands set the IORESULT function. The format of the RESETCAT
command is

RESETCAT directoryname

Directoryname is & string expression thet specifies the pathname of a
volumne, catalog, cor file; the wildcard character = may be used in the
filename part only. For instance,

$resetcat "-[vol]”
$resetcat '=_obj’

If directoryname includes & filename part but no wildcard, the filename part
is used & a prefix. In other words, RESETCAT “-{volHcatHrile]" is
equivalent to RESETCAT “{voll{cat]{file]=".

When RESETCAT is executed, the value of NEXTFILE is set to the first
pathname in the directory that meets the criterion specified in
directoryname. (ln searching a directory, NEXTFILE returns catalog names ss
well ss filenames.) In the examples shown above, after the first execution of
RESETCAT the value of NEXTFILE is ss described below:

Directoryname value of NEXTFILE
"—[vol]" -first file in [vol] directory
'=_obj' -first file with _obj suffix on

the default (prefix) volumec

Wwhen NEXTFILE is called again, it contains the name of the next file (or
catalog) in the directory thet meets the directoryname criterion. When no
such file exists, or if the directory is empty, NEXTFILE returns an empty
string. Here's an example of an exec routine that checks for a blank volume
and lists filenames:
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exec (vol, ior, savefile, count)
resetcat "—[vol]”
if ioresult <> "' then
set ior to ioresult
writeln ‘'Bad volume'
writeln ior
else
set savefile to nextfile
if savefile = " then
writeln vol, ' has an empty directory.’
else
set count to 1
while savefile <> "' do
writeln "File [count] on volume [vol] is
savefile
set count to eval(count+1)
set savefile to nextfile
endwhile
endif
endif

-
4

9225 The IORESULT Function
IORES\LT is & string function that tells you if an error occurred during s
previous RESET, REWRITE, READCH, READLN, WRITE, WRITELN,
RESETCAT, or NEXTFILE operation. If the [/O operation was successful, the
value of the IORESWLT function is an empty string. If an error occured,
JORESULT contairs an Operating System error message in the form

Error (number)>: (message>
You can display the error message &s follows:

$reset infile

$set errmsg to ioresult

$if errmsg <> '’ then
$uwriteln errmsg

$endif

This example demonstrates the need for an intermediate variable to save the
contents of IORESULT before displaying it because the WRITELN command
also sets the IORESIAT veriable.

9226 The Program Communication Buffer
Prograrns that run under the Workshop can communicate with each other by
writing and reading in & 1K-byte communicstion buffer made available by
the ProgComm unit. (See The ProgComm Unit in the third binder of this
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set)) You can open and close the communication buffer and write to or read
from it from an exec program by using the exec 170 cornmands (REWRITE,
RESET, CLOSE, READCH, READLN, WRITE, and WRITELN) with a special
keyword file identifier, COMMBUFR.

Some of the [/O commands require an &access kel that limits access to the
huffer. Access—key is a string expression.  Since several spplications can
share the buffer, programs within each application must agree upon & value
for access-key. The format of the 1/O commends for use with the program
communication buffer is

RESET COMMBUFR, access-key

REWRITE COMMBUFR, access—key

CLOSE COMMBUFR, access—Kkey

READCH (COMMBUFR) variable

READLN (COMMBUFR) variable

WRITE (COMMBUFR) stringl, string?2, ... stringN
WRITELN (COMMBUFR) stringl, string2, ... stringN

These forrnats correspond to the formats described earlier in Section 9.2.2
except for the CLOSE command, which requires an access key when used
with the communication buffer.

NOTE

Do not close COMMBUFR after a write comrnand. The communication
buffer should be closed after reading, in order to ernpty it. CLOSE
flushes the buffer for the specified access key; REWRITE flushes the
buffer unconditionally.

The following exec prograrn demonstrates communicetion buffer 1/0:

exec (key, line, ior, n, ch)
Tepeat {do one cycle of writing, then reading}
clear screen
Tequest key with 'Open CommBufr for write.. key 7 °
rewrite commbufr, key
Tequest line with ‘Write what to buffer ? '
while line ) '’ do {terminate input with empty line)
writeln (commbufr) line
request line with 'Write what ?
endwhile
writeln
repeat {try opening until we succeed}
request key with 'Open CommBufr for read.. . key 7 '
reset commbufr, key
set ior to ioresult
if ior ¢ ' then
writeln 'CommBufr open failed: ', ior
endif

9-16

7 'A"»“\



Workshop L&er's Guide

until ior =
set n to ‘1’
repeat {write out CommBurfr lines)
readln (commbufr) line
if line <) 'EDF' then
writeln 'CB(', n, '): ', line
set n to eval(n + 1)
endif
until line = 'EOF’
writeln

write 'Do you want to try another test ? (Y or [N]) °*

readch ch
until uppercase(ch) < 'Y’
halt '‘Done’
endexec

923 Conditional Statements

Exec Files

Like other programming languages, exec language allows you to execute

comrnands under some circumstances but not others.

The IF, WHILE, and

REPEAT statements described in this section ere similar to their Pascal
counterparts, but the conditions they test are examined & gprocess time not

run time.

The example that follows below and on the next page dernonstrates the use
of IF, WHILE, and REPEAT statements to prompt for a series of directories

and list their contents:

EXEC (cat, ioerr, file)
REWRITE text, ‘catlist_text'

IF JTORESULT = "' THEN {successful list file open)
REPEAT

REQUEST cat WITH ‘Search what directory?

IF cat = ‘' OR LOWERCASE(cat) = 'quit’' THEN
CLOSE text
HALT 'Done’

ENDIF

RESETCAT cat

IF IORESULT = '" THEN ({successful catalog open)

SET file to NEXTFILE
WHILE file ¢ '"' DO
WRITELN (text) file
SET file to NEXTFILE
ENDWHILE
ELSE
SET ioerr TO IORESULT

WRITELN 'Could not open ', cat

WRITELN '0S error: ', ioerr
ENDIF
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UNTIL FALSE {endless loop}
ELSE

SET ioerr TO IORESULT

WRITELN 'Could not open output file’
ENDIF
ENDEXEC

9231 String and Numeric Comparisons in Boolean Expressions
The condition tested by a conditional statement is in the form of a booclesn
expression--an expression whose velue is either true or false. The constants
true and false may also be used in boolean expressions. In the boolean
expression

uppercase( answer) = "'NO'

uppercase{answer) is a string function with its argument, = i a string
comparison operator, and 'NQ' is a string constant; the value of the
expression is true if the value of answer is any one of the following: NO, No,
nO, no.

Use the siring comparison operators in a boolean expression to compeare
string expressions:

~

{equal}

{not equal}

{oreater than}

greater than or equal}
less than}

{less than or equal}

Use the numeric compsrison operators in 8 boolean expression to compare
string expressions that yield a numeric result:

AAVNVNAL
]

fl

EQ {equal}

NE {not equal}

GT {oreater than}

GE {oreater than or equal}
LT {less then}

LE {less than ar equal}

String comparisons proceed character by character; numeric comparisons
cause two numeric values to be compared. The results may be the same
either way: COUNT = 1 (string comparison) is equivalent to COUNT EQ 1
(numeric comparison). Ususlly, however, the results are not the same. For
example, the string comparison 1006 < 309 is true (because 'l' is less than
'5"), while the coiresponding numeric caomparison 1006 L T 509 is false.
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You can use the following Jlogical operators in a boolean expression:

AND {expression is true if both terms are true .. A AND B}
OR {expression is true if either termistrue.... AOR B }
NOT {expression is true if the term is false ..___. NOT (A) }

The expression following NOT must be enclosed in parentheses. The default
sequence of evaluation of a boolean expression is left to right. You can also

use parentheses to control the sequence according to the rules of algebra
For instance,

not (R} or B {true if A is false or B is true }
not (A or B) {true if A and B are both false }

9232 The IF Statement
The IF statement lets you choose an action depending on conditions
evaluated at process time; it consists of the IF, ELSEIF, ELSE, and ENDIF
commands. Each command must begin on a new line and may occupy more
than ane line. ENDIF always ends an IF statement. ELSEIF and ELSE are
optional. More than one ELSEIF mey be present in an IF statement. Aesting
is permitted; that is, any number of IF statements can be contained within
an IF statement.

The format of the IF statement is shown below.

IF boolean—-expression THEN
Workshop and exec commands
ELSEIF boolean-expression THEN
Workshop and exec commands
ELSEIF ...
ELSE

Workshop and exec commands
ENDIF

The IF statement is evalusted in the order it appears in the exec source file.
when the first true boolean expression in an IF or ELSEIF command is
encountered, its corresponding THEN clause is selected —-that is, its
Warkshop commands are processed and placed in the exec run file, and its
exec commands are executed. If no true condition is encountered, the ELSE
Workshop and exec lines, if present, are selected. Exec lines that are not
selected are examined for correct syntax. Here is an example of an IF
statement that submits a different exec file depending on the day of the
week:
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exec (date, ledger, payroll, payable, bankbal, personnel)
if date = 'FRIDAY' then
submit endweek([ledger], [payroll])
writeln ‘Have a good weekendi'
elseif date = ™MONDAY' then
submit startwk([payable], [payroll])
else {tuesday, wednesday, thursday}
submit midweek([bankbal], [personnel])
endif
endexec

Here are the Workshop Run commands needed to run this exec file on three
different days of the week:

R<weekday(FRIDAY, —-1edger .march, —payroll _hourly)
R(weekday(MONDAY, , —payroll _exempt, —payable _march)
R<{weekday(MIDWEEK, , , , —bankbal .march, —personnel)

9.2.33 The WHILE and REPEAT Statements
The WHILE statement lets you repeat an action wfhile a condition remains
true: the condition is tested before the action is performed. The REPEAT
statement lets you repeat an action wntil & condition becomes ralse: the
condition is tested after the action is performed. The condition is in the
form of a boolean expression. Each cormnmand in a8 REPEAT or WHILE
statement must begin on a new line and may occupy more than one line.

The WHILE staternent consiste of the WHILE snd ENDWHILE commands.
ENDWHILE always ends a WHILE statement. The format of the WHILE
statement is

WHILE boolean—expression DO
Workshop and exec commands
ENDWHILE

When the boolean expression in a WHILE command is true, the Exec
Processor selects the corresponding DO clause by executing its exec
commands and placing its Waorkshop lines in the exec run file. Then the
Exec Processor reevaluates the WHILE command. If the expression is still
true, the DO clause is selected again. When the expression becomes false,
processing continues at the command following ENDWHILE. Commands that
are not selected are examined for correct syntax. Here is an example of a
WHILE statement that deletes a series of object files named fileN, fileN-1,
and so on:
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F{iler}

$while inputval > '0' do
D{elete}—[vol]-[file] [inputval].ob]
$set inputval to eval(inputval-1)

$endwhile

Q{uit}

The REPEAT statement consists of the REPEAT and UNTIL commands. The
format of the REPEAT statement is

REPEAT
Workshop and exec commands
INTIL bobnlean—expression

The example shown above for the WHILE statement can be rewritten using
the REPEAT statement.:

F{iler}
$ir inputval > "0’ then
$repeat
D{elete}—[vol]-[rile][inputval]_obj
$set inputval to eval(inputval-1)
$until inputval = 'O’
$endif
Qfuit}

9234 The EXISTS and NEWER Boolean Functions
The EXISTS function returns a value of true if the specified file, catalog,
volume, or device is online at process time; otherwise the value false is
returned. A volume or device is online if it is mounted; a file is online if it
exists on & mounted device. The forrnat of the function is

EXISTS (pathname)

Pethname is any string expression that vields a valid file, volume, or device
name. Some examples follow:

$if exists ("-slot2chanl”™) then {device}
$if exists {"—[vol]") then {volume}
$ir exists (“-paraport-%i.obj") then {file}

The NEWER function returns a value of true if the Last-Mod-Date of the
first file specified is more recent than that of the second file; otherwise the
value false is returned. Both files must be online at process time or an
error will be reported. The format of the function is

NEWER (filel, file2)

Filel and fileZ can be any string expressions that yield a valid pathname.
Some examples follow:
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$if newer ("-[fed]-taxes”, "-[state]-taxes”)
then {calc state)

$if not (newer ("-%3.0bj", "-%3_backup”)) then {backup
is current}

$if newer("[pom] .TEXT", "[pom].0BJ") then {recompile}

9.24 Built-In String Functions

A string function is a function whose result is a string (text) value. The
types of strings used in exec files are described in Section 9.1.4, Syntax of
Exec Lines and Workshop Lines. Even a function result that is a number (for
example, ORD) is returned as a string. Since the ORD, POS, LENGTH, and
EVAL functions always return a number, they may always be used in a
numeric expression even though the function result is a string. In fact, any
string function can be used in a8 numeric expression as long as it returns a
number .

Several built-in string functions are included as part of the exec language. In
addition, you can write your own functions (see Section 9.2.6.3, Calling a
User Function). The built~in string functions provided by the Exec Processor
are

CONCAT Combines strings
UPPERCASE Converts a string to uppercase
LOWERCASE Converts a string to lowercase

LENGTH Gives the length of a string

COPY Copies all or part of a string

POS Gives the position of a string within another string

CHR Translates a number into its corresponding ASCI]
tharacter

ORD Translates an ASCII character into its
corresponding number

EVAL Provides string arithmetic

RETSTR Returns the ProgComm return string.

TRIMBLANKS Trims leading and trailing blanks.
NEXTFILE Refer to Section 9.2.2.4.
IORESULT Refer to Section 9.2.2.5.

9241 The CONCAT Function

The CONCAT function lets you combine string expressions and functions to
produce a single string result. The format of the CONCAT function is

CONCAT (stringl, string2, __ stringN)
Stringl is a string expression. String2 through stringN are optional string
expressions. The function result is a string containing the string parameters

in the order they were given. Here's an example that combines two string
variables and three string constants:
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exec (vol, file, pathname)

set pathname to concat('-',vol, '-', file, ' text')

Note that you can accomplish the same result by using an expanded string
constant.:

set pathname to "-[vol]-[file].text"”

9242 The UPPERCASE and LOWERCASE Functions

The UPPERCASE function converts any lowercase letters in a string to
uppercase. The LOWERCASE function converts any uppercase letters in a
string to lowercase. Nonalphabetic characters remain unchanged. For
irstance, UPPERCASE converts ABc,dEr.3$gh to ABC,DEF.33GH. The format
of the functions is

UPPERCASE (string-expression)
LOWERCASE (string-expression)

You can save the result of the function in the same variable it converts:
$set pathname to uppercase(pathname)

You can also convert a string in order to compare it. In the following
example, the expression is true whether the value of reply is YES, yes, or
any other uppercase and lowercase combination of these three characters.

$while lowercase(reply)="ves' do

9243 The LENGTH, COPY, and POS Functions

LENGTH gives the number of cheracters in a string, COPY duplicates part or
all of a string, and POS gives the location of a substring within a string.

The LENGTH function returfs the length of a string in its function result.
(The length of a null string is '0'.) The format of the LENGTH function is

LENGTH (string-expression)
For example,

$if length(word) GT 24 then
$writeln word, ° is even lenger than
'disestablishmentarianism!’
$endif

The COPY function copies all or part of a string into the result string. The
format of the COPY function is

COPY (source, position, count)

Source is the string expression contsaining the substring (part of a string) to
be copied. Pgsition is a numeric expression indicating the place in source of
the first character to be copied; the first position in source is 1. Count is a
numeric expression indicating the number of characters to be copied. If
fewer than count characters are found at position, those that are found are

Fd
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placed in the function result. (Note that this differs from the Pascal Copy
function) If position is beyond the end of the source string, COPY returns a
null function result. The following example copies establishment out of
disestablishmentarianism:

set X8 to copy(’disestablishmentarianism’, 4, 13)

The POS function returns the position of a substring within a string. If the
substring does not appear in the string, the function result is '0'. The format
of the POS function is

POS (substring, source)

Substring and sowrce are string expressions. In the COPY example above,
vou can use the POS function if you don't know the position of establishment
in the source string:

set X7 to 'disestablishmentarianism’
set %8 to copy(%7, pos('establishment’, %7), 13))

9244 The CHR and ORD Functions
The CHR function returns a one-character string that represents the
character value of a number. The ORD function returns a string that
represents the numeric value of an ASCII character or any other character in
the Lisa's extended character set. For any character x, CHR{ORD(x)) is x.

The format of the CHR function is
CHR (numeric-expression)

Numeric-expression must result in a whole number; it is taken MOD 256,
producing an intermediate result in the range 0..255. CHR returns the
character that corresponds to the intermediate result.

You can use the CHR function to generate a nonkeyboard character. The
following example writes a BEL character:

$if ioresult<)>’'' then {there's an error}
$write chr(7) {ring bell}
$endif

The format of the ORD function is
(string-expression)

String-expression must not be an empty string, or a process-time error will
occur. If string-expression yields a string longer than one character, the
numeric value of the first character is placed in the ORD function result.

9245 String Arithmetic Using the EVAL Function
The EVAL function lets you do long-integer arithmetic. It evaluates a
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numeric expression and returns an integer value in the function result string.
The format of the function is

EVAL (numeric-expression)

Numeric-expression consists of numeric (decimal) constants, variables that
contain integer values, string functions that yield integer values (such as
LENGTH, POS, and ORD), string constants with integer values (such as '25'),
and the operators listed below. You can use parentheses to control the
sequence of operations as in algebra. The nureric operators are:

+ Addition

- Subtraction

* Multiplication
/ Division

MOD Modulo

Here is an example of an exec routine that takes a word and writes it
vertically, one character per line:

set count to length(woxd)
while count GT 0 do
writeln copy(word, 1, 1)
{write first char}
set count to eval(count-1)
{reduce count by 1}
set word to copy(word, 2, count)

{remove first char from word}
endwhile

9246 The RETSTR Function
The RETSTR function returns a string containing whsatever is currently in the
ProgComm unit's return string. The format of the RETSTR function is

RETSTR

The value of RETSTR can he set by any program that uses the ProgComm
unit's PCSetRetStr procedure. (Refer to the System Software Manuals binder
of this set for rmore information about the ProgComm unit) If you run a
program containing PCSetRetStr from an exec file, you can check the results
using the RETSTR function. For example,

exec
Iun 'comn.prog_obj'
if retstr ¢» "SUCCESS’ then
abort ‘Progrem failed_'
endexec

9247 The TRIMBLANKS Function
The TRIMBLANKS function strips leading and trailing blanks and tab
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characters from a string. The format of the TRIMBLANKS function is
TRIMBLANKS (string-expression)

925 Controlling the Screen Display
When you write to the screen with WRITE or WRITELN, the information is
displayed at the current cursor location. Three commands--GOTOXY,
CLEAR, and CURSOR--are provided to let you do custom formatting of a
screen display by moving the cursor and/or clearing the screen.

9251 The CLEAR Command
The CLEAR command erases all or part of the screen. The format of the
CLEAR command is

CLEAR option
Option is one of the following keywords:

SCREEN Clears screen, moves cursor to home position.
ENDSCREEN Clears screen from current cursor position to end.
ENDLINE Clears current line from cursor position to end.

For instance, the following exec program demonstrates the use of all three
forms of the CLEAR command, plus the GOTOXY command, to display text
on a diagonal across the screen:

exec (DisplayStr, x, vy)
clear screen
repeat
gotoxy 0,0 {move cursor to home}
clear endline {clear for input, but don't destroy
previous display}
write '>' {prompt}
readln DisplayStr {get text}
if lowercase(DisplayStr)='quit' then
halt 'Done’
else {display text on diagonal, one char at a time}
set x to 20
set v to 6
clear endscreen {leave prompt, clear display}
while DisplayStr ¢ '’ do
{display high-order char, then delete}
write copy (DisplayStr,1,1)
gset DisplayStr to copy (DisplayStr, 2, 255)
{move cursor to next point on the diagonal}
set x to eval (x+2)
set y to eval (y+1)
gotoxy x, vy
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endwhile
endif
until false
endexec

9252 The CURSOR Command
The CURSOR command lets you move the cursor relative to its current
lecation. (To move the cursor to an absolute coordinate, use the GOTOXY
command described in the next section) The only change the CURSOR
command makes to the screen display is to relocate the cursor. The format
of the CURSOR command is

CURSOR option
Option is one of the following keywords:

HOME Cursor moves to location 0,0 (upper left corner).

UP n Cursor moves n positions up from current location.
DOWN n  Cursor moves n positions down from current location.
LEFT n Cursor moves n positions left from current location.

RIGHT n  Cursor moves n pcsitions right from current location.

N is an optional numeric expression; if you don't give it a value, it defaults
to 1. Here is an exarple of the CURSOR command where the value of n is
determined by the EVAL function:

$urite X6
$cursor left eval(length(x6)-1)) {move cursor to start
of previous write}

9253 The GOTOXY Commmand
The GOTOXY command moves the cursor to the screen coordinates you
specify. (To move the cursor relative to its current position, use the
CURSOR command.) The format of the GOTOXY command is

GOTOXY x,vy

X and y are numeric expressions representing screen coordinates: x
represents the location of the cursor in the horizontal plane; y represents its
location in the vertical plane. The top left corner of the Lisa screen is
location 0,0; the lower right corner is location 79,21, If you supply a value
of x or y beyond the limit for the coordinate, the limit value will be
substituted.

If lastx and lasty represent the rightmost location and the downmost location
respectively, the following example moves the cursor to the center of the
screen:

$gotoxy lastx/2, lasty/2
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926 Calling Anather Exec Program
One exec programn can call another either as a8 weer 7wnction, which returns a
string result to its caller, or as an sxec procedurs, which does not return a
result. Although a =ingle exec program can call any number of execs as
procedures or functions, only one exec run file is generated. Mested calis
are permitted; that is, a called exec rnay in turn contain exec procedure and
function calls.

when an exec is called as a procedure by using the SUBMIT cormmmand, it
must not return a function value. The exec procedure may end by executing
its last line or by issuing 8 RETURN command with no argument.

When an exec is called as & user function it must end with a RETURN
command that returns a string result. See Section 9.2.6.3, Calling a User
Function, for more information.

In the case of both exec procedures and user functions, the Exec Processor
executes the exec lines in the called exec, processes its Workshop commands
and places them in the exec run file. The exec run file contains the output
from processing all of the input exec files.

The invocation of an exec procedure or user function specifies the pathname
of the called exec, its parameter list, and Processor options where permitted.
The Exec Processor treats the invocation as lext--as if it were in a
Workshop line. Within this text, imbedded built-in and user function calls
are not permitted. The irmvocation must be on a single line. The length of
the invocation after processing must not exceed 255 characters. The only
processing performed on the invocation is as follows:

» Process tildes.

« Substitute the current values of variables. (Named variables must be
enclosed in square brackets, as in Workshop lines.)

» Remove comments.

9.26.1 Calling an Exec Procedure with the SUBMIT Comsmand
The SUBMIT command calls an exec procedure. The Exec Processor
processes the called exec and puts its Workshop lines into the current exec
run file.

The SUBMIT command must be on a single line. The format of the SUBMIT
command is

SUBMIT exec-run-command

Exec-run—command is the invocation text and follows the rules described in
the previous section. The format of exec—run-command is

filename {invocation-parameter-list) option-list
Filename is the pathname of the exec procedure.
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Invocation-parameter-list is an optional list of initial values to be passed to
the exec procedure; the values must be separated by cormmas. If the
parameter list is empty and is followed by options or other significant text,
its place must be indicated by parentheses.

Option-list is an optional list of Processor options; only the Imbed and
Blanks options ere valid on a SUBMIT command. See Section 9.3.2 for more
information on Processor options.

Some examples of the SUBMIT command follow:

submit testexec

submit makeanyprog.text(oneprog)lI
submit noparams()B

submit endweek ([ledger], [payroll])

9262 The RETURN Command
The RETURN command tells the Exec Processor to resume processing the
calling exec. In a user function, the RETURN command must be the last
commeand executed. The format of the RETURN command is

RETURN function-value

Function—value is a string expression that contains the value returned by the
called exec. If the called exec is a user function, function—value is required;
if the called exec is a procedure, function—value is not permitted. Here are
some examples of valid RETURN commands:

$return
$return "The data is %5_°
$return ‘done'

An exec procedure needs a RETURN command only if the exec procedure
does not end by executing the ENDEXEC command. In the exec procedure
shown below, the RETURN command terminates an endless loop:

EXEC
WHILE TRUE DO

IF <(condition)> THEN
RETURN
ENDIF
ENDWHILE
ENDEXEC

9263 Calling a User Function
A user function is a user-written exec program that returns a string value
using the RETURN command. You can call a user function from another
exec wherever you would use a string expression. If the user function
contains Warkshop lines, including comment lines, they will be processed and
placed in the exec run file.
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The format of a user function invocsation is
{ filename (invocation-parameter—list)

where ¢ tells the Exec Processor to process a user function. Filename ic the
pathname of the user function exec file. Invocation-parameter-list is
opticnal and follows the rules for the exec-run-command (see Section 9.2.6.1).
For instance,

$while <-taxes—quarter() > '0' do

Here is an example of a user function, GETDATA, that returns data to the
calling exec each time the function is invoked; when no more data can be
read, GETDATA returns the string value 'done’ in its function result. The
function contains two RETURN commands; one or the other is executed as
the lest command. The count variable is set by the calling exec.

exec (count, data) {GETDATA}
if count eq 1 then {open datafile}
reset indata, data.text

endif

read (indata) data

if ioresult = ‘" then
return data

else

close indata
return ‘'done’
endif
endexec

The routine below is from an exec program that calls the GETDATA function.
(This routine does not use the same dollar-sign convention ss GETDATA)

$exec (counter, reply)

$set counter to '1°
$set reply to <getdata([counter])
$while reply <> 'done’
$writeln '#°,count,’ = ", reply
$set counter to eval(counter+1)
$set reply to <(getdata([counter])
$endwhile
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927 Commands that Control the Exec Processor
There are four exec commands that affect the running of the Exec Processor:

« HALT tells the Exec Processor to stop processing and run the exec run
file created thus far.

= ABORT tells the Exec Processor to stop processing without running the
exec run file.

= RUN tells the EXEC Processor to run a prograrn and then resume
processing the exec file.

= DOIT tells the Exec Processor to run the current contents of the exec
run file and then resume processing the exec file.

9271 The HALT and ABORT Commands
The HALT command tells the Exec Processor to stop processing the exec
source file and run the exec run file in its present state. The ABORT
command terminates processing without running the exec run file. With
either command you can display a8 message. The format of the commands is

HALT string-expression
ABORT string—expression

String-expression is optional; if present, the contents are displayed on the
console. For instance,

$halt 'Processing stopped at program #3°
ABORT "Incorrect date [INDATE] in parameter list”

9272 The Exec RUN and ENDRUN Cormmands
The exec RUN commeand is & command within an exec program--it is not the
same as the Workshop Run cornmeand. The format of the exec RUN
commeand is

RUN filename

Filename is a string expression resulting in the psthname of & program you
want to run gwring exec processing when the Exec Program finds the RUN
command, it suspends processing of the exec source file and runs the
program; then it resumes processing; for example,

$if day = ‘1" then
$run '-monthly-firstday_obj"
$endif

The ENDRUN command is required only if you want to supply input data to
the program narned in the RUN command. In this case, you must also
specify the INPUT keyword in the RUN commmand as follows:

RUN filename INPUT
input lines
ENDRUN
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The input lines between RUN and ENDRUN sre placed in a temporary file
and have no effect on the exec run file.

The Generste Processor option disables the exec RUN command.

9273 The DOIT Command
In a simple exec program without DOIT cornmands, all of the exec cornmands

are executed (by the Exec Processor) before any Workshop lines ere executed.
The DOIT command allows the execution of Workshop lines to be interleaved
with the execution of exec commands. The format of the DOIT command is

DOIT

Wwhen the Exec Processor finds the DOIT command, the following actions are
taken:

1. Processing of the exec source file is suspended.

2. The current contents of the exec run file are run by the
Workshop.

3. The contents of the exec run file are erased, and a new exec run
file is started.

4. Processing of the exec source file resumes &t the point where it
was suspended.

These actions occur even if you sre stepping through the exec source file
using the Step option. However, the Generate option disables the DOIT
command. (For more information see Section 9.3.2, Processor Options.)

You can use the DOIT command to display run-time messages &s Workshop
lines sre executed. If the DOIT command is omitted from the following
example, the "Backup completed" message will be displasyed before the
backup actually takes place:

exec (fromVol, toVol)
writeln 'Now starting backup...
$rF{iler}B{ackup}[fromv¥ol]-=, [toYol]-$
$0{uit the Filer}
DOIT
writeln 'Backup of ', fromvol, ' to ', toVol,
' completed.’

endexec

93 Ruming an Exec Program
Exec programs are run under the main command line using the Workshop Run
command. The Run comrnand calls in the Exec Processor to read your exec
source file, execute its exec commands, and create an exec run file
containing only Workshop lines. The Workshop then runs the exec run file,
which is sutomatically deleted at the end of the run unless you specified the
Keep Processor option.
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When a8 Workshop Run comrnand is used to invoke an exec from within
another exec, the result is chsining. The difference between submitting an
exec procedure (see Section 9.2.6) and chaining is that an exec procedure is
processed before any Workshop commands are executed; a chained exec is
processed after all of the Workshop comrnands in the chaining exec have
heen executed. See Section 9.4.1, Exec File Chaining, for more information.

931 The Warkshop Run Commaend
The format of the Workshop Run command that invokes the Exec Processor
is

R{exec—-run-command
or
REXEC/exec—run—command

The format, of the exec-run—-command invocstion (also discussed in Section
9.2.6.1) is

filename (invocation-parameter~list) option-list
For example,

r{testexec

T <(noparams()sb
Texec/—upper—compile(-lower-testprog)i

Filename is the pathnarne of the exec program you want to run. An
extension of TEXT is essumed unless you override the extension by sdding a
period at the end of filename. For exarnple,

You type The Warkshop looks for
abc abc_text

abc_xyz abc_xyz _text

abe. abc

Invocation—perameter-list is an optional list of initial values for parameters;
it present, it is enclosed in parentheses. It can be empty, or it can include
up to 20 perameter values seperated by commas. Omitted parameters are
specified by commeas; for example (10, May). If a parameter is not
specified, its value is an empty string (' ').

Option-list refers to the options described below.

932 Processor Options
You can modify the Exec Processor's operation by specifying one or rmore
single-letter Processor options following the invocation parameter list.
Processor options allow you to tailor the processing of your exec

* By controlling the way spaces are handled--Blanks option.

« By proceeding even if errors are encountered while running--Error
option.
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= By processing the exec file without running it--Generate option.
= By imbedding your exec in & source file--Imbed option.
= By saving the exec run file that is normally deleted--Keep option.

= By stepping through an exec source file, selectively including Workshop
lines for its exec run file--Step option.

« By running from a previously saved run file--Rerun option.

To request an option, type the option letter after the exec parameter list.
Include an empty parameter list if you want to specify options hut not
perameters. For example,

R(firstexec(apples, , oranges)BE {Blanks, Errors}
REXEC/anotherexec(9, 17,7, 23)S  {Step}
$submit lastexec()i {Imbed}

The default condition for all options is thet they are not in effect unless
specified. Most Processor options ere giobal--they apply to the exec on
which they're specified and also to any execs it calls; they are therefore not
permitted on a SUBMIT command invocation. The two exceptions are the
Blanks and Imbed options, which are local and are permitted with SUBMIT.
You may not specify Processor options when inmvoking a user function.

B 7he Blanks option tells the Exec Processor not to remove leading and
trailing blanks from the Workshop lines it places in the exec run file.
Leading blanks result from indenting lines to improve exec readability.
{Leading and trailing blanks sre not significant to Workshop programs, but
they might be significant to other programs you run under the Exec
Processor.)

E 7he Errors option tells the Exec Processor to continue processing even if
errors are encountered that would normally stop exec file execution. This
option is useful for forcing the completion of a test series.

G The Generate gption tells the Exec Processor to generate an exec run file
without running it. Syntax errors are flagged. The DOIT and RUN
comrnands ere disabled. By specifying the Keep option with the Generate
option, you can retain the exec run file and examine or maodify it using
the Workshop Editor. If K is not specified, the exec run file is deleted.

1 7he Imbed option tells the Exec Processor to ignore the first line of the
exec file because the exec is imbedded in a source program. For
instance, the exec file can also be the source file for the Pascal
Compiler. To use this technigue, begin the first line of the exec file with
the Pascal comment delimiter (* and follow the ENDEXEC command with
the Pascal comment delimiter *); then begin the source program.

9-34

e,



Workshop Leer's Guide Exec Files

Irnbedding works with any language that allows you to extend & comment
over more than one ling, including exec language. Here is a Pascal
source program in file -Pascal prog.text that contains an imbedded exec
program:

(* This Pascal program compiles itself!
$exec {Pascaltest}

P{ascal Compile}Pascaltest
Pascaltest list

Pascaltest _obj

$endexec

*)

PROGRAM Pascaltest;

USES _ ..

TYPE. ..

VAR ..

BEGIN. ..

END.

To compile this program, simply type the following Warkshop Run comrnand:
R<Pascaltest()I

K 7he Keep option tells the Exec Processor not to delete the exec run file
after the Workshop runs it. You may then rerun the file using the R
option.

R 7he Rerun gption tells the Exec Processor to run a previously processed
exec run file that was saved using the K option. This option overrides all
other options.

S 7he Slep oplion puts the Exec Processor in Step mode so that it displaeys
the exec run file one line at a time, prompting you for selective skipping
of output lines and SUBMIT cormmands. Specify the Keep option also if
vou want to keep the exec run file. This option is further described
helow.

933 Using the Step Option

With the Step option, the Exec Processor processes the exec source file one
line at a time and prompts you for a decision:

<= Include ? for a Workshop line.
<= Submit ? for a SUBMIT command line.

When you first enter Step mode, you can get an explanation of the possible
responses by answering Y to the Mare details ? prompt. You can also get
help by answering ? to the decision prompts. The responses are:

Y Include the Workshop line or submitted exec program in the exec
run file.

N Omit the line or submitted exec program.
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Raiaa'

S Step through the submitted exec (with Submit ? only).
Abort processing; the exec run file is nat run.

D

K Keep the remaining lines of the exec source file as is (process
exec lines, include Workshop lines without further prompting), and
run the exec run file.

I lgnore the remainder of the exec source file, keep previously
included Workshop lines, and run the exec run file.

You can use the Step option to skip over the first portion of an exec
file--for instance, when debugging a series of programs. Step through the
exec that runs the series, responding with N to eliminate the programs that
ran successfully. Then when you get to the program that failed and has been
corrected, respond with K to generste the exec run file with only the
remaining programs in it.

You can alsc select sepsrate sections or modules of a large applicstion. In

this case you can use Step mode most essily if you place each module in a
separste exec file, as in the following high-level exec file called RUNALL

which runs modules A, B, C, D, and E:

exec {RUNALL}
submit Aexec
submit Bexec
submit Cexec
submit Dexec
subnit Eexec

endexec

To select only modules B and D, invoke RUNALL in Step mode. If you want
to keep the exec run file so that you can run it again without going through
the selection process, specify the Keep option ss well as the Step option:

r<runall()sk

Your dialog with the Exec Processor in Step mode as you select Bexec and
Dexec for runining is shown below, with your responses in italics:

Step Hode:
—— in response to “Include ?" answer:
Y, N, A (RAbort), K (Keep rest), or I (Ignore rest).
—— in response to "Submit ?" answer:
Y, N, S (Step), A (Abort), K (Keep rest), or 1
(Ignore rest).
More details ? (Y or N} [No]
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submit Aexec {= Submit ? N
submit Bexec {(=Submit ? Y
submit Cexec {=Submit ? N
submit Dexec {=Submit ? Y
submit Eexec {= Submit ?
NOTE

If the exec you are stepping through conteins & DOIT command, the
contents of the exec run file are executed when the DOIT line is
encountered (unless it's in the false part of & conditional statement);
then you are returned to stepping.

934 The File Cache and the Input Buffer
The Exec Processor uses a file cache for improved performance. If you need
to optimize the performance of an exec program that calls exec procedures
and user functions, understanding the file cache can help you.

The Zile ceche consists of Tive pages (a page is two blocks) that can contain
five srnall files st a time in mernory. A smaif file has a listed size of four
hlocks--saccording to the File Manager's List cormmand--and contains one
header page and one page of text. If an exec procedure or user function is
called repesatedly--within the range of & WHILE staternent, for example—-it
should be a small file so that it can be read from memcry rather than from
disk.

Small files that are accessed by a SUBMIT command or & function call ere
placed in the cache. Subsequent access to these files is made from the
cache rather than from disk. The cache is maintained on a
lesst-recently-used basis. That is, once the cache is full, the file least used
recently is the one whose space is relinquished for a new small file.

If your exec modifies itself and then calls itself (and we don't recornmend
this), the modified version won't execute if the previous version is still in
the cache. To avoid this problem, make the self-modifying exec lerger than
four blocks.

The inpit bwfver is the area in mernory where large exec: files sre read. If
one large file is called repesatedly by & second large file, both files must be
read frorn disk each time through the loop. To optimize perforrnance,
modularize the large files so that at lesst one file can be accessed from the
cache.

94 Sample Exec Programs
The following sections contain a series of actual exec programs that
demonstrate some useful techniques like chaining and recursive calls.
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941 Exec File Chaining

Chaining takes place when the Workshop Run command is used from wilhin
an exec: the Workshop is executing the current exec run file--the chaining
exec program--when it encounters a Workshop Run command; it then closes
the current exec run file and imvokes the Exec Processor to begin processing
the new exec source file named in the Workshop Run command--the chained
exec program. The chaining exec is nof returned to for further processing;
the Workshop Run comrnand is effectively its last command. In the example
illustrated by Figure 9-2 below, exec prograrn A invokes exec program B by
meeans of the Workshop Run comrnend. Exec run file A is executed. Its last
command is

R<(ExecB_text

The Workshop then returns control to the Exec Processor, which processes
exec source file B and gives its exec run file to the Workshop to run.

Figure 9-2. Chaining Exec Flies

Here is a set of four exec files that demonstrates the use of exec file
chaining, using Pascal compiles as an example.

=« COMP perforrns & basic Pascal compile.

« COMPIF submits COMP only if the object file does not already exist or
if the source file is newer than the object file.

= LINKIF links the three units if any of them was changed since the last
link.

= COMPLINKIF, the calling exec, submits COMPIF for three separate
Pascal units--conditionally compiling them--and then chains to LINKIF.

The COMP exec program follows:

EEC (unit, objname) {*** COMP *** Pascal compile
unit: source to compile
objname: alternate name for object file }
DEFAULT objname TO unit {if no alternate name use source name}
$P{Pascal compile} [unit]
${no list file}
$[objname] {object file}
ENDEXEL

The COMPIF exec program follows:
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EXEC (unit, objname) {*** COMPIF *** conditional compile
unit: source to compile
objname: name of 0B) file
DEFALLT objname TO unit {if no alternate name use source name}
IF EXISTS (" [objname] .obj") THEN
IF NEWER (" [unit].text”, "[objname] .obj")
THEN {recompile if source newer than object)
SUBMIT comp([unit], [objname])
ENDIF
ELSE { object file does not exist, so generate it }
SUBMIT comp( [unit], [objname])
ENDIF
ENDEXELC

The LINKIF exec program follows:

BEXEC  {*** LINKIF *** Link the object modules into a
new executable progrem if any
of them was recompiled.}

IF NEWER ('unitl.obj’, 'program.obj')
OR MEWER (‘unitZ_obj', ‘'program.obj’)
OR NEMER (‘'unit3.obj', 'program.obj‘') THEN
$L{ink}unit1
$unit2
$unit3
$iospaslib
${end of input}
${no list file}
$program{executable output file)
ENDIF

ENDEXEC

The COMPLINKIF exec program follows:

EXEC (unitl, unit2, unit3) {*** "COMPLINKIF" *** compile
if necessary, then chain to
link}

SUBMIT compif([unitl])

SUBMIT compif([unit2])

SUBMIT compif([unit3])

FRLINKIF { Chain to link exec file after compiles
have Tun so that LINKIF exec gets the
correct file dates. Note the
diffe.'{ence between process time and run
time.
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Here's what happens when COMPLINKIF is run:

1. COMPIF is invoked for unitl. If unitl needs to be compiled,
COMP is subrnitted and the wWorkshop lines Tor the compile
are placed in the exec run file.

2. In the same way, COMPIF is invoked for unit2 and unit3,
until the exec run file contains sll of the commands necessary
to cornpile any unit that requires it. The Workshop then runs
the exec run file.

3. When the Workshop finds the comrmand to Run the LINKIF
exec, it calls on the Exec Processor to start a new exec run
file. LINKIF now has svailable the dates of the most recent
compiles. If LINKIF were submitted rather than chained to,
the compiles would execute a7ter LINKIF compared dates.
(But vou could accomplish the same effect ss chaining by
adding a DOIT comrnand to force the compiles and then
submitting LINKIF.)

4. The Workshop gives control back to the Exec Processor to
process LINKIF, which creates a new exec run file containing
commands for the Linker.

942 A Recursive Exec Program
The RCOMP exec perfarms up to ten Pascal compiles, using the COMP exec
described in the previous section. RCOMP takes an srgument list with the
names of the units to be compiled.

EXELC { RCOMP — pexrform any number (up to 10) Pascal compiles.
It calls COMP on its first argument and then calls itself
recursively with its arguments shifted left )
IF 20 ¢ "' THEN
SUBMIT comp(%0) { "comp™ the first one }
{ "rcomp™ the rest, less first }
SUBMIT rcomp(X1, %2, %3, %4, X5, %6, X7, %8, X9)
ENDIF
ENDEXEL

943 A Recursive User Function
The GETPROFLOC exec is a function that prompts the user for the location
of & ProFile and returns a string with the name of the device to which the
ProFile is sttached. The function calls itself recursively until a valid device
name is specified.

EXEC (plLoc) {***GETPROFLOC*** prompt user for Profile location }
REQUEST ploc WITH
'Where is the ProFile attached (parapart/slot2chanl/slot2chan2)’
SET ploc TO UPPERCASE (plLoc)
IF (ploc > 'PARAPORT') AND (pLoc <> "SLOTZ2CHANL')
AND (ploc () "SLOT2CHANZ') THEN
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WRITELN 'That is not 8 valid device neme. let''s try sgain. '
RETURN <GetProflLoc { recursive function call }
ELSE
RETURN pLoc
ENDIF
ENDEXEL

944 An Exec Application
The application listed below verifies the contents of a disk: CHECK lists
missing files, and CHECK?Z2 lists extraneous files. The disk to be verified is
compared against GoodListFile, a text file containing the list of valid files,
one per line. The applicstion consists of two main execs (CHECK and
CHECK2), a user function (DEVNAME), and an exec procedure
(CHKIORESULT). Both main exec programs call the DEVNAME function to
format device names and the CHKIORESULT procedure to handle 1/0 errors.

The DEYNAME user function follows:

EXEC (Deviame, DevDefault) { DEVNAME function returns device
name with leading '-' )

DEFANLT DevName TD DevDefault

IF COPY (DevName, 1, 1) <> '-' THEN

SET Devhame TO CONCAT ('-’, DevName)

ENDIF

RETURN Deviame

ENDEXEC

s

The CHKIORESULT exec procedure follows:

EXEC (ExrorMsg, I0Res) { CHKIORESULT will ebort if we get an
IORESILT error; sounds bell and prints message )
IF IORESULT <> "' THEN
SET I0Res TO IG}QESULT { so WRITEs below will not change its
value
WRITELN CHR(7), ExTortisg
WRITELN I0Res
ABORT 'Bye’
ENDIF
ENDEXEC
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The CHECK exec program follows:

EXEC (GoodListFile, CheckVol, FileNeme)

{ CHECK looks for miseing files on CheckVol; GoodlListFile is a
text file containing an alphabetical list of the
files that should be on CheckVol, one file name per
line. }

DEFALT GoodListFile TO 'GoodFileList Text'

SET CheckVYol TO <deviName( [CheckVol ], —YVOL)

{ check for missing files }

RESET GoodfFile, GoodlistFile

SUBMIT chkIOResult(Could not open [GoodListFile])

WRTTELN 'Check of ', CheckVol, ' against GoodlListFile (',
GoodListFile, ')'

WRITELN

REPEAT { get file name and see if file exists on CheckVol }
READIN (Goodfile) FileNeme
IF FileName <> 'EDF' THEN
IF NOT (EXISTS ("[CheckVol]-[FileName]™)) THEN
WRITELN CHR(7), ‘Missing file: ', FileName
ENDIF
ENDIF
UNTIL FileNeme = 'EOF’
CLOSE Goodfile
ENDEXEC

The CHECK2 exec program follows:

EXEC (GoodListFile, CheckVol, GoodName, FileName, LastGoodName)

{ CHECK2 looks for extraneous files on CheckVol; GoodListFile
should be the name of a text file with an
alphabetized list of the files that should be
present, one file name per line. }

{ Note: this will not work if the volume being checked has
sub-catelogs, since the Names command will not

return the full pathnames for files within the
catalogs. }

DEFAULT GoodListFile TO ‘GoodFilelList Text'

SET CheckVol TO (devName( [CheckVol], -MYVOL)

{ get the names of the files on CheckVol }

$F {i1e-Mgr )N{ emes] [CheckVol ]-=, CHECK . TMP _TEXT

$0{quit)}

DOIT { execute File-Mgr commands to create list of files in
CHECK _THP _TEXT }
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RESET Nemefile, 'CHECK . TMP.TEXT'

SUBMIT ChkIOResult(Could not open CHECK . TMP.TEXT)

READILN [NmeFile)}FileNme {ignore 3 title lines from Names
cmnd

READLN (NameFile) FileName

READIN (NameFile) FileNeme

RESET GoodfFile, GoodlListFile

SUBMIT chkIOResult(Cound not open [GoodListFile])

SET LastGoodName TO ‘A’ { alphabetically first }

READLN (GoodFile) GoodName { prime the pumps }

READIN (Namefile) FileName

REPEAT
SET GoodName TO UPPERCASE (GoodNeme)
SET FileName TO UPPERCASE (FileNeme)
IF (GoodNeme < LastGoodName) AND (GoodName <> 'EDF') THEN
WRITELN CHR(7), GoodNeme, ° is not alphabetical in *
GoodListFile
ABORT ‘Bye’
ENDIF
SET LastGoodName TO GoodName
IF (GoodName = 'EDF') AND (FileName = 'EDF') THEN
HALT ‘Done’
ELSEIF GoodName = 'EOF' THEN
WHILE FileName <> 'EDF' DO
WRITELN CHR(7), 'Extra file: ', FileNeme
READIN (NameFile) FileNome
ENDWHILE
HALT ‘Done’
ELSEIF FileNeme = 'EDF' THEN { missing files will be
detected by other test }
HALT 'Done’
ELSEIF FileNeme = GoodName THEN
READLN (GoodfFile) GoodNeme
READLN (Nemefile) FileName
ELSE { mismatch — list extra files & resynchronize }
IF GoodNeme < FileName THEN {missing files)
REPEAT
READLN (GoodFile) GoodNeme
SET GoodName to UPPERCASE (GoodName)
UNTIL (GoodNeme )= FileName) NR (GoodName = 'EDF')
ENDIF
IF GoodNeme <) FileName THEN
REPEAT
WRITELN CHR(7), 'Extra file: ', FileName
IF FileName ( GoodName THEN
READLN (NemeFile) FileName

-
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SET FileName TO UPPERCASE (FileName)
ENDIF
UNTIL (FileNsme >= GoodName) OR (FileName = 'EDF')
ENDIF
IF FileNeme = GoodName THEN
READIN (NemeFile) FileNeme
ENDIF
READIN (GoodFile) GoodName
ENDIF
UNTIL FALSE
ENDEXELC

95 Exec File Brrars
The Exec Processor reports syntax errors, /0O errors, and other process-time
errors; it also reports errors resulting from Operating System calls. The
formsat in which the Exec Processor reports errors is:

ERROR in <{error location}
(curremt line)
{error marker)

{EeITOr Message)
where

{error locationy is either 'invocation line' or 'line 2<n> of file
{filey'.

(current line) is the text of the exec line in which the error was
detected.

{error marker> is a question mark indicating the place in <(curremt
line> where the error was detected.

<error message) is one of the messages listed below. The error
message begins with an error number.

951 Symtax Errors
The line containing the syntax error does not conform to the rules of the
exec language. Check to see that you have typed the line correctly; refer to
Section 9.14, Syntax of Exec Lines and Workshop Lines, and to descriptions
of the individual commands end options for more information.

More than 20 parameters on exec procedure/function call
No closing ) found

End of Exec file before ENDEXEC

No Exec file specified

End of Exec file in comment

Irvalid percent: not "8n" form

Garbage at end of command

File does not begin with EXEC

No argument to SUBMIT

QO W~ BN =

(=
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ELSE, ELSEIF or ENDIF not in IF
ELSEIF after ELSE
Nothing following ™
EXEC command other than at start of file
More than 20 variables declared
ENDWHILE riot in WHILE
Duplicate parameter/variable namme
Bad number. Numeric constent expected
Nurnber too large
ORD requires a string srgument of at least one character
UNTIL not in REPEAT
Bad Number for first argurment to numeric comparison
Nurnbher too large for first argument to nurneric comparison
End of Exec file in RUN command input
Bad Number. String expression with nurneric result expected
Invalid command. <token> expected.
<{token> is one of the following:
String value
Numeric value
Nurmber
String expression with numeric result
Boolean value
Parameter name
Parameter/variable
String compere operator
L 97
Comma (list delimiter)
Command
Terminating string delimiter
Yalid command keyword

(

)

IIENDIFII

"ENDWHILE"

"UNTIL"

Catalog specification

File ldentifier

Cleer command (Screen, EndScreen EndLine)
Cursor cornmand (Home, Up, Down, Right, Left)
Program name
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252 1/0 BErroes

The 170 error reported by the Exec Processor is followed by an additional
line with the text of the corresponding Operating System error message.

201
202
203
204
205
211

Uneble to open input file "<file)"
Unable to open exec run file "(file>"
Unable to access file "<file»"
Unsble to rerun file "<file>"

Unsble to reread file "<file>"

Unable to reopen input file "<file)>"
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953 Other Exec Errors

Line buffer overflow (> 255 chars)

Out of memory. Exec processing aborted

No value returned from file called as function
RETURN with value in file not called as function
Bad Nurnber. String expression with nurneric result expected
Number returned by string expression is too large
File variable "<id>" already in use

File variable "<id»" is undefined

File variable "<id>»" is not open for input

File variable "<id»" is not open for output

Bad exec run file name generated: "<file>"
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The Transfer Program

10.1 Introduction

The Transfer program is a data communications utility that supports the
transfer of text between your Lisa and another computer that we'll call the
remote computer. The Transfer progrem can send text from a file to the
remote computer. It can also act as a terminal emulator: Everything you
type on the Lisa keyboard is transmitted to the remote computer. Text
received by your Lisa can be stored in a standard text file that you can read
using the Warkshop Editor.

10.2 Hardware Comnection and Software Configuration

Before you can use the Trensfer program you must establish a physical
connection between your Lisa and the remote computer. Then, in order to
transfer data properly from one computer to another, you must set certain
data communications characteristics on the Lisa to match the remote
computer. Establishing this software connection is known as comfiguration

It you want to connect the Lisa lo the remote computer by telephone. attach

a modem to your phone jack and to the Serial A or Serial B connector on the
pack of the Lisa

Ir you want to connect the Lisa directly to the remote cormputer, connect a
modem eliminator cable to an R5232 cable; attach the modem eliminator end
of the cable to a serial port on the remote computer; attach the R5232 end
of the cable to the Serial A or Serial B connector on the back of the Lisa

To configure the Workshop soitweare. let the Workshop know what's connected
to the serial ports by selecting the Preferences tool from the Systemn
Manager commend line and using the Device Connections menu to set either
Serial A or Serial B to Remote Computer.

To configure the ITransfer program software ot the beginning of a transfer,
choose a value fram each of the following menus (described in detail in the
next section):

» Baud Rate The speed at which data is transferred. Ten baud represents
about one character per second; for example, 300 baud is equivalent to
30 cps.

* Parity The “insurance policy" that ensures the valid transmission of
data.

s Handshake The hardware or software mechanism for synchronizing data
transmission.
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* Duplex The type of information flow between the Lisa and the remote
computer.

« Connectar The serial port you plan to use (A or B).

To control transmission while the transfer session is in progress, use the
Control menu:

= Control Start or stop receiving or sending dats; filter out control
characters; increase transfer speed by suppressing text display;
set line delay; exit from the Transfer program.

NOTE

When the Workshop shell is initialized, all serial ports ere configured as
follows: 9600 baud, DTR handshake, autornatic linefeed insertion. When
vou leave the Transfer program, these defaults are automatically
restored.

103 Setting Transfer Program Characteristics
In order to communicate with a remote computer, the Transfer program
menus must be set so that the Lisa transmits and receives data in the same
way as the remote computer. If you are dialing a service on a mainframe
computer, use the settings specified in the mainframe computer manual. If
you are connecting your Lisa to another Lisa, make sure that both Lisas are
set to the same characteristics.

Each menu has a defawlt setting that is in effect when you start the
Workshop. To change the default, open the menu and click on the setting
you want. When you exit from the Transfer program, the Workshop saves the
last settings you used: In other words, you automatically create your own
customn default settings that last until you change them.

1031 The Connectar Menu
This menu allows you to specify which serial port you will use to connect
your Lisa to the remote computer. (You can only use a connector if it is
specified in the Preferences menu.) The default is Serial A. For more
informeation on the serial connectors, see the Hardware chapter in the Lisa 2
Chwner's Guide.

v'Serial A
Serial B
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1032 The Baud Rate Menu

Baud rate is the speed at which data is transmitted to or from the remote
computer. The baud rate must be set to agree with the remote computer
and modem you are using. The default is 1200 baud. Yalid baud rate
settings for the serial ports are shown in the “PortConfig" section of the
Utilities chapter. Note that 3600, 7200, and 19200 baud are not available on
Serial A.

On telephone-line connections, the faster the baud rate, the less reliability

the data will have. If you are getting garbled transmission or missing data,
you might need to use a lower baud rate (but remember to synchronize with
the remote computer). Standard rates for transmission over telephone lines

are 300 baud and 1200 baud.
Baud Rate

50
75
110
134.5
150
200
300
600
v'1200
1800
2000
2400
3600
4800
9600
19200
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10.33 The Parity Menu

Data transmission between computers can be unreliable because of pops,
clicks, crosstalk, and noise on telephone lines; hard-wired lines are also
subject to interference and weak signals. Farity error detection is the most
common method of detecting data communicetions errors. This method does
not caorrect errors; it merely points them out--the Transfer program displays
characters with bad parity as highlighted question marks.

Parity error detection depends on the fact that the ASCII character set
requires only seven bits of an eight-bit byte to encode the standard 128
characters. The eighth bit, known es the parity: bif, can be set to make each
character transmitted contain either an even number of 1-bits fewven parityi
or an odd number (odd parity:l If a bit in a character is inadvertently
changed during transmission, the number of 1-bits will not match parity and
the byte will be highlighted as an error. (Note that this method can detect
only an odd number of bit changes in a character. If two, four, or six bits
change, parity checking will not detect an error. This means that perity
checking works best with relatively reliable lines.)

Parity should be set to agree with the remote computer. The parity choices
provided by the Transfer program are Even, Odd, or None. The default is
None. If you are sending or receiving characters from the extended
cheracter set, choose None (see Section 10.4.2, Transmitting Special
Characters, for more information).

Parity
v NOne
Even

Odd

10.3_.4 The Handshoke Menu

Handshaking is the exchange of predetermined signals between two computers
in order to synchronize transmission. The Handshake menu allows you to
select XON/XOFF (a softwere handsheke), DTR (a herdware handshake), or
None. The default is None.

XON/XOFF is a software protocol for use with a modem or a modem
eliminator. It allows the transfer of a continuous string of characters,
pausing only when the receiving buffer is nearly full. Using this protocol,
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the Lisa can stop transmission from the remote computer by sending XOFF
and start it again by sending XON; likewise, the remote computer can start
and stop transmission from the Transfer program by sending XON and XOFF
to the Lisa.

NOTE

If you use XON/XOFF and the information transmitted includes an XON
or XOFF, the transmission will halt and the Lisa will time out. The
XON and XOFF characters are the same as the ASCII Control-@ ($11)
and Control-$ ($13) characters.

DTR (Data Terminal Ready) is a hardware handshake for use with a modem
eliminator cable or modem. The RS232 handshake lines associated with
serial ports A and B are monitored for control signals that suspend or allow
transmission of characters. This arrangement works well if you are
connecting your Lisa to another Lisa.

If you get error message 647, the Transfer program failed to receive the
appropriate handshake from the remote computer after s timeout. The
session terminates. Before retrying, make sure that the characteristics
settings for the Lisa are in agreement with those of the remote computer.

Handshake.
v'None
XOn/XO0Ff
DTR

1035 The Duplex Menu
This menu allows you to select Full or Half duplex. Maost remote computer
connections are made using full duplex mode. The default is Full duplex.
Full duplex transmission allows information to flow in both directions at
once; both the Lisa and the remote computer can sehnd and receive
information simulteneously. Half duplex transmission allows information to
flow in only one direction at a time; when the Lisa is sending, the remote
computer can only receive, and vice versa

In full duplex mode, the characters you type are sent but not displayed on
the Lisa screen. (Characters received from the remote computer are
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displayed.) Normally in full duplex mode the remote computer sends back
the characters you type so that you can see them on the screen; this is
known as echoing.

In half duplex mode, the characters you type are both sent and displayed.
Normally the remote computer does not echo in half duplex mode. If it
does, you'll see two characters for each one you type.

Duplex
vFull
Half

104 Uking the Transfer Program
Start the Trarsfer prograrn by typing 7 in response to the Workshop
comrnand line. Then use the characteristics menus described in Section 10.3
to configure the Lisa so that it matches the remote computer you warnt to
communicate with. The Transfer program begins in terminal emulation mode:
Whatever you type on one computer is received on the other computer. To

send from & file or receive to a file, select the appropriate options from the
Control menu.

1041 The Control Menu
The Control Menu allows you to control transmission by receiving, sending, or
exiting from the Transfer program. Some of the menu items in the Control
menu are t{oggles: selecting a toggle item turns it on, selecting the sarne
item again turns it off, and so forth. The toggle items are Receive From
Remote, Suppress Text Displey, and Transfer to Remote. The item is on if it
has a checkmark next to it.

The Suppress Text Display option applies to either sending or receiving.
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v'Receive from remote ...

Receive Rll Text
Receive Filtered Text

Suppress Text Display

Transfer to remote ...
Line Delay

Exit

104.1.1 Receiving Text
When the Transfer program starts, you are able to receive text from the
remote computer in terminal emulation mode. The first item on the Control
menu, Receive From Remote, lets you specify a file in which to save the
text sent by the remote computer. When you select Receive From Remote,
the following message appears.

Mg ago ] Connector Baud Rate Parity Handshake Duplex

A Write to Filename [.text]?

Type the name of the file you want to save the transmitted data in. It must
be a text file.

Two options ere associated with Receive From Remote. You must choose
one of them; Receive Filtered Text is the default.

Receive All Text lets you store the transmitted data in the receiving file
exactly as they are received, including control characters.

Receive Filtered Text does not save control characters in the receiving file.
This option changes [RETURN)] to [NEWLINE] and replaces [TAB] cheracters
with the appropriate number of spaces. All other control charscters are
discarded.
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To stop storing text in the file, toggle Receive From Remote to close the
file. You can then read the file using the Workshop Editar or any progrem
that reads standard text files. The Transfer program does not insert s
[RETURN] &t the end of the file, so if your file is a program file or cther
file that must end with [RETURN] use the Editor to insert one.

10412 Sending Text
The Transfer to Remote menu item lets you send data directly from a text
file rather then typing it at the keyboard. When you toggle Transfer to
Remote to begin sending, you are prompted for the name of the text file.

The Line Delay option is associated with Transfer to Remote. When you
select this menu item, you are prompted for the number of milliseconds the
Transfer program will wait before sending each line of text. The default is
zero. Specify a line delay when you are transmitting to a remote computer
that is losing data because it cannot keep up with full speed transmission.

Kiljlvgo]M Connector Baud Rate Parity Handshake Duplex

Set Delay between Lines [in milliseconds] 7

10413 Suppressing Text Display
The Baud Rate menu lets you select a maximum transfer speed. However,
the actual transfer rate may be slower because of the processing time
required to display the text as it is sent or received. Suppress Text Display
is a Control menu item that may be used with either Receive From Remote
or Transfer to Remote. You can toggle it on or off at any time. When
Suppress Text Display is selected, text that is received or sent is not
displayed on the Lisa screen, and the dsta transmission speed is usually
improved.

10414 Exiting from the Transfer Program
When you have completed your communicetions session, select Exit from the
Control menu. The current characteristics settings are saved and you are
returned to the Workshop command line.

You must explicith log off I the remote computer has & logoft procedure.
If you choose Exit without logging off, neither the session nor the telephone
cannection is autornatically terminated. When you return to the Transfer
program, the session will still be active and you can proceed as if you'd
never exited.
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1042 Transmitting Special Characters
By using special keys, you can type standard terminal control characters. To
transmit & control character from the keyboard, hold down the Apple key and
type a character, as shown in Table 10-1.

You can also gend international, mathematical, and scientific symbals and
other cheracters from the Lisa's extended cheracter set (see Appendix B, Lisa
Extended Character Set) if the remote computer is a Lisa. The extended
character set uses the eighth (perity) bit as part of the character identity, so
both Lisas must operate with parity set to None; if parity checking is on, the
parity bit will be stripped and the character will be received as an ASCII
character.

To transmit a character from the extended character set, hold down the
Option key (or the Option key together with the Shift key) and type &
character.

Table 10-1
Trensmitting Special Characters from the Keyboard

Keyvoard Transmits
@-backspace DEL

clear ESC

ENTER (alpha keyboard) BREAK (233ms)

ENTER (numeric keypad) RETURN

arrow keys their symbols

&«-Q XON

&-S XOFF

@-character other control
characters

Option-character Extended

Option-Shift-character Character Set
(see Appendix B)
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The Utilities

The Utilities are general-purpose programs that run in the Workshop
environment. To run a utility program, use the Workshop Run command. For
example, to run the Copy utility, type

RCOPY

from the Workshop command line. You can also run a utility program from
an exec file.

The Utilities are arranged alphabetically in this chapter. Each utility
program is documented as follows:

Synopsis Tells briefly what the program does.
Dialog Lists the program prompts and tells how to
respond to them.
Description Gives detsils on input, output, and processing.
Notes Brings special information to your attention.
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11.1 ByteDiff
Synopsis | |
ByteDiff compares the contents of two files and reports which bytes (words)
are different.
Dialog
Source file?
Target file?
Description
ByteDiff compares the source file to the target file and reports on their
differepces. This utility is ugeful for finding the first differences between
files or for finding a srnall number of differences.

The program prompts for an input file and an output file. The two files can
be in any formeat: .text, .obj, .i, and so forth.

The output is of the form:
Bytes $xxxxxx differ asaa bbbb
where:

xxxxxx is the byte address in hex
aaaa is the word (two bytes) from the source file
hbbh is the word from the target file

After 20 lines of output the user can either terminate by preszing [CLEAR]
or continue by pressing the space bar.

See Also
Diff, E(qual command of the File Manager

Notes
ByteDiff compares any binary files, but once it finds a difference between the two
files, it does not try to resynchronize. This utility does block-at-a-time 1/0.
The program stops at the first end-of-file and has no termination message.
ByteDiff is nonstandard user interface.
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11 2 ChangeSeqg
Synopsis
ChangeSeqg changes the segment name in the modules in an unlinked object
file.
Dialog
File to change:
Map all Names (Y/N)
Description
The first prompt, "File to Change", asks for the unlinked object file you want

to change. To exit from the ChangeSeq utility st this point, type (CLEAR>
(RETURN?>.

You are next asked if you want to map all names. If you want to change
segment names in all modules, respond Y. If you want to be prampted for
the new segment name for each module, type N. A response of [RETURN]
accepts the default narne.

Notes

Changes are made in place (the file itself is changed).
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113 CharCount

Synopsis

CharCount counts the number of characters in its input.

Dialog

Paremetex(s) [? for help]:

The format for the parameters is: (stdin >stdout

Description

CharCount counts the number of characters in its input (StdIn), and writes
the total to its output (StdOut). The defaults for both Stdin and StdOut are

the console. If the input is from the console, use #-C to indicate the end of
file.

All characters are counted, including RETURN and DLE characters.
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114 CodeSize
Synopsis
Determines the code size and code zegmentation for a unit, a program, ar a
library.
Dialog
Input. file [LOBJ] -
Resident file [.TEXT] -
Output file [-CONSOLE]/[.TEXT] -
The resigent rile is the file that contains the segment names that are
considered resident. The names in the file must be the same case as in the
code file itself. The resident information is used in the summary reports to
automatically sum the residert and swapping code.

At any time when specifying the file names, the run-time options can be
turned on or off. The run-time options &are:

+X turns the mapping of calls to sustem externals on or off. System
externals are procedures whose names begin with a "¥". Using this
option, the system will counl the number of procedures that call &
particular system external. This option is used to determine which

system routines are being used, for example, if WRITELNs are left in
the code.

+E  turns the mapping of calls to nronsysiem externals on or off.
Nonsystem externals are procedures in a segment other than the
calling procedure. Using this option, the system will count the
number of procedures that call a particular nonsystem external. This
option is used to determine which routines are being used, for
example, which library routine the code is using.

+M tells CodeSize that a particular segrment is mapped onto another
segment. This information generates the segment rmapping summary
and the segment summary. This option is used when smaller
seqrments are mapped into larger segements, and the sizes of the
emaller and resulting larger segements are needed.

+5 turns the main report on and off. Sometimes the summary report is
all that is needed. Use this option to print only the summary report.
Description
CodeSize generates two types of reports depending on the type of input
file(s): main report and summary report. The input file can be an execution
file, & library, or an object file. For each file, the report format will be:
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Type of File
Execution file

Main Report
segment ipformation

unit information
segment information

Library file

Object file unit information

The LRilities

Summary Report

segment summary
main summary

unit sumrmary
segment summary
main summary

external summary(+E or +%)

procedure information unit summary

segment mapping summary(+M)
segment summary
main summary

The contents of the report section are:

Segment. information
segment type
segment name

segment size

Unit information
unit name
unit global size
unit type

Procedure information
procedure name

associated segment

procedure size
interface information

external references
External summary

external procedure narme
# of occurrences

intrinsic, nonintrinsic, main program
first eight charcters of the segment's
name

size of the segment in decimal or hex

first eight characters of the unit name
how much global space the unit uses
intrinsic, shared intrinsic, regular

first eight characters of the procedure's
name

first eight characters of its segment's
name

size of the procedure in decimal or hex

is the procedure in the interface of the
unit?

list of all the external calls the procedure
makes. This is triggered by the +E or +¥%
options

name of the procedure
how many different procedures called the

procedure. This is triggered by the +E or +% options.1Unit summary

unit name

unit size

unit type

unit global size

Segment mapping summary
ariginal segment name

first eight characters of the unit's name
size of the unit in decimal or hex
intrinsic or not

how much global space the unit uses

name of the original segment
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new segment narne
segment size

Segment summary
segment type

segment name

segment size

Main summary
total code size
total resident code

total swapping code

total data globals
total main prog globals

total jump table

I ‘ total globals

The LRIiiies

name the segment is being mapped into
size of the segment being mapped. This
is triggered by the +M option.

swapping or resident. Resident segment
is specified to CodeSize ky the "resident
file".

first eight characters of the segment's
name

size of the segment in decimal or hex

summation of the code size

summation of the code that is considered
resident all the time. Resident code is
specified to CodeSize by "resident file".
summation of the code that is considered
swapping all the time. Swapping code is
specified to CodeSize by "resident file."
summation of the global space for data
summation of the global space in the main
program

sum of main program globals plus data
globals

size of the jump table
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115 Compare

Synopsis

Compare compares the lines of two text files and prints out all their
differences. Options let you compress blanks, delete trailing blanks, ignore
case, set the number of lines that are allowed to rnismatch and the number
that must be equal to be considered a match, and control the format of the
display.

Dialog

Parameter(s) [? for help]:

File #1: [.TEXT]

File #2: [.TEXT]

Options [? for help]:

Maximum stack depth:

Fixed/Minimum grouping factor:

Maximum display width:

Only the Parameters and Options prompts always appear; the other prompts
don't appear if they are not needed or are specified as explicit parameters:

Parameter(s) [? for help]: filei file? [ci-c2] [depth] [g] [width] [>listing]

Where:
filel and file2z are the input files
cl-c2 is a column range to compare (optional)
depth is the stack depth for resynchronization (optional)
g i